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Safety Information

When using this machine, the following safety precautions should always be followed.

/\ CAUTION:

Safety During Operation

In this manual, the following important symbols are used:

/\ WARNING:
Indicates a potentially hazardous situation which, if
instructions are not followed, could result in death or serious
injury.

/\ CAUTION:
Indicates a potentially hazardous situation which, if instructions are

not followed, may result in minor or moderate injury or damage to
property.

/\ WARNING:

- Disconnect the power plug (by pulling the plug, not the cable) if the
power cable or plug becomes frayed or otherwise damaged.

- To avoid hazardous electric shock or laser radiation exposure, do not
remove any covers or screws other than those specified in this manual.

« Turn off the power and disconnect the power plug (by pulling the plug,
not the cable) if any of the following occurs:

«You spill something into the machine.
You suspect that your machine needs service or repair.
-The external housing of your machine has been damaged.

- Do not incinerate used toner or toner containers. Toner dust might
ignite when exposed to an open flame.

- Disposal can take place at our authorized dealer.
- Dispose of used toner containers in accordance with local regulations.

» Keep the machine away from flammable liquids, gases, and aerosols.
A fire or an electric shock might occur.

Connect the machine only to the power source described on the inside
front cover of this manual. Connect the power cord directly into a wall
outlet and do not use an extension cord.

- Do not damage, break or make any modifications to the power cord. Do
not place heavy objects on it. Do not pull it hard nor bend it more than
necessary. These actions could cause an electric shock or fire.

- If the power cord is damaged (exposure of the core, disconnection,
efc.), contact your service representative to change a new one.
Operating the machine with a damaged power cord may cause an
electric shock or fire.

Protect the machine from dampness or wet weather, such as rain and snow.

Unplug the power cord from the wall outlet before you move the machine.
While moving the machine, you should take care that the power cord will not
be damaged under the machine.

Before moving the machine, be sure to disconnect all external connections,
especially the power cord from the wall outlet. Damaged power cords are a
fire and electric shock hazard.

When you disconnect the power plug from the wall outlet, always pull the plug
(not the cable).

To disconnect the power cord, pull it out by plug. Do not drag the cord itself.
Doing so may result in damage to the cord, leading to fire or electric shock.

For safety reason, unplug the power cord from the wall outlet if the machine
will not be used for an extended period of time such as holidays.

Do not allow paper clips, staples, or other small metallic objects to fall inside
the machine.

Keep toner (used or unused) and toner containers out of reach of children.

For environmental reasons, do not dispose of the machine or expended
supply waste at household waste collection points. Disposal can take place at
an authorized dealer.

The inside of the machine could be very hot. Do not touch the parts with a
label indicating the “hot surface”. Otherwise, an injury might occur.

The fusing section of this machine might be very hot. Caution should be taken
when removing misfed paper.

Keep the machine away from humidity and dust. Otherwise a fire or an
electric shock might occur.

Do not place the machine on an unstable or tilted surface. If it topples over, an
injury might occur.

Do not use aluminum foil, carbon paper, or similar conductive paper to avoid
a fire or machine failure.

Make sure the room where you are using the machine is well ventilated and
spacious. Good ventilation is especially important when the machine is used
heavily.

Do not open toner containers forcefully. Toner can spill, dirtying your clothes
or hands, and possibly resulting in accidental ingestion.

If toner or used toner is inhaled, gargle with plenty of water and move into a
fresh air environment. Consult a doctor if necessary.

If toner or used toner gets into your eyes, flush immediately with large
amounts of water. Consult a doctor if necessary.

If toner or used toner is swallowed, dilute by drinking a large amount of water.
Consult a doctor if necessary.




/\ CAUTION:

Avoid getting toner on your clothes or skin when removing a paper jam or
replacing toner. If your skin comes into contact with toner, wash the affected
area thoroughly with soap and water.

If toner gets on your clothing, wash with cold water. Hot water will set the
toner into the fabric and may make removing the stain impossible.

» Do not look into the lamp - it can damage your eyes.

When loading paper, take care not to trap or injure your fingers.

« During operation, rollers for transporting the paper and originals revolve. A
safety device is being installed so that the machine can be operated safely.
But take care not to touch the rollers during operation. An injury might occur.

* Fire and breakdown can result from heavy accumulation of dust inside this
machine. Consult your service representative for details about and charges
for cleaning the machine’s interior.

« If you have to move the machine when the optional paper tray unit is
attached, do not push on the main unit's top section. Doing so can cause the
optional paper tray unit to detach, possibly resulting in injury.

Power Supply

The socket-outlet shall be in stalled near the product and shall be easily accessible.

Ozone Safety
This product generates ozone during operation.

Normally, the ozone level is safe for operators. If ozone odor may appear, ventilate the
room.

For Fax or Telephone

When using your telephone equipment, basic safety precautions should always be
followed to reduce the risk of fire, electric shock and injury to persons, including the
following:

Do not use this product near water, for example, near a bathtub, wash bowl, kitchen sink
or laundry tub, in a wet basement or near a swimming pool. Avoid using a telephone
during an electrical storm. There may be a remote risk of electric shock from lightning.
Do not use a telephone in the vicinity of a gas leak to report the leak. Use only No. 26
AWG or larger telecommunication line cord.

SAVE THESE INSTRUCTIONS

Laser Safety:

This equipment is considered a class 1 laser device. This equipment contains a
15 milliwatt, 775-800 nanometer wavelength, AlGaAs laser diode. The following
marking is attached on the back of the equipment.

CLASS 1 LASER PRODUCT
LASER KLASSE 1 PRODUKT

Caution:

Use of controls or adjustment or performance of procedures other than those specified
in this manual might result in hazardous radiation exposure.

For North America

CDRH Regulations

This equipment complies with requirements of 21 CFR subchapter J for class 1 laser
products. This equipment contains a 15 milliwatt, 775-800 nanometer wavelength,
AlGaAs laser diode. This equipment does not emit hazardous radiation, since the beam
is totally enclosed during all customer modes of operation and maintenance.

Caution:

Use of controls or adjustment or performance of procedures other than those specified
in this manual might result in hazardous radiation exposure.

Notes for Users

LAMP(S) INSIDE THIS PRODUCT CONTAIN MERCURY AND MUST BE RECYCLED
OR DISPOSED OF ACCORDING TO LOCAL, STATE OR FEDERAL LAWS.
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Notice to Users in EEA Countries

Declaration of Conformity

This product complies with the essential requirements and provisions of Directive 1999/

5/EC of the European Parliament and of the Council of 9 March 1999 on radio
equipment and telecommunications terminal equipment and the mutual recognition of
their conformity.

Notice to Users Accessing Analog PSTN in EEA Countries

This product is designed to be able to access analog PSTN in all EEA countries. Local
PSTN compatibility is dependent on software switch settings. Please contact your
service representative if relocating this product to another country. In the event of
problems, please contact your service representative in the first instance.

Aficio SP 3200SF/SP 3200SF :

The CE declaration of Comformity is available on the Internet at URL :
http://www.ricoh.co.jp/fax/ce_doc

CE Marking Traceability Information (For EU Countries
Only)

Manufacturer:

Ricoh Co., Ltd.
3-6 Nakamagome 1-chome, Ohta-ku, Tokyo, 143-8555 Japan

Authorized representative:
RICOH EUROPE B.V.
Prof. W.H. Keesomlaan 1, 1183 DJ Amstelveen The Netherlands

User Information on Electrical & Electronic Equipment

Users in the EU, Switzerland and Norway
Our Products contain high quality components and are designed to facilitate recycling.
Our products or product packaging are marked with the symbol below.

E The symbol indicates that the product must not be treated as municipal

waste. It must be disposed of separately via the appropriate return and

collection systems available. By following these instructions you ensure

that this product is treated correctly and help to reduce potential impacts
B ) the environment and human health, which could otherwise result from
inappropriate handling. Recycling of products helps to conserve natural
resources and protect the environment. For more detailed information on
collection and recycling systems for this product, please contact the shop
where you purchased it, your local dealer or sales/service representatives.

Positions of Labels and Hallmarks for
/\ WARNING and /\ CAUTION Labels

This machine has labels for AAWARNING and /A\CAUTION at the positions shown
below. For safety, please follow the instructions and handle the machine as indicated.

180°C
356°F

*This label is stuck to hot surfaces. Be careful not to touch these areas.

In accordance with IEC 60417, this machine uses the following symbols for the main
power switch:

| means POWER ON.
O means POWER OFF.

ENERGY STAR® Program

ENERGY STAR

The ENERGY STAR® Program encourages energy conservation by promoting energy
efficient computers and other office equipment.

The program backs the development and dissemination of products that feature energy
saving functions.

It is an open program in which manufacturers participate voluntarily.

Targeted products are computers, monitors, printers, facsimiles, copiers, scanners, and
multifunction devices. Energy Star standards and logos are internationally uniform.


http://jboard.danka.de/jboard/produkte/index.htmlo

NOTICE

Note to users in the United States of America

Notice:

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one more of the following
measures:

+ Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

« Consult the dealer or an experienced radio /TV technician for help.

Caution
Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

Notice about the Telephone Consumer Protection Act (Valid in
USA only).

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to
use a computer or other electronic device, including FAX machines, to send any
message unless such message clearly contains in a margin at the top or bottom of each
transmitted page or on the first page of the transmission, the date and time it is sent and
an identification of the business or other entity, or other individual sending the message
and the telephone number of the sending machine or such business, other entity, or
individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your FAX machine, refer to “Setting the Machine
ID” in this manual. Follow the steps provided there to enter the business identification

and telephone number of the terminal or business. This information is transmitted with
your document by the FAX HEADER feature. In addition to the information, be sure to
program the date and time into your machine.

USA

FCC Requirements

1. This equipment complies with Part 68 of the FCC rules and requirements adopted
by the ACTA. On the cover of this equipment is a label that contains, among other
information, a product identifier in the format US:AAAEQ##TXXXXX. If requested,
this number must be provided to the telephone company.

This equipment uses the RJ11C USOC jack.

A plug and jack used to connect this equipment to the premises wiring and
telephone network must comply with the applicable FCC Part 68 rules and
requirements adopted by the ACTA. A compliant telephone cord and modular plug
is provided with this product. It is designed to be connected to a compatible
modular jack that is also compliant. See installation instructions for details.

4. The REN is used to determine the number of devices that may be connected to a
telephone line. Excessive RENs on a telephone line may result in the devices not
ringing in response to an incoming call. In most but not all areas, the sum of RENs
should not exceed five (5.0). To be certain of the number of devices that may be
connected to a line, as determined by the total RENs, contact the local telephone
company. The REN for this product is part of the product identifier that has the
format US:AAAEQ##TXXXXX. The digits represented by ## are the REN without
a decimal point (e.g., 03 is a REN of 0.3).

5. If this equipment causes harm to the telephone network, the telephone company
will notify you in advance that temporary discontinuance of service may be
required. But if advance notice is not practical, the telephone company will notify
the customer as soon as possible. Also, you will be advised of your right to file a
complaint with the FCC if you believe it is necessary.

6. The telephone company may make changes in its facilities, equipment, operations
or procedures that could affect the operation of the equipment. If this happens the
telephone company will provide advance notice in order for you to make
necessary modifications to maintain uninterrupted service.

7. If trouble is experienced with this equipment, for repair or warranty information,
please contact Ricoh Americas Corporation. CUSTOMER SUPPORT DEPT. at 1-
800-FASTFIX. If the equipment is causing harm to the telephone network, the
telephone company may request that you disconnect the equipment until the
problem is resolved.

8. Inthe event of operation problems (document jam, copy jam, communication error
indication), refer to the solving problems section in this manual.

9. Connection to party line service is subject to state tariffs. Contact the state public
utility commission, public service commission or corporation commission for
information.

10. If your home has specially wired alarm equipment connected to the telephone line,
ensure the installation of this equipment does not disable your alarm equipment. If
you have questions about what will disable alarm equipment, consult your

telephone company or a qualified installer.

WHEN PROGRAMMING EMERGENCY NUMBERS AND/OR MAKING TEST
CALLS TO EMERGENCY NUMBERS:

1. Remain on the line and briefly explain to the dispatcher the reason for the call
before hanging up.

2. Perform such activities in the off-peak hours, such as early morning hours or late
evenings.



CANADA
This product meets the applicable Industry Canada technical specifications.

The Ringer Equivalence Number is an indication of the maximum number of devices
allowed to be connected to a telephone interface. The termination on an interface may
consist of any combination of devices subject only to the requirement that the sum of
the RENSs of all the devices does not exceed five.



1 Introduction

Thank you for purchasing this multifunctional product. Your machine
provides printing, copying, scanning, and faxing functions.

This chapter includes:

» Special features

« Printer overview

« Understanding the Status LED
« Finding more information

« Selecting a location

Special features

Your new machine is equipped with special features that improve print
quality. You can:

Print with excellent quality and speed

* You can print with a resolution of up to 1200 dpi [Best].

See the Software section.

+ Your machine prints A4-sized paper at up to 28 ppm?
and letter-sized paper at up to 30 ppm.

» For duplex printing, your machine prints A4-sized
paper at up to 19 ipm® and letter-sized paper at up to
21 ipm.

Handle paper flexibly

) » The multi-purpose tray supports letterhead,
)| \ envelopes, labels, transparencies, custom-sized
. media, postcards, and heavy paper. The multi-
purpose tray holds up to 50 sheets of plain paper.
» The 250-sheet tray 1 and 250-sheet optional tray 2
support plain paper in various sizes.

Create professional documents

)

with words, such as “Confidential”. See the Software
2‘\ section.

» Print Posters. The text and pictures of each page of

a poster. See the Software section.

Save time and money

» You can print multiple pages on one single sheet of paper to save
paper.

» You can use preprinted forms and letterhead with plain paper. See the

Software section.

» This machine automatically conserves electricity by substantially
reducing power consumption when not in use.

a. pages per minute
b. images per minute

» Print Watermarks. You can customize your documents

K J your document are magnified and printed across the
sheet of paper and can then be taped together to form

Expand your machine’s capacity
* Your machine has 96 MB of memory which can be

expanded to 320 MB.
* You can add a 250-sheet optional tray 2 to your
machine. This tray lets you add paper to the machine

less often.

» Zoran IPS Emulation* compatible with PostScript 3
(PS) enables PS printing.

* Zoran IPS Emulation compatible with PostScript 3

_ » © Copyright 1995-2005, Zoran Corporation. All
rights reserved. Zoran, the Zoran logo, IPS/PS3, and
Onelmage are trademarks of Zoran Corporation.
* 136 PS3 fonts

Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments

* You can print with Windows 98/Me/NT 4.0/2000/XP/2003.

* Your machine is compatible with a variety of Macintosh systems.
* Your machine comes with both USB and Parallel interfaces.

Use USB flash memory devices

If you have a USB memory device, you can use it in various ways with
your machine.

* You can scan documents and save them to the device.

» You can directly print data stored to the device.

* You can back up data and restore backup files to the machine’s
memory.
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Printer overview

These are the main components of your machine:

Front view

| \L}/f/’/ %
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© 00 O

S0 S
1 ADF (automatic 10 tray1
document feeder)'

2 document width guides 11  optional tray 2

3 document input tray 12 multi-purpose tray

4  scanner lid 13  output support

5  document output tray 14  USB memory port

6  control panel 15  multi-purpose tray
extension

7 output tray 16  multi-purpose tray paper
width guides

8 front cover 17  scanner glass

9  paper level indicator 18 toner cartridge

1. Automatic document feeder is used as ADF in this user’s guide.

Rear view
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“ \/

1 control board cover 7  extension telephone
socket (EXT)
2  npetwork port duplex unit
3  USB port 9  power receptacle
4  parallel port 10  power switch
5  optional tray 2 cable 11 rear cover
connector

6  telephone line socket
(LINE)
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Control panel overview
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1 Speed buttons: Allows you to store frequently-dialed fax numbers 13 Back: Sends you back to the upper menu level.
and email addresses and enter them with the touch of a few
buttons.

2 Shift: Allows you to shift the speed buttons to access numbers 16 14  Status: Shows the status of your machine. See page 1.4.
through 30.

3 Address Book: Allows you to store frequently used fax numbers in 15  Darkness: Adjusts the document brightness for the current copy
memory or search for stored fax numbers or email addresses. Also job.
allows you to print an Address Book/Phone Book list.

4 Resolution: Adjusts the document resolution for the current fax job. 16 Original Type: Selects the document type for the current copy job.

5  Redial/Pause: In Standby mode, redials the last number, or in Edit 17  Reduce/Enlarge: Makes a copy smaller or larger than the original.

mode, inserts a pause into a fax number.

6 Fax: Activates Fax mode. 18  USB Print: Allows you to directly print files stored on a USB
Memory device when it is inserted into the USB memory port on
the front of your machine.

7 Copy: Activates Copy mode. 19  Duplex: Allows you to print documents on both sides of the paper.

8 Scan/Email: Activates Scan mode. 20  Toner Save: Allows you to save on toner by using less toner in
printing.

9 Display: Shows the current status and prompts during an operation. 21 Number keypad: dials a number or enters alphanumeric characters.

10  Menu: Enters Menu mode and scrolls through the available menus. 22  On Hook Dial: Engages the telephone line.

11 Scroll buttons: Scroll through the options available in the selected 23  Stop/Clear: Stops an operation at any time. In Standby mode,

menu, and increase or decrease values. clears/cancels the copy options, such as the darkness, the
document type setting, the copy size, and the number of copies.

12 OK: Confirms the selection on the screen. 24  Start: Starts a job.

1.3
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Understanding the Status LED Finding more information

The Status LED on the control panel shows the status of your machine.

You can find information for setting up and using your machine from the
See the table below to know your machine’s status. g up 9y

following resources, either printed or onscreen.

Status Description
Quick Install Provides information on setting up your
Off » The machine is off-line. Guide machine and, therefore, be sure to follow
+ The machine is in Power Save mode. When e the instructions in the guide to get the
data is received, or any button is pressed, it m=__ B machine ready.
switches to on-line automatically. u: .-
Bl
Green | On The machine is on-line and can be used. 101
Blinking | When t.h.e backlight slowly blinks, the machine Online User’s Provides you with step-by-step
is receiving data from the computer. Guide instructions for using your machine’s full
» When the backlight fast blinks, the machine is features, and contains information for
printing data. maintaining your machine,
i - troubleshooting, and installing
Red On » The toner cartridge is totally exhausted. accessories.
Remove the old toner cartridge and install a This user’s guide also contains the
new-one. See page 13.5. Software section providing you with
* A paper jam has occurred. To solve the information on how to print documents
problem, see page 14.2. with your machine on various operating
+ The front cover is open. Close the front cover. systems, and how to use the supplied
» There is no paper in the tray. Load paper in software utilities.
the tray.
» The toner cartridge installed is not a genuine Note
cartridge, and you selected Stop at the You can access the user’s guides
NonGenuine Toner prompt. See page 14.10. in other languages from the
« The lifespan of the toner cartridge is reached, Manual folder on the Printer,
and you selected Stop at the Toner Scanner Drivers and Utilities
Exhausted prompt. See page 14.10. Type 104 software CD.
) Z:rzrmgﬁzg]ketpssdisstglz r;lercr:i]:SuseatgoeaSrr;?or Network Printer Contained on the Printer, Scanner Drivers
’ ; : User’s Guide and Utilities Type 104 software CD,
page 14.7 for details on the meaning of the provides you with information on setting
error message. up and connecting your machine to a
Blinking | « A minor error occurs and the machine is network.
waiting an error to be cleared. Check the
display message. When the problem is - - X X X X
cleared, the machine resumes. Printer Driver Pr.owdes you with hglp |nforn_1at|on on
« The toner cartridge installed is not a genuine Help printer driver properties and instructions
cartridge, and you selected Continue at the for setting up the PFOPG”'GS for prlntlng. To
NonGenuine Toner prompt. See page 14.10. a(;?eifo?nptugte';iﬂ:gfrrr;elgrﬁgrsegpa’lgh(:k
 The lifespan of the toner cartridge is reached, boxp P prop 9
and you selected Continue at the Toner ’
Exhausted prompt. See page 14.10.
» The toner cartridge is low. Order a new toner
cartridge. You can temporarily improve print
quality by redistributing the toner. See
page 13.4.
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Selecting a location

Select a level, stable place with adequate space for air circulation. Allow

extra space for opening covers and trays.

The area should be well-ventilated and away from direct sunlight or
sources of heat, cold, and humidity. Do not set the machine close to the
edge of your desk or table.

Clearance space

» Front: 482,6 mm (enough space so that the paper tray can be

removed)

» Back: 100 mm (enough space for ventilation)

» Right: 100 mm (enough space for ventilation)

+ Left: 100 mm (enough space for ventilation)

] c > |
. £ & i
' o £ H
: Sy '
] ) 1
: C i
) 1
) 1
) 1
) 1
) 1
) 1
: i
E 100 mm 100 mm !
.‘ > < .l
1(3.9inches) | |(3.9inches):
. —— i
) 1
) 1
! & J H
) — 1
) (%) 1
) [ 1
[l S |
' £ !
i © i
) [o0) 1
) — 1
] ~ )
! £ i
' e 1
] © !
) 1
] IVl [}
] o0 :
R N 1

1.5

<Introduction>




2 System setup

This chapter gives you an overview of menus available on your machine
and step-by-step instructions for setting up the machine’s systems.

This chapter includes:

Menu overview

Changing the display language

Setting the date and time

Changing the default mode

Setting sounds

Entering characters using the number keypad
Using the save modes

Setting print job timeout

Menu overview

The control panel provides access to various menus to set up the
machine or use the machine’s functions. These menus can be accessed
by pressing Menu. Refer to the following diagram. Menus available in
Fax, Copy, or Scan mode vary.

Fax Feature

Darkness

Multi Send
Delay Send
Priority Send
Send Forward
Rcv. Forward
Secure Receive
Add Page
Cancel Job

Fax Setup

Sending
Redial Times
Redial Term
Prefix Dial
ECM Mode
Sent Report
Image TCR

Receiving
Receive Mode
Ring to Answer
Stamp Rcv Name
Rcv Start Code
Auto Reduction
Discard Size
Junk Fax Setup
DRPD Mode

Change Default
Resolution
Darkness

Auto Report

Network

TCP/IP
EtherTalk
Ethernet Speed
Clear Setting
Network Info.

(continued)

Machine Setup

Copy Feature Copy Setup Scan Feature
Copy Collation Change Default USB Memory
2-Up Copies Scan Size
4-Up Reduce/Enlarge Original Type
ID Copy Darkness Resolution
Poster Copy Original Type Scan Color
Clone Copy Scan Format
Erase Bkgd. E-mail

Scan Size
Original Type
Resolution
Scan Color
FTP
Scan Size
Original Type
Resolution
Scan Color
SMB
Scan Size
Original Type
Resolution
Scan Color
System Setup System Setup Scan Setup

Change Default

Sound/Volume Machine ID USB Memory
Key Sound Machine Fax No. E-mail
Alarm Sound Date & Time FTP
Speaker Clock Mode SMB
Ringer Language

Report Default Mode

Maintenance Power Save
Clean Drum Scan PWR Save
Remote Service Timeout
Ignore Toner NetSc_anTlmeout

Job Timeout

CLR Empty Msg.

Supplies Life

Serial Number
Clear Setting

Import Setting

Export Setting
Paper Setup

Paper Size

Paper Type

Paper Source
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Changing the display language

To change the language that appears on the control panel, follow these
steps:

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.
3 Press the Scroll buttons until Language appears and press OK.

4 Press the Scroll buttons until the language you want appears and
press OK.

5 Press Stop/Clear to return to Standby mode.

Setting the date and time

The current date and time are shown on the display when your machine
is on and ready to work. All of your faxes will have the date and time
printed on them.

Note
If power to the machine is cut off, you need to reset the correct
time and date once the power has been restored.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.
3 Press the Scroll buttons until Date & Time appears and press OK.

4 Enter the correct time and date using the number keypad.

Month = 01to 12
Day = 01to 31
Year = requires four digits
Hour = 01 to 12 (12-hour mode)
00 to 23 (24-hour mode)
Minute = 00 to 59
Note

The date format may differ from country to country.

You can also use the Scroll buttons to move the cursor under the
digit you want to correct and enter a new number.

5 To select AM or PM for 12-hour format, press the % or 1 button or
any number button.

When the cursor is not under the AM or PM indicator, pressing the
¥ or # button immediately moves the cursor to the indicator.

You can change the clock mode to 24-hour format (e.g. 01:00 PM as
13:00). For details, see the next section.

6 Press OK to save the time and date.

When you enter a wrong number, Out of Range appears and the
machine does not proceed to the next step. If this happens, simply
reenter the correct number.

7 Press Stop/Clear to return to Standby mode.

Changing the clock mode

You can set your machine to display the current time using either a
12-hour or 24-hour format.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

Press OK when Machine Setup appears.
Press the Scroll buttons until Clock Mode appears and press OK.

Press the Scroll buttons to select the other mode and press OK.

a B~ W N

Press Stop/Clear to return to Standby mode.

Changing the default mode

Your machine is preset to Fax mode. You can switch this default mode
between Fax mode and Copy mode.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.
3 Press the Scroll buttons until Default Mode appears and press OK.

4 Press the Scroll buttons until the default mode you want appears
and press OK.

5 Press Stop/Clear to return to Standby mode.

2.2
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Setting sounds

You can control the following sounds:

» Key Sound: Turns the key sound on or off. With this option set to On,
a tone sounds each time a key is pressed.

» Alarm Sound: Turns the alarm sound on or off. With this option set to
On, an alarm tone sounds when an error occurs or fax communication
ends.

+ Speaker: Turns on or off the sounds from the telephone line through
the speaker, such as a dial tone or a fax tone. With this option set to
Comm. which means “Common,” the speaker is on until the remote
machine answers.

You can adjust the volume level using On Hook Dial.

» Ringer: Adjusts the ringer volume. For the ringer volume, you can
select Off, Low, Mid, and High.

Speaker, ringer, key sound, and alarm sound

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Sound/Volume appears and press
OK.

3 Press the Scroll buttons until the sound option you want appears
and press OK.

4 Press the Scroll buttons until the desired status or volume for the
sound you have selected appears and press OK.

5 If necessary, repeat steps 3 through 5 to set other sounds.

6 Press Stop/Clear to return to Standby mode.

Speaker volume

1 Press On Hook Dial. A dial tone sounds from the speaker.
2 Press the Scroll buttons until you hear the volume you want.

3 Press On Hook Dial to save the change and return to Standby
mode.

Note
You can adjust the speaker volume only when the telephone
line is connected.

Entering characters using the number keypad

As you perform various tasks, you may need to enter names and
numbers. For example, when you set up your machine, you enter your
name or your company’s name, and the fax number. When you store fax
numbers or email addresses in memory, you may also enter the
corresponding names.

Entering alphanumeric characters

1 When you are prompted to enter a letter, locate the button labeled
with the character you want. Press the button until the correct letter
appears on the display.

For example, to enter the letter O, press 6, labeled with MNO.

Each time you press 6, the display shows a different letter, M, N, O,
and finally 6.

You can enter special characters, such as space, plus sign, and etc.
For details, see the below section.

2 To enter additional letters, repeat step 1.

If the next letter is printed on the same button, move the cursor by
pressing the right Scroll button and then press the button labeled
with the letter you want. The cursor will move to the right and the
next letter will appear on the display.

You can enter a space by pressing 1 twice.

3 When you have finished entering letters, press OK.

Keypad letters and numbers

Key Assigned numbers, letters, or characters
1 1 Space

2 A B Caboc2

3 D EFde f 3

4 G H I g hi 4

5 JKLjkKIS

6 M N O mn o 6

7 P QR Spgqgrs 7

8 T UV tuwv 8

9 W XY Zwxy z 9

0 + -, . # & @ 0

2.3
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Correcting numbers or names

If you make a mistake while entering a number or name, press the left
Scroll button to delete the last digit or character. Then enter the correct
number or character.

Inserting a pause

With some telephone systems, you must dial an access code (9, for
example) and listen for a second dial tone. In such cases, you must insert
a pause in the telephone number. You can insert a pause while you are
setting up speed buttons or speed dial numbers.

To insert a pause, press Redial/Pause at the appropriate place while
entering the telephone number. A - appears on the display at the
corresponding location.

Using the save modes

Toner Save mode

Toner Save mode allows your machine to use less toner on each page.
Activating this mode extends the life of the toner cartridge beyond what
one would experience in the normal mode, but it reduces print quality.

To turn this mode on or off, press Toner Save.

Note
When PC-printing, you can also turn on or off Toner Save mode
in the printer properties. See the Software section.

Power Save mode

Power Save mode allows your machine to reduce power consumption
when itis not in actual use. You can turn this mode on and select a length
of time for which the machine waits after a job is printed before it switches
to a reduced power state.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

Press OK when Machine Setup appears.
Press the Scroll buttons until Power Save appears and press OK.

Press the Scroll buttons until On appears and press OK.

a A W DN

Press the Scroll buttons until the time setting you want appears and
press OK.

6 Press Stop/Clear to return to Standby mode.

Scan Power Save mode

Scan Power Save mode allows you to save power by turning off the scan
lamp. The scan lamp under the scanner glass automatically turns off
when it is not in actual use to reduce power consumption and extend the
life of the lamp. The lamp automatically wakes up after some warm-up
time when you start scanning.

You can set the length of time for which the scan lamp waits after a scan
job is completed before it switches to the power save mode.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.

3 Press the Scroll buttons until Scan PWR Save appears and press
OK.

4 Press the Scroll buttons until the time setting you want appears and
press OK.

5 Press Stop/Clear to return to Standby mode.

Setting print job timeout

You can set the amount of time a single print job is active before it must
print.

The machine handles incoming data as a single job if it comes in within
the specified time. When an error occurs while processing data from the
computer and the data flow stops, the machine waits the specified time
and then cancels printing if data flow does not resume.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.
3 Press the Scroll buttons until Job Timeout appears and press OK.

4  Press the Scroll buttons until the time setting you want appears and
press OK.

5 Press Stop/Clear to return to Standby mode.

24
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3 Software overview

This chapter gives you an overview of the software that comes with your
machine. Further details about installing and using the software are
explained in the Software section.

This chapter includes:

« Supplied software

« Printer driver features
« System requirements

Supplied software

You must install the printer and scanner software using the supplied CD
after you have set up your machine and connected it to your computer.

This CD provides you with the following software:

CcDh Contents
Printer, Windows Printer driver: Use this driver to
Scanner take full advantage of your printer’s
Drivers and features.
Utilities Type « PostScript Printer Description
104 (PPD) file: Use the PostScript driver

to print documents with complex
fonts and graphics in the PS
language.

» Scanner driver: TWAIN and
Windows Image Acquisition (WIA)
drivers are available for scanning
documents on your machine.

« Status Monitor: This program
allows you to monitor the machine’s
status and alerts you when an error
occurs during printing.

« SmarThru': This is the
accompanying Windows-based
software for your multifunctional
machine.

* Printer Settings Utility: You can
create and edit Phone Book entries
from your computer and set up print
and scan system data options.

+ ScanClair: This program allows you
to scan a document on your machine
and save it to a network-connected
computer.

» User’s Guide in PDF

+ Set IP: Use this program to set your
machine’s TCP/IP addresses.

* Network Printer User’s Guide in
PDF

CcD Contents

Printer, Macintosh | « PostScript Printer Description

Scanner (PPD) file: Use this file to run your
Drivers and machine from a Macintosh computer
Utilities Type and print documents.

104 « Scan driver: TWAIN driver is
(Continue) available for scanning documents on
your machine.

1. Allows you to edit a scanned image in many ways using a powerful image
editor and to send the image by email. You can also open another image editor
program, like Adobe Photoshop, from SmarThru. For details, please refer to the
onscreen help supplied on the SmarThru program.

3.1
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Printer driver features

System requirements

Your printer drivers support the following standard features:

» Paper source selection

» Paper size, orientation and media type

* Number of copies

In addition, you can use various special printing features. The following
table shows a general overview of features supported by your printer

Windows

Before you begin, ensure that your system meets the following
requirements:

Item

Requirements Recommended

Operating | Windows 98/Me/NT 4.0/2000/XP/2003

drivers:
PCL 6 PostScript
Feature
Windows Windows Macintosh

Toner save
Print quality option O O o
Poster printing O X X
Multiple pages per 0] @) @)
sheet (N-up)
Fit to page printing o
Scale printing (0] @) @)
Different source for first
page
Watermark 0] X X
Overlay’ 0] X X

—_

. The Overay feature is not supported in NT 4.0.

system
CPU Windows 98/ Pentium I Pentium Il
Me/NT 4.0/2000 | 400 MHz or 933 MHz
higher
Windows XP/ Pentium Il Pentium IV
2003 933 MHz or 1 GHz
higher
RAM Windows 98/ 64 MB or more 128 MB
Me/NT 4.0/2000
Windows XP/ 128 MB or more 256 MB
2003
Free disk Windows 98/ 300 MB or more 1GB
space Me/NT 4.0/2000
Windows XP/ 1 GB or more 5GB
2003
Internet 5.0 or higher
Explorer
Note

For Windows NT 4.0/2000/XP/2003, users who have an
administrator right can install the software.

Macintosh

Item

Requirements

Operating system

Macintosh 10.3 ~ 10.4

RAM

128 MB

Free disk space

200 MB

Connection

USB interface, Network interface
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4 Network setup

This chapter gives you step-by-step instructions for setting up your
machine for network connections.

This chapter includes:

+ Introduction

« Supported operating systems

- Configuring TCP/IP

« Configuring EtherTalk

« Setting Ethernet speed

» Restoring the network configuration

- Printing a network configuration page

Introduction

Once you have connected your machine to a network with an RJ-45
Ethernet cable, you can share the machine with other network users.

You need to set up the network protocols on the machine to use it as your
network printer. Protocols can be set up by the following two methods:

Via network administration programs

You can configure your machine’s print server settings and manage the
machine via the following programs that came with your machine:

+ Web Image Monitor Type 104: A web server embedded to your
network print server, which allows you to:

- Configure the network parameters necessary for the machine to
connect to various network environments.

- Customize e-mail settings and set up Address Book for scanning
to email.

- Customize server settings and set up Address Book for scanning
to an FTP or SMB servers.

- Customize printer, copy, and fax settings.

 SetlP: A utility program allowing you to select a network interface and
manually configure the addresses for use with the TCP/IP protocol.

For further details, refer to the user’s guide on the Printer, Scanner
Drivers and Utilities Type 104 CD that came with your machine.

Via the control panel

You can set up the following basic network parameters through the
machine’s control panel:

» Configure TCP/IP

» Configure EtherTalk

Supported operating systems

The following table shows the network environments supported by the
machine:

Item Requirements

Network interface * 10/100 Base-TX

Network operating » Windows 98/Me/NT 4.0/2000/XP/2003
system * Macintosh OS 10.3 ~ 10.4

Network protocols « TCP/IP on Windows
+ EtherTalk

Dynamicaddressing | « DHCP, BOOTP
server

TCP/IP: Transmission Control Protocol/Internet Protocol
» DHCP: Dynamic Host Configuration Protocol
+ BOOTP: Bootstrap Protocol

Configuring TCP/IP

Your machine can be set up with a variety of TCP/IP network information,
such as an IP address, a subnet mask, a gateway, and DNS addresses.
There are several ways in which your machine can be assigned a TCP/
IP address, depending on your network.

« Static addressing: A TCP/IP address is assigned manually by the
system administrator.

+ Dynamic addressing via BOOTP/DHCP (default): A TCP/IP address is
assigned automatically by the server.

Note
Before configuring TCP/IP, you need to set the network protocol
to TCP/IP.

4.1
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Static addressing

To enter a TCP/IP address from your machine’s control panel, take the
following steps:

1 Press Menu until Network appears on the bottom line of the display
and press OK.

Press OK when TCP/IP appears.
Press the Scroll buttons until Static appears and press OK.

Press OK when IP Address appears.

a &~ W N

Enter a byte between 0 and 255 using the number keypad and
press the Scroll buttons to move between bytes.

Repeat this to complete the address from the 1st byte to the 4th
byte.

6 When you have finished, press OK.

7 Repeat steps 5 and 6 to configure the other TCP/IP parameters:
subnet mask and gateway address.

8 Press the Scroll buttons until Static appears and press OK.

9 Press the Scroll buttons until Primary DNS appears and press OK.

10 Enter each byte of the address and press OK.

11 Press the Scroll buttons until Secondary DNS appears and press
OK.

12 Enter each byte of the address and press OK.
13 Press Stop/Clear to return to Standby mode.

Dynamic addressing (BOOTP/DHCP)

To have a TCP/IP address assigned automatically by the server, take the
following steps:

1 Press Menu until Network appears on the bottom line of the
display.

2 Press OK when TCP/IP appears.

3 Press the Scroll buttons until DHCP or BOOTP appears and press
OK.

4 Press Stop/Clear to return to Standby mode.

Configuring EtherTalk

EtherTalk is AppleTalk used in an Ethernet network. This protocol is
widely used in Macintosh network environments. To use EtherTalk, take
the following steps:

1 Press Menu until Network appears on the bottom line of the display
and press OK.

2 Press the Scroll buttons until EtherTalk appears and press OK.
3 Press the Scroll buttons until On appears and press OK.

4 Press Stop/Clear to return to Standby mode.

Setting Ethernet speed

You can select the communication speed for Ethernet connections.

1 Press Menu until Network appears on the bottom line of the display
and press OK.

2 Press the Scroll buttons until Ethernet Speed appears and press
OK.

3 Press the Scroll buttons until the speed you want appears and
press OK.

4 Press Stop/Clear to return to Standby mode.

Restoring the network configuration

You can return the network configuration to its default settings.

1 Press Menu until Network appears on the bottom line of the display
and press OK.

2 Press the Scroll buttons until Clear Setting appears and press OK.
3 Press OK when Yes appears to restore the network configuration.

4 Power the machine off and back on.

Printing a network configuration page

The Network Configuration page shows how the network interface card
on your machine is configured.

1 Press Menu until Network appears on the bottom line of the display
and press OK.

2 Press the Scroll buttons until Network Info. appears and press OK.

3 Press OK when Yes appears.

The Network Configuration page prints out.
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5 Loading originals and print
media

This chapter introduces you to how to load originals and print media into
your machine.

This chapter includes:

« Loading originals

« Selecting print media

« Loading paper

« Setting the paper size and type
» Selecting an output location

Loading originals

You can use the scanner glass or ADF to load an original for copying,
scanning, and sending a fax.

On the scanner glass

Make sure that no originals are in the ADF. If an original is detected in the
ADF, the machine gives it priority over the original on the scanner glass.
To get the best scan quality, especially for colored or gray-scaled images,
use the scanner glass.

1 Lift and open the scanner lid.

2 Place the original face down on the scanner glass and align it with
the registration guide at the top left corner of the glass.

3 Close the scanner lid.

Notes

» Leaving the scanner lid open while copying may affect copy
quality and toner consumption.

» Dust on the scanner glass may cause black spots on the
printout. Always keep it clean.

« If you are copying a page from a book or magazine, lift the
scanner lid until its hinges are caught by the stopper and then
close the lid. If the book or magazine is thicker than 30 mm,
start copying with the lid open.

In the ADF

Using the ADF, you can load up to 50 sheets of paper (75 g/m?) for one
job.

When you use the ADF:

» Do not load paper smaller than 142 x 148 mm or larger than
216 x 356 mm.

» Do not attempt to load the following types of paper:
- carbon-paper or carbon-backed paper
- coated paper
- onion skin or thin paper
- wrinkled or creased paper
- curled or rolled paper
- torn paper

» Remove all staples and paper clips before loading.

» Make sure any glue, ink, or correction fluid on the paper is completely
dry before loading.

» Do not load originals that include different sizes or weights of paper.

» Do not load booklets, pamphlets, transparencies, or documents
having other unusual characteristics.

5.1
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To load an original into the ADF: . . .
o load an ongiainto e Selecting print media

1 Load the original face up into the ADF. Make sure that the bottom of
the original stack matches the paper size marked on the document You can print on a variety of print media, such as plain paper, envelopes,
input tray. labels, and transparencies. Always use print media that meet the

guidelines for use with your machine. Print media that does not meet the

guidelines outlined in this user’s guide may cause the following problems:

 Poor print quality
* Increased paper jams
* Premature wear on the machine.

Properties, such as weight, composition, grain, and moisture content, are
important factors that affect the machine’s performance and the output
quality. When you choose print materials, consider the following:

» The type, size and weight of the print media for your machine is
described in following tables.

» Desired outcome: The print media you choose should be appropriate
for your project.

+ Brightness: Some print media are whiter than others and produce
sharper, more vibrant images.

+ Surface smoothness: The smoothness of the print media affects how
crisp the printing looks on the paper.

Notes

» Some print media may meet all of the guidelines in this section
and still not produce satisfactory results. This may be the result
of improper handling, unacceptable temperature and humidity
levels, or other variables over which we have no control.

» Before purchasing large quantities of print media, ensure that it
meets the requirements specified in this user’s guide.

Using print media that does not meet these specifications may
cause problems, requiring repairs. Such repairs are not covered
by our warranty or service agreements.

Note

Dust on the ADF glass may cause black lines on the printout.
Always keep it clean.
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Supported print media types and sizes

A4, JIS B5, ISO B5,
Executive, A5, A6

bond)

Type Size Dimensions Weight' Capacity?
Plain paper Letter 216 x 279 mm (8.5 x 11 inches) + 6010 90 g/m? (16t0 24 Ib + 250 sheets of 75 g/m?
- bond) for the tray (20 Ib bond) paper for the
Legal 216 x 356 mm (8.5 x 14 inches) « 60to 163 g/mz (16t0 43 Ib tray
Folio 216 x 330.2 mm (8.5 x 13 inches) bond) for the multi-purpose | « 50 sheets for the multi-
tray purpose tray
Oficio 216 x 343 mm (8.5 x 13.5 inches)
A4 210 x 297 mm (8.27 x 11.69 inches)
JIS B5 182 x 257 mm (7.18 x 10.12 inches)
ISO B5 176 x 250 mm (6.93 x 9.84 inches)
Executive 184.2 x 266.7 mm (7.25 x 10.5 inches)
A5 148.5 x 210 mm (5.85 x 8.27 inches)
A6 105 x 148.5 mm (4.13 x 5.85 inches)
Envelope Envelope B5 176 x 250 mm (6.93 x 9.84 inches) 751090 g/m? (20 Ibto 24 Ib | 5 sheets of 75 g/m? (20 Ib
bond) bond) in the multi-purpose
Envelope Monarch 98.4 x 190.5 mm (3.88 x 7.5 inches) tray
Envelope COM-10 105 x 241 mm (4.12 x 9.5 inches)
Envelope DL 110 x 220 mm (4.33 x 8.66 inches)
Envelope C5 162 x 229 mm (6.38 x 9.02 inches)
Envelope C6 114 x 162 mm (4.49 x 6.38 inches)
Transparency Letter, A4 Refer to the Plain paper section 138 to 146 g/m? (37 to 39 Ib 5 sheets of 75 g/m? (20 Ib
bond) bond) in the multi-purpose
tray
Labels Letter, Legal, Folio, Refer to the Plain paper section 120 to 150 g/m? (32 to 40 Ib 5 sheets of 75 g/m? (20 Ib
A4, JIS B5, ISO B5, bond) bond) in the multi-purpose
Executive, A5, A6 tray
Card stock Letter, Legal, Folio, Refer to the Plain paper section 60to 163 g/m2 (161043 1b 5 sheets of 75 g/m? (20 Ib

bond) in the multi-purpose
tray

Minimum size (custom)

76 x 127 mm (3 x 5 inches)

Maximum size (custom)

216 x 356 mm (8.5 x 14 inches)

60 to 163 g/m? (16 to 43 Ib
bond)

5 sheets of 75 g/m? (20 Ib
bond) in the multi-purpose
tray

1. If media weight is over 90 g/m? (24 Ib bond), use the multi-purpose tray.

2. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.
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Media sizes supported in each mode

Mode Size Source
Copy mode Letter, A4, Legal, Folio, |« tray 1
Executive, ISO B5, JIS | « optional tray 2
B5, A5, A6 * multi-purpose tray
Single side All sizes supported by |« tray 1
printing the machine + optional tray 2

* multi-purpose tray

Duplex printing Letter, A4, Legal, Folio |+ tray 1
» optional tray 2

- multi-purpose tray’

Fax mode Letter, A4, Legal + tray 1

» optional tray 2

1.75 to 90 g/m? (20 to 24 Ib bond) only

Guidelines for selecting and storing print media

When selecting or loading paper, envelopes, or other print materials,
keep these guidelines in mind:

» Always use print media that conform with the specifications listed on
page 5.3.

« Attempting to print on damp, curled, wrinkled, or torn paper can cause
paper jams and poor print quality.

« For the best print quality, use only high quality copier grade paper
specifically recommended for use in laser printers.

» Avoid using the following media types:

- Paper with embossed lettering, perforations, or a texture that is too
smooth or too rough

- Erasable bond paper

- Multi-paged paper

- Synthetic paper and thermally reactive paper

- Carbonless paper and Tracing paper.

Use of these types of paper could result in paper jams, chemical

smells, and damage to your machine.

« Store print media in its ream wrapper until you are ready to use it.
Place cartons on pallets or shelves, not on the floor. Do not place
heavy objects on top of the paper, whether it is packaged or
unpackaged. Keep it away from moisture or other conditions that can
cause it to wrinkle or curl.

 Store unused print media at temperatures between 15 °C and 30 °C.
The relative humidity should be between 10% and 70%.

« Store unused print media in a moisture-proof wrap, such as a plastic
container or bag, to prevent dust and moisture from contaminating
your paper.

+ Load special media types one sheet at a time through the multi-
purpose tray to avoid paper jams.

» To prevent print media, such as transparencies and label sheets, from
sticking together, remove them as they print out.

Guidelines for special print media

Media type

Guidelines

Envelopes

+ Successful printing on envelopes depends upon
the quality of the envelopes. When selecting
envelopes, consider the following factors:

- Weight: The weight of the envelope paper
should not exceed 90 g/m? or jamming may
occur.

- Construction: Prior to printing, envelopes
should lie flat with less than 6 mm curl, and
should not contain air.

- Condition: Envelopes should not be wrinkled,
nicked, or otherwise damaged.

- Temperature: You should use envelopes that
are compatible with the heat and pressure of
the machine during operation.

+ Use only well-constructed envelopes with sharp
and well creased folds.

» Do not use stamped envelopes.

» Do not use envelopes with clasps, snaps,
windows, coated lining, self-adhesive seals, or
other synthetic materials.

» Do not use damaged or poorly made envelopes.

» Be sure the seam at both ends of the envelope
extends all the way to the corner of the
envelope.

i

Acceptable

¥

» Envelopes with a peel-off adhesive strip or with
more than one flap that folds over to seal must
use adhesives compatible with the machine’s
fusing temperature of 180 °C for 0.1 second.
The extra flaps and strips might cause wrinkling,
creasing, or jams, and may even damage the
fuser.

 For the best print quality, position margins no
closer than 15 mm from the edges of the
envelope.

+ Avoid printing over the area where the
envelope’s seams meet.

Unacceptable
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Media type

Guidelines

Transparencies

To avoid damaging the machine, use only

transparencies designed for use in laser printers.

Transparencies used in the machine must be
able to withstand 180 °C, the machine’s fusing
temperature.

Place them on a flat surface after removing them
from the machine.

Do not leave them in the paper tray for long
periods of time. Dust and dirt may accumulate
on them, resulting in spotty printing.

To avoid smudging caused by fingerprints,
handle them carefully.

To avoid fading, do not expose printed
transparencies to prolonged sunlight.

Ensure that transparencies are not wrinkled,
curled, or have any torn edges.

Media type Guidelines
Preprinted Letterhead must be printed with heat-resistant
paper ink that will not melt, vaporize, or release

hazardous emissions when subjected to the
machine’s fusing temperature of 180 °C for

0.1 second.

Letterhead ink must be non-flammable and
should not adversely affect printer rollers.
Forms and letterhead should be sealed in a
moisture-proof wrapping to prevent changes
during storage.

Before you load preprinted paper, such as forms
and letterhead, verify that the ink on the paper is
dry. During the fusing process, wet ink can come
off preprinted paper, reducing print quality.

Labels

To avoid damaging the machine, use only labels

designed for use in laser printers.

When selecting labels, consider the following

factors:

- Adhesives: The adhesive material should be
stable at 180 °C, the machine’s fusing
temperature.

- Arrangement: Only use labels with no
exposed backing between them. Labels can
peel off sheets that have spaces between the
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with
no more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles,
bubbles, or other indications of separation.

Make sure that there is no exposed adhesive

material between labels. Exposed areas can

cause labels to peel off during printing, which
can cause paper jams. Exposed adhesive can
also cause damage to machine components.

Do not run a sheet of labels through the machine

more than once. The adhesive backing is

designed for only a single pass through the
machine.

Do not use labels that are separating from the

backing sheet or are wrinkled, bubbled, or

otherwise damaged.

Card stock or
custom-sized
materials

Do not print on media smaller than 98 mm wide
or 148 mm long.

In the software application, set margins at least
6.4 mm away from the edges of the material.

Loading paper

In the tray 1

Load the print media you use for the majority of your print jobs in the
tray 1. The tray 1 can hold a maximum of 250 sheets of 75 g/m? plain

paper.

You can purchase an optional tray (tray 2) and attach it below the
standard tray to load an additional 250 sheets of paper. For order
information for an optional tray, see page 12.1.

The paper level indicator on the front of the tray 1 and the optional tray 2
shows the amount of paper currently left in the tray. When the tray is
empty, the indicator of the bar is completely lowered.
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Loading paper in the tray 1 or optional tray 2

1 Pull open the paper tray and load paper.

You can load letterhead with the design side face down. The top
edge of the sheet with the logo should be placed at the front of the
tray.

2  After loading paper, set the paper type and size for the multi-
purpose tray. See page 5.8 for copying and faxing or the Software
section for PC-printing.

Notes

« If you experience problems with paper feed, place one sheet at
a time in the multi-purpose tray.

* You can load previously printed paper. The printed side should
be facing up with an uncurled edge at the front. If you
experience problems with paper feed, turn the paper around.
Note that print quality is not guaranteed.

Changing the size of the paper in the paper tray

To load longer sizes of paper, such as Legal-sized paper, you need to
adjust the paper guides to extend the paper tray.

GW Letter
P

paper length guide

support guide

guide lock

paper width guides

1 Press and hold the guide lock, and slide the paper length guide to
locate it in the correct paper size slot.

2  After inserting paper into the tray, adjust the support guide so that it
lightly touches the paper stack.

3 Squeeze the paper width guides, as shown and slide them to the
stack of paper until it lightly touches the side of the stack.

Notes

» Do not push the paper width guides far enough to cause the
materials to warp.

« If you do not adjust the paper width guides, it may cause paper
jams.

==ln| | (&= | (&=
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In the multi-purpose tray

The multi-purpose tray can hold special sizes and types of print material,
such as transparencies, postcards, note cards, and envelopes. It is useful

for single page printing on letterhead or colored paper.

To load paper in the multi-purpose tray:

1

Open the multi-purpose tray and unfold the multi-purpose tray
extension, as shown.

If you are using paper, flex or fan the edge of the paper stack to
separate the pages before loading.

For transparencies, hold them by the edges and avoid touching the

print side. Oils from your fingers can cause print quality problems.

Load the paper with the side to be printed on facing up.

Notes

Depending on the media type you are using, keep the following

loading guidelines:

» Envelopes: Flap side down and with the stamp area on the top
left side.

* Transparencies: Print side up and the top with the adhesive
strip entering the machine first.

* Labels: Print side up and top short edge entering the machine
first.

* Preprinted paper: Design side up with the top edge toward the
machine.

« Card stock: Print side up and the short edge entering the
machine first.

* Previously printed paper: Previously printed side down with an
uncurled edge toward the machine.

4 Squeeze the multi-purpose tray paper width guides and adjust them
to the width of the paper. Do not force too much, or the paper will be
bent, which will result in a paper jam or skew.

5 After loading paper, set the paper type and size for the multi-
purpose tray. See page 5.8 for copying and faxing or the Software
section for PC-printing.

Notes

» The settings made from the printer driver override the settings
on the control panel.

» Make sure to open the rear cover when you print on
transparencies. If not, they may tear while exiting the machine.

6 After printing, fold the multi-purpose tray extension and close the
multi-purpose tray.
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Tips on using the multi-purpose tray
» Load only one size of print media at a time in the multi-purpose tray.

» To prevent paper jams, do not add paper when there is still paper in
the multi-purpose tray. This also applies to other types of print media.

» Print media should be loaded face up with the top edge going into the
multi-purpose tray first and be placed in the center of the tray.

» Always load only the print media specified in page 5.2 to avoid paper
jams and print quality problems.

« Flatten any curl on postcards, envelopes, and labels before loading
them into the multi-purpose tray.

» Make sure to open the rear cover when you print on transparencies. If
not, they may tear while exiting the machine.

Setting the paper size and type

After loading paper in the paper tray, you need to set the paper size and
type using the control panel buttons. These settings will apply to Copy
and Fax modes. For PC-printing, you need to select the paper size and
type in the application program you use on your PC.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Paper Setup appears and press OK.
3 Press OK when Paper Size appears.

4 Press the Scroll buttons until the paper tray you want appears and
press OK.

5 Press the Scroll buttons until the paper size you are using appears
and press OK.

6 Press Back to return to the upper level.
7 Press the Scroll buttons until Paper Type appears and press OK.

8 Press the Scroll buttons until the paper type you are using appears
and press OK.

9 Press Stop/Clear to return to Standby mode.

Selecting an output location

The machine has two output locations: the rear cover (face up) and the
output tray (face down).

output tray
rear cover

The printer sends output to the output tray by default. To use the output
tray, make sure that the rear cover is closed.

Notes
« If paper coming out of the output tray has problems, such as
excessive curl, try printing to the rear cover.

» To avoid paper jams, do not open or close the rear cover while
the machine is printing.

Printing to the output tray

The output tray collects printed paper face down, in the order in which
the sheets were printed. The tray should be used for most print jobs.
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Printing to the rear cover
Using the rear cover, paper comes out of the machine face up.

Printing from the multi-purpose tray to the rear cover provides a straight
paper path. Using the rear cover might improve the output quality with
special print media.

To use the rear cover, open it by pulling down.
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Note
The fuser area inside the rear cover of your machine becomes
very hot when in use. Take care when you access this area.
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6 Copying

This chapter gives you step-by-step instructions for copying documents.

This chapter includes:

« Selecting the paper tray

« Copying

« Changing the settings for each copy
« Changing the default copy settings
- Using special copy features

- Copying on both sides of paper

« Setting copy timeout

Selecting the paper tray

After loading the print media for copy output, you must select the paper
tray you will use for copy jobs.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

Press the Scroll buttons until Paper Setup appears and press OK.

Press OK when Copy Tray appears.
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Press the Scroll buttons until the paper tray you want appears and
press OK.

6 Press Stop/Clear to return to Standby mode.

Press the Scroll buttons until Paper Source appears and press OK.

Copying

1 Press Copy.
Ready to Copy appears on the top line of the display.

2 Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.
3 Enter the number of copies using the number keypad, if necessary.

4 If you want to customize the copy settings including copy size,
darkness, and original type, by using the control panel buttons, see
page 6.1.

If necessary, you can use special copy features, such as poster
copying, 2- or 4-up copying. See page 6.2.

5 Press Start to begin copying.

Note
You can cancel the copy job during an operation. Press Stop/
Clear, and the copying will stop.

Changing the settings for each copy

Your machine provides default settings for copying so that you can
quickly and easily make a copy. However, if you want to change the
options for each copy, use the copy function buttons on the control panel.

Note

If you press Stop/Clear while setting the copy options, all of the
options you have set for the current copy job will be canceled
and returned to their default status. Or, they will automatically
return to their default status after the machine completes the
copy in progress.

Darkness

If you have an original containing faint markings and dark images, you
can adjust the brightness to make a copy that is easier to read.

To adjust the darkness of copies, press Darkness. Each time you press
the button, the following modes are available:

* Normal: Works well with standard typed or printed originals.
« Light: Works well with dark print.
« Dark: Works well with light print or faint pencil markings.

Original Type

The original type setting is used to improve the copy quality by selecting
the document type for the current copy job.

To select the document type, press Original Type. Each time you press
the button, the following modes are available:

» Text: Use for originals containing mostly text.
+ Text/Photo: Use for originals with mixed text and photographs.
» Photo: Use when the originals are photographs.

<Copying>




Reduced or enlarged copy

By using the Reduce/Enlarge button, you can reduce or enlarge the size
of a copied image from 25% to 400% when you copy original documents
from the scanner glass, or from 25% to 100% from the ADF.

To select from the predefined copy sizes:
1 Press Reduce/Enlarge.

2 Press Reduce/Enlarge or the Scroll buttons until the size setting
you want appears and press OK.

To scale the copy by directly entering the scale rate:
1 Press Reduce/Enlarge.

2 Press Reduce/Enlarge or the Scroll buttons until Custom appears
and press OK.

3 Enter the scale rate and press OK to save the selection.

Note
When you make a reduced copy, black lines may appear at the
bottom of your copy.

Changing the default copy settings

The copy options, including darkness, original type, copy size, and
number of copies, can be set to those most frequently used. When you
copy a document, the default settings are used unless they have been
changed by using the corresponding buttons on the control panel.

1 Press Copy.

2 Press Menu until Copy Setup appears on the bottom line of the
display and press OK.

3 Press OK when Change Default appears.

4 Press the Scroll buttons until the setup option you want appears
and press OK.

5 Press the Scroll buttons until the setting you want appears and
press OK.

6 Repeat steps 4 through 5, as needed.
7 Press Stop/Clear to return to Standby mode.

Note
While you are setting copy options, pressing Stop/Clear
cancels the changed settings and restores the defaults.

Using special copy features

You can use the following copy features:

Collation

You can set the machine to sort the copy job. For
example, if you make 2 copies of a 3 page original,
one complete 3 page document will print followed by a
second complete document.

N
B

1 Press Copy.
2 Load originals face up into the ADF.

i
B

For details about loading an original, see
page 5.1.

3 Enter the number of copies using the number
keypad.

4 Press Menu until Copy Feature appears on the
bottom line of the display and press OK.

5 Press OK when Copy Collation appears.
6 Press the Scroll buttons to select Yes.

7 Press OK or Start to begin copying.

One complete document will print followed by the
second complete document.

2-up or 4-up copying

Your machine can print 2 or 4 original images reduced
to fit onto one sheet of paper.

Lml| 1 press coy

h‘Hh“‘M“\‘M‘Hw‘ 2 Load originals face up in the ADF.
-

For details about loading an original, see
page 5.1.

A 2-up copying

3 Press Menu until Copy Feature appears on the
bottom line of the display and press OK.

4 Press the Scroll buttons until 2-Up or 4-Up
appears and press OK.

5 Press the Scroll buttons to select Yes.
a 4-up copying
Press OK or Start to begin copying.

Note
You cannot adjust the copy size using the
Reduce/Enlarge button for making a 2- or 4-

up copy.
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ID card copying
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Your machine can print 2-sided originals on one sheet
of A4-, Letter-, Legal-, Folio-, Executive-, B5-, A5-, or
A6-sized paper.

When you copy using this feature, the machine prints
one side of the original on the upper half of the paper
and the other side on the lower half without reducing
the size of the original. This feature is helpful for
copying a small-sized item, such as a name card.

This copy feature is available only when you place
originals on the scanner glass.

1 Press Copy.

2 Place a single original face down on the scanner
glass.

For details about loading an original, see
page 5.1.

3 Press Menu until Copy Feature appears on the
bottom line of the display and press OK.

4 Press the Scroll buttons until ID Copy appears
and press OK.

Place Front Side and Press[Start] appears on
the display.

5 Press OK or Start.

Your machine begins scanning the front side and
shows Place Back Side and Press[Start].

6 Open the scanner lid and turn the original over.

Note

If you press Stop/Clear or if no buttons
are pressed for approximately

30 seconds, the machine cancels the
copy job and returns to Standby mode.

7 Press Start to begin copying.

Note
If the original is larger than the printable area,
some portions may not be printed.

Poster copying
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Your machine can print an image onto 9 sheets of
paper (3x3). You can paste the printed pages together
to make one poster-sized document.

This copy feature is available only when you place
originals on the scanner glass.

1 Press Copy.

2 Place a single original face down on the scanner
glass.

For details about loading an original, see
page 5.1.

3 Press Menu until Copy Feature appears on the
bottom line of the display and press OK.

4 Press the Scroll buttons until Poster Copy
appears and press OK.

5 Press the Scroll buttons to select Yes.
6 Press OK or Start to begin copying.

Note
You cannot adjust the copy size using the
Reduce/Enlarge button when making a

poster.
Your original is divided into
9 portions. Each portion is scanned L -
and printed one by one in the
following order: 4| 5|8
7 8 9

6.3
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Clone copying

Your machine can print multiple image copies from the

original document on a single page. The number of
images is automatically determined by the original

image and paper size.

This copy feature is available only when you place
originals on the scanner glass.

1 Press Copy.

2 Place a single original face down on the scanner
glass.

For details about loading an original, see
page 5.1.

3 Press Menu until Copy Feature appears on the
bottom line of the display and press OK.

4 Press the Scroll buttons until Clone Copy
appears and press OK.

5 Press the Scroll buttons to select Yes.
6 Press OK or Start to begin copying.

Note

You cannot adjust the copy size using the
Reduce/Enlarge button while making a
clone copy.

Erasing background images

You can set the machine to print an image without its background. This
copy feature removes the background color and can be helpful when
copying an original containing color in the background, such as a
newspaper or a catalog.
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Press Copy.

Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.

Press Menu until Copy Feature appears on the bottom line of the
display and press OK.

Press the Scroll buttons until Erase Bkgd. appears and press OK.
Press the Scroll buttons to select On and press OK.

Press Stop/Clear to return to Standby mode.

Enter the number of copies using the number keypad.

Press Start to begin copying.

Copying on both sides of paper

By using the Duplex button on your machine, you can set the machine to
print copies on both sides of paper.

1
2

Press Duplex.

Press the Scroll buttons until the binding option you want appears.
« Off: Prints in Normal mode.

» 1->2Side Short: Prints pages to be read by flipping like a note
pad.

* 1->2Side Long: Prints pages to be read like a book.
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A 1->2Side Long A 1->2Side Short

Press OK to save your selection.

If the mode is enabled, the Duplex button is backlit.
Start copying a document.

Note
It is only available when scanning from ADF. It is not possible on
scanner glass.

Setting copy timeout

You can set the time the machine waits before it restores the default copy
settings, if you do not start copying after changing them on the control
panel.

1

Press Menu until System Setup appears on the bottom line of the
display and press OK.

Press OK when Machine Setup appears.
Press the Scroll buttons until Timeout appears and press OK.

Press the Scroll buttons until the time setting you want appears.

Selecting Off means that the machine does not restore the default
settings until you press Start to begin copying, or Stop/Clear to
cancel.

Press OK to save your selection.

Press Stop/Clear to return to Standby mode.

6.4
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7 Basic printing

This chapter explains common printing tasks.

Printing a document

Your machine allows you to print from various Windows or Macintosh.
The exact steps for printing a document may vary depending on the
application you use.

For details about printing, see the Software section.

Canceling a print job

If the print job is waiting in a print queue or print spooler, such as the
printer group in Windows, delete the job as follows:

1 Click the Windows Start menu.

2 For Windows 98/NT 4.0/2000/Me, select Settings and then
Printers.

For Windows XP/2003, select Printers and Faxes.
3 Double-click the Printer Driver Type 104 PCL 6 icon.

4 From the Document menu, select Cancel Printing (Windows 98/
Me) or Cancel (Windows NT 4.0/2000/XP/2003).

Note
You can also access this window by simply double-clicking the
printer icon at the bottom right corner of the Windows desktop.

You can also cancel the current job by pressing Stop/Clear on the control
panel.
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8 Scanning

Scanning with your machine lets you turn pictures and text into digital files
that can be stored on your computer. Then you can fax or email the files,
upload them to your website, or use them to create projects that you can
print.

This chapter includes:

« Scanning basics

« Scanning to an application using a local connection
« Scanning using a network connection

- Changing the settings for each scan job

« Changing the default scan settings

« Setting up Address Book

Scanning to an application using a local
connection

Scanning basics

Your machine offers the following ways to scan an image using a local
connection:

 Via one of the preset imaging applications. Scanning an image
launches the selected application, enabling you to control the
scanning process. See the next section.

* Via the SmarThru™ program supplied with your machine. Scanning
an image launches SmarThru™ and enables you to control the
scanning process.

+ Via the Windows Images Acquisition (WIA) driver. See the Software
section.

» To a portable USB memory device, if inserted into the USB memory
port on your machine. See page 11.1.

Also, you can send scanned images to several destinations using a
network connection:

+ To your networked computer via the ScanClair program. You can
scan an image from the machine, if network-connected, to the
computer where the ScanClair program is running.

» To Email. You can send the scanned image as an attachment to an
email. See page 8.4.

» To an FTP file server: You can scan an image and upload it to an FTP
server. See page 8.4.

+ To a computer networked via SMB (NetBEUI)2 protocol: You can scan
an image and send it to a shared folder on an SMB server. See
page 8.5.

a. A network protocol provided by Microsoft Corporation for Windows network
systems.

Make sure that your machine and computer are turned on and
properly connected to each other.

Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.

Press Scan/Email.

Ready to Scan appears on the top line of the display.

Press the Scroll buttons until Scan to Appl. appears on the bottom
line of the display and press OK.

Press the Scroll buttons until the application you want to use
appears and press OK.

» Microsoft Paint: Sends the scanned image to Microsoft Paint.

» Email: Sends the scanned image to your default email program on
your computer. A new message window opens with the image
attached.

« My Document: Saves the scanned image in the default folder, My
Documents, on your computer.

» SmarThru: Sends the scanned image to SmarThru™, installed
with the printer driver.

* OCR: Sends the scanned image to the OCR program for text
recognition.

Note

You can add more TWAIN-compliant software for scanning,
such as Adobe Photoshop Deluxe, or Adobe Photoshop,
from the Printer Settings Utility. See the Software
section.

On the selected application, adjust the scan settings and begin
scanning. For details, please refer to the application user's guide.
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Scanning using a network connection

If you have connected your machine to a network and set up network
parameters correctly, you can scan and send images over the network.

Preparing for network scanning
Before using your machine’s network scanning features, you need to
configure the following settings depending on your scan destination:

» Adding the machine to the ScanClair program for scanning to a
network client

 Registering as an authorized user for scanning to Email, FTP, or SMB
 Setting up an account for scanning to Email

» Setting up FTP servers for scanning to FTP

+ Setting up SMB servers for scanning to SMB

Adding the machine to the ScanClair program
First, install the ScanClair program. See the Software section.

To scan images from your machine to your computer through the
network, you need to register the machine as an authorized network
scanner in the ScanClair program.

1 In Windows, select Start — Programs — ScanClair —
ScanClair.

The ScanClair window opens.
2 Click the Add Device button or double-click the Add Device icon.
3 Click Next.

4 Select Browse for a scanner. (recommended), or select Connect
to this scanner. and enter the IP address of your machine.

5 Click Next.

A list of the scanners on your network appears.

6 Select your machine from the list and enter a name, user ID, and
PIN (Personal Identification Number) for the machine.

Notes
 For the scanner name, the model name of your machine is
automatically entered, but can be changed.

* You can enter an ID of up to 8 characters. The first character
must be a letter.

» The PIN must be 4 digits.
7 Click Next.
8 Click Finish.

Your machine is added to the ScanClair program and you can now
scan images through the network.

Note

You can change the scanner properties of your machine and the
scan settings from the ScanClair window. Click Properties and
set the options in each tab.

Registering authorized users

To use an FTP server or SMB server, or to send an email, you need to
register authorized users using Web Image Monitor Type 104. You can
add up to 50 users.

1 Enter your machine’s IP address as the URL in a browser and click
Go to access the web site of your machine.

2 Click Machine Settings and User Authentication.
3 Click Add.

4 Select the index number where the corresponding entry will be
stored, from 1 to 50.

5 Enter your name, user ID, password, and e-mail address.

You need to enter the registered user ID and password in the
machine when you start scanning to FTP, SMB or e-mail from the
control panel.

6 Click Apply.

Setting up an e-mail account

To scan and send an image as an email attachment, you need to set up
network parameters using Web Image Monitor Type 104.

1 Enter your machine’s IP address as the URL in a browser and click
Go to access the web site of your machine.

Click Machine Settings and E-mail Setup.
Select IP Address or Host Name.

Enter the IP address in dotted decimal notation or as a host name.

a & W N

Enter the server port number, from 1 to 65535.

The default port number is 25.

6 Putacheck mark in SMTP Requires Authentication to require
authentication.

7 Enter the SMTP server login name and password.

Setting up an FTP server

To use an FTP server, you need to set up parameters for access to FTP
servers using Web Image Monitor Type 104.

1 Enter your machine’s IP address as the URL in a browser and click
Go to access the web site of your machine.

2 Click Machine Settings and FTP Setup.
3 Click Server List.

8.2
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Click Add.
Select the index number, from 1 to 20.

Enter a name in Alias for the Setup for the corresponding Server
List entry. This name will be displayed on your machine.

Select IP Address or Host Name.

Enter the server address in dotted decimal notation or as a host
name.

Enter the server port number, from 1 to 65535.

The default port number is 21.

Put a check mark in Anonymous if you want to allow the FTP
server to be accessed by unauthorized persons.

By default, this is unchecked.
Enter the login name and password.

Enter the location the scanned image will be stored. This is the
location you have entered in the step 6.

Click Apply.

Setting up an SMB server

To use an SMB server, you need to set up parameters for access to SMB

servers using Web Image Monitor Type 104.

1
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Enter your machine’s IP address as the URL in a browser and click
Go to access the web site of your machine.

Click Machine Settings and SMB Setup.
Click Server List.

Click Add.

Select the index number, from 1 to 20.

Enter a name in Alias for the Setup for the corresponding Server
List entry. This name will be displayed on your machine.

Select IP Address or Host Name.

Enter the server address in dotted decimal notation or as a host
name.

Enter the server port number, from 1 to 65535.

The default port number is 139.
Enter the share name of the server.

Put a check mark in Anonymous if you want to allow the SMB
server to be accessed by unauthorized persons.

By default, this is unchecked.

Enter the login name and password.

13 Enter the domain name of the SMB server.

14 Enter the location the scanned image will be stored. This is the
location you have entered in the step 6.

15 Click Apply.

Scanning to a network client

Network client allows you to remotely scan an original from your network-
connected machine to your computer in JPEG, TIFF, or PDF file format.

Scanning

1 Make sure that your machine and the computer are connected to a
network and ScanClair is running on the computer.

2 Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.
3 Press Scan/Email.

4 Press the Scroll buttons until NetScan appears on the bottom line
of the display and press OK.

5 Enterthe ID you have set in the ScanClair window and press OK.
6 Enter the PIN you have set in the ScanClair window and press OK.

If the scan destination is folder type, press the Scroll buttons until
the scan setting option you want appears and press OK. Or, press
Start to immediately start scanning using the default settings.

+ Scan Size: Sets the image size.

« Original Type: Sets the original document’s type.
* Resolution: Sets the image resolution.

+ Scan Color: Sets the color mode.

» Scan Format: Sets the file format in which the image is to be
saved. If you select TIFF or PDF, you can select to scan multiple
pages.

If the scan destination is application type, go to the step 11.

8 Press the Scroll buttons until the desired status appears and press
OK.

9 Press Start to start scanning.

Your machine begins scanning the original to the computer where
the program is running.

10 Press the Scroll buttons until the application you want appears and
press OK. Scanning is started.
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Setting network scan timeout

If the ScanClair program on your computer does not send a refresh
request and does not scan a job within a specified timeout period, your
machine cancels the scan job. You can change this timeout setting as
needed.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.

3 Press the Scroll buttons until NetScanTimeout appears and press
OK.

4 Enter the desired timeout value and press OK.

The change will be broadcast over the network and will apply to all
clients connected to the network.

5 Press Stop/Clear to return to Standby mode.

Scanning to Email

You can scan and send an image as an email attachment. You first need
to set up your email account in Web Image Monitor Type 104. See page
8.2.

Before scanning, you can set the scan options for your scan job. See
page 8.5.

1 Make sure that your machine is connected to a network.

2 Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.
3 Press Scan/Email.

4 Press the Scroll buttons until Scan to Email appears on the bottom
line of the display and press OK.

5 Enter the recipient’s email address and press OK.

If you have set up Address Book, you can use a speed button or a
speed email or group email number to retrieve an address from
memory. See page 8.5.

6 To enter additional addresses, press OK when Yes appears and
repeat step 5.

To continue to the next step, press the Scroll buttons to select No
and press OK.

7 If the display asks if you want to send the email to your account,
press the Scroll buttons to select Yes or No and press OK.

Note
This prompt does not appear if you have activated the
Send To Self option in the email account setup.

8 Enter an email subject and press OK.

9 Press the Scroll buttons until the file format you want appears and
press OK or Start.

The machine begins scanning and then sends the email.

10 If the machine asks if you want to log off your account, press the
Scroll buttons to select Yes or No and press OK.

11 Press Stop/Clear to return to Standby mode.

Scanning to an FTP server

You can scan an image and then upload it to an FTP server. You need to
set up parameters for access to FTP servers from Web Image Monitor
Type 104. See page 8.2.

Before scanning, you can set the scan options for your scan job. See
page 8.5.

1 Make sure that your machine is connected to a network.

2 Load originals face up into the ADF or place a single original on the
scanner glass.

For details about loading an original, see page 5.1.
3 Press Scan/Email.

4 Press the Scroll buttons until Scan to FTP appears on the bottom
line of the display and press OK.

5 Enter the user ID and press OK.
6 Enter the password and press OK.

7 Press the Scroll buttons until the FTP server you want appears and
press OK or Start.

8 Press the Scroll buttons until the file type you want appears and
press OK or Start.

The machine begins scanning and then sends the file to the
specified server.

8.4
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Scanning to an SMB server

You can scan an image and then send it to an SMB server. You need to
set up parameters for access to SMB servers from Web Image Monitor
Type 104. See page 8.3.

Before scanning, you can set the scan options for your scan job. See
page 8.5.

1 Make sure that your machine is connected to a network.

2 Load originals face up into the ADF or place a single original on the
scanner glass.

For details about loading an original, see page 5.1.
3 Press Scan/Email.

4 Press the Scroll buttons until Scan to SMB appears on the bottom
line of the display and press OK.

5 Enter the user ID and press OK.
6 Enter the password and press OK.

7 Press the Scroll buttons until the SMB server you want appears and
press OK or Start.

8 Press the Scroll buttons until the file format you want appears and
press OK or Start.

The machine begins scanning and then sends the file to the
specified server.

Changing the settings for each scan job

Your machine provides you with the following setting options to allow you
to customize your scan jobs.

* Scan Size: Sets the image size.

+ Original Type: Sets the original document’s type.
» Resolution: Sets the image resolution.

+ Scan Color: Sets the color mode.

+ Scan Format: Sets the file format in which the image is to be saved. If
you select TIFF or PDF, you can select to scan multiple pages.
Depending on the selected scan type, this option may not appear.

To customize the settings before starting a scan job:
1 Press Scan/Email.

2 Press Menu until Scan Feature appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until the scan type you want appears and
press OK.

4 Press the Scroll buttons until the scan setting option you want
appears and press OK.

5 Press the Scroll buttons until the desired status appears and press
OK.

6 Repeat steps 4 and 5 to set other setting options.

7 When you have finished, press Stop/Clear to return to Standby
mode.

Changing the default scan settings

To avoid having to customize the scan settings for each job, you can set
up default scan settings for each scan type.

1 Press Scan/Email.

2 Press Menu until Scan Setup appears on the bottom line of the
display and press OK.

3 Press OK when Change Default appears.

4 Press the Scroll buttons until the scan type you want appears and
press OK.

5 Press the Scroll buttons until the scan setting option you want
appears and press OK.

6 Press the Scroll buttons until the desired status appears and press
OK.

7 Repeat steps 5 and 6 to change other settings.

8 To change the default settings for other scan types, press Back and
repeat from step 4.

9 Press Stop/Clear to return to Standby mode.

Setting up Address Book

You can set up Address Book with the email addresses you use
frequently via Web Image Monitor Type 104 and then easily and quickly
enter email addresses by entering the location numbers assigned to them
in Address book.

Registering speed email numbers

1 Enter your machine’s IP address as the URL in a browser and click
Go to access the web site of your machine.

2 Click Machine Settings and Local Address Book.
3 Click Add.

4 Select a location number and enter the user name and e-mail
address you want.

5 Click Apply.

Note
You can also click Import and obtain your address book from
your computer.

8.5
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Configuring group email numbers

1 Enter your machine’s IP address as the URL in a browser and click
Go to access the web site of your machine.

Click Machine Settings and Group Address Book.
Click Add.
Select a group number and enter the group name you want.

Select speed email numbers that will be included in the group.
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Click Apply.

Using Address Book entries

To retrieve an email address, use the following ways:

Speed email numbers

When you are prompted to enter a destination address while sending an
email, enter the speed email number at which you stored the address you
want.

» For a one-digit speed email location, press and hold the
corresponding digit button from the number keypad.

» For a two- or three-digit speed email location, press the first digit
button(s) and then hold down the last digit button.

You can also press the speed buttons at which you stored the address
you want.

You can also search through memory for an entry by pressing Address
Book. See page 8.6.
Group email numbers

To use a group email entry, you need to search for and select it from
memory.

When you are prompted to enter a destination address while sending an
email, press Address Book. See page 8.6.
Searching Address Book for an entry

There are two ways to search for an address in memory. You can either
scan from A to Z sequentially or search by entering the first letters of the
name associated with the address.

Searching sequentially through memory
1 If necessary, press Scan/Email.

2 Press Address Book until Search&Send appears on the bottom
line of the display and press OK.

3 Press the Scroll buttons until the number category you want
appears and press OK.

4 Press OK when All appears.

5 Press the Scroll buttons until the name and address you want
appears. You can search upwards or downwards through the entire
memory in alphabetical order.

Searching with a particular first letter
1 If necessary press Scan/Email.

2 Press Address Book until Search&Send appears on the bottom
line of the display and press OK.

3 Press the Scroll buttons until the number category you want
appears and press OK.

4 Press the Scroll buttons until ID appears and press OK.

5 Enter the first few letters of the name you want and press OK.

6 Press the Scroll buttons until the name you want appears and press
OK.

Printing Address Book

You can check your Address Book settings by printing a list.

1 Press Address Book until Print appears on the bottom line of the
display.

2 Press OK. A list showing your speed button settings, and the speed/
group email entries print out.

8.6
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9 Faxing

This chapter gives you information about using your machine as a fax

machine.

This chapter includes:

Sending a fax

Setting the fax header

Adjusting the document settings
Sending a fax automatically
Sending a fax manually
Confirming a transmission
Automatic redialing

Redialing the last number

Receiving a fax

Selecting the paper tray

Changing receiving modes

Receiving automatically in Fax mode

Receiving manually in Tel mode

Receiving automatically in Ans/Fax mode
Receiving manually using an extension telephone
Receiving faxes using DRPD mode

Receiving in secure receiving mode

Receiving faxes in memory

Printing received faxes on both sides of paper

Other ways to fax

Sending a fax to multiple destinations
Sending a delayed fax

Sending a priority fax

Forwarding faxes

Sending a fax

Setting the fax header

In some countries, you are required by law to indicate your fax number
on any fax you send. The Machine ID, containing your telephone nhumber
and name or company hame, will be printed at the top of each page sent
from your machine.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press OK when Machine Setup appears.
3 Press OK when Machine ID appears.

4  Enter your name or the company name using the number keypad.

You can enter alphanumeric characters using the number keypad,
and include special symbols by pressing the 0 button.

For details on how to enter alphanumeric characters, see page 2.3.
5 Press OK to save the ID.

6 Press the Scroll buttons until Machine Fax No. appears and press
OK.

7 Enter your fax number using the number keypad and press OK.

8 Press Stop/Clear to return to Standby mode.

Adjusting the document settings

Before starting a fax, change the following settings according to your
original’s status to get the best quality.
Resolution

The default document settings produce good results when using typical
text-based originals. However, if you send originals that are of poor
quality, or contain photographs, you can adjust the resolution to produce
a higher quality Fax.

1 Press Resolution.

2 Press Resolution or the Scroll buttons until the option you want
appears.

3 Press OK to save your selection.
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Recommended resolution settings for different original document types
are described in the table below:

Mode Recommended for:

Standard

Originals with normal sized characters.

Fine Originals containing small characters or thin lines or

originals printed using a dot-matrix printer.

Super Fine

Originals containing extremely fine detail. Super
Fine mode is enabled only if the machine with
which you are communicating also supports the
Super Fine resolution.

Notes

» For memory transmission, Super Fine
mode is not available. The resolution
setting is automatically changed to Fine.

» When your machine is set to Super Fine
resolution and the fax machine with
which you are communicating does not
support Super Fine resolution, the
machine transmits using the highest
resolution mode supported by the other
fax machine.

Photo Fax

Originals containing shades of gray or photographs.

Color Fax

Originals with colors. Sending a color fax is enabled
only if the machine with which you are
communicating supports color fax reception and
you send the fax manually. In this mode, memory
transmission is not available.

Note
The resolution setting is applied to the current fax job. To
change the default setting, see page 10.2.

Darkness

You can select the default contrast mode to fax your originals lighter or

darker.

1 Press Fax.

2 Press Menu, and then OK when Fax Feature appears on the
bottom line of the display.

3 Press OK when Darkness appears.

4 Press the Scroll buttons until the option you want appears and
press OK.

5 Press Stop/Clear to return to Standby mode.

Note
The darkness setting is applied to the current fax job. To change
the default setting, see page 10.2.

Sending a fax automatically

Press Fax.

Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.
Ready to Fax appears on the top line of the display.
Adjust the resolution and the darkness to suit your fax needs.

Enter the receiving fax machine’s number.

You can use speed buttons, speed dial numbers, or group dial
numbers. For details about storing and searching for a number, see
page 10.3.

Press Start.

If an original is placed on the scanner glass, select Yes to add
another page. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.

After the number is dialed, the machine begins sending the fax
when the receiving fax machine answers.

Note
When you want to cancel a fax job, press Stop/Clear at any
time while sending.

Sending a fax manually

Press Fax.

Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.

Adjust the resolution and the darkness to suit your fax needs. See
page 9.1.

Press On Hook Dial. You hear a dial tone.

Enter the receiving fax machine’s number.

You can use speed buttons, speed dial numbers, or group dial
numbers. For details about storing and searching for a number, see
page 10.3.

Press Start when you hear a high-pitched fax signal from the
remote fax machine.

Note
When you want to cancel a fax job, press Stop/Clear at any
time while sending.

9.2
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Confirming a transmission

When the last page of your original has been sent successfully, the
machine beeps and returns to Standby mode.

When something goes wrong while sending your fax, an error message
appears on the display. For a list of error messages and their meanings,
see page 14.7. If you receive an error message, press Stop/Clear to
clear the message and try to send the fax again.

You can set your machine to print a confirmation report automatically

each time sending a fax is completed. For further details, see page 10.1.

Automatic redialing

When the number you have dialed is busy or there is no answer when you
send a fax, the machine automatically redials the number every three
minutes, up to seven times according to the factory default settings.

When the display shows Retry Redial?, press OK to redial the number
without waiting. To cancel the automatic redialing, press Stop/Clear.

To change the time interval between redials and the number of redial
attempts. See page 10.1.

Redialing the last number

To redial the number you called last:
1 Press Redial/Pause.

2 When an original is loaded in the ADF, the machine automatically
begins to send.

If an original is placed on the scanner glass, select Yes to add
another page. Load another original and press OK. When you have
finished, select No at the Another Page? prompt.

Receiving a fax

Selecting the paper tray

After loading the print media for fax output, you have to select the paper
tray you will use for the fax reception.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Paper Setup appears and press OK.

3 Press the Scroll buttons until Paper Source appears and press
OK.

4 Press the Scroll buttons until Fax Tray appears and press OK.

5 Press the Scroll buttons until the paper tray you want appears and
press OK.

6 Press Stop/Clear to return to Standby mode.

Changing receiving modes

1 Press Fax.

2 Press Menu until Fax Setup appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Receiving appears and press OK.
4 Press OK when Receive Mode appears.

5 Press the Scroll buttons until the fax reception mode you want
appears.

* In Fax mode, the machine answers an incoming fax call and
immediately goes into the fax reception mode.

* In Tel mode, you can receive a fax by pressing On Hook Dial and
then Start. You can also pick up the handset of the extension
phone and then press the remote receive code. See page 9.4.

* In Ans/Fax mode, an answering machine attached to your
machine answers an incoming call, and the caller can leave a
message on the answering machine. If the fax machine senses a
fax tone on the line, the machine automatically switches to Fax
mode to receive the fax. See page 9.4.

« In DRPD mode, you can receive a call using the Distinctive Ring
Pattern Detection (DRPD) feature. Distinctive Ring is a telephone
company service which enables an user to use a single telephone
line to answer several different telephone numbers. For further
details, see page 9.4.

6 Press OK to save your selection.

9.3
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7 Press Stop/Clear to return to Standby mode.

Notes

« When the memory is full, the printer can no longer receive any
incoming fax. Secure free memory to resume by removing data
stored in the memory.

» To use the Ans/Fax mode, attach an answering machine to the
EXT socket on the back of your machine.

« If you do not want other people to view your received
documents, you can use secure receiving mode. In this mode,
all of the received faxes are stored in memory. For further
details, see page 9.5.

Receiving automatically in Fax mode

Your machine is preset to Fax mode at the factory. When you receive a
fax, the machine answers the call on a specified number of rings and
automatically receives the fax.

To change the number of rings, see page 10.1.

Receiving manually in Tel mode

You can receive a fax call by pressing On Hook Dial and then pressing
Start when you hear a fax tone from the remote machine.

The machine begins receiving a fax and returns to Standby mode when
the reception is completed.

Receiving manually using an extension
telephone

This features works best when you are using an extension telephone
connected to the EXT socket on the back of your machine. You can
receive a fax from someone you are talking to on the extension telephone
without going to the fax machine.

When you receive a call on the extension phone and hear fax tones,
press the keys % 9 % on the extension phone. The machine receives the
fax.

Press the buttons slowly in sequence. If you still hear the fax tone from
the remote machine, try pressing % 9 % once again.

* 9 % is the remote receive code preset at the factory. The first and the
last asterisks are fixed, but you can change the middle number to

whatever you wish. For details about changing the code, see page 10.1.

Receiving automatically in Ans/Fax mode

To use this mode, you must attach an answering machine to the EXT
socket on the back of your machine.

If the caller leaves a message, the answering machine stores the
message as it would normally. If your machine detects a fax tone on the
line, it automatically starts to receive the fax.

Notes

« If you have set your machine to Ans/Fax mode and your
answering machine is switched off, or no answering machine is
connected to EXT socket, your machine automatically goes
into Fax mode after a predefined number of rings.

« If your answering machine has a user-selectable ring counter,
set the machine to answer incoming calls within 1 ring.

* If you are in Tel mode (manual reception) when the answering
machine is connected to your machine, you must switch off the
answering machine, or the outgoing message from the
answering machine will interrupt your phone conversation.

Receiving faxes using DRPD mode

Distinctive Ring is a telephone company service which enables an user
to use a single telephone line to answer several different telephone
numbers. The particular number someone uses to call you is identified by
different ringing patterns, which consist of various combinations of long
and short ringing sounds. This feature is often used by answering
services who answer telephones for many different clients and need to
know which number someone is calling in on to properly answer the
phone.

Using the Distinctive Ring Pattern Detection (DRPD) feature, your fax
machine can learn the ring pattern you designate to be answered by the
fax machine. Unless you change it, this ringing pattern will continue to be
recognized and answered as a fax call, and all other ringing patterns will
be forwarded to the extension telephone or answering machine plugged
into the EXT socket. You can easily suspend or change DRPD at any
time.

Before using the DRPD option, Distinctive Ring service must be installed
on your telephone line by the telephone company. To set up DRPD, you
will need another telephone line at your location, or someone available to
dial your fax number from outside.

To set up the DRPD mode:
1 Press Fax.

2 Press Menu until Fax Setup appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Receiving appears and press OK.

4 Press the Scroll buttons until DRPD Mode appears and press OK.
Waiting Ring appears on the display.
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5 Call your fax number from another telephone. It is not necessary to
place the call from a fax machine.

6 When your machine begins to ring, do not answer the call. The
machine requires several rings to learn the pattern.

When the machine completes learning, the display shows
Completed DRPD Setup.

If the DRPD setup fails, Error DRPD Ring appears. Press OK when
DRPD Mode appears and start over from step 4.

7 Press Stop/Clear to return to Standby mode.

When the DRPD feature is set up, the DRPD option is available for the
receiving mode setting. To receive faxes in DRPD mode, you need to set
the menu to DRPD.

Notes

» DRPD must be set up again if you re-assign your fax number,
or connect the machine to another telephone line.

» After DRPD has been set up, call your fax number again to
verify that the machine answers with a fax tone. Then have a
call placed to a different number assigned to that same line to
be sure the call is forwarded to the extension telephone or
answering machine plugged into the EXT socket.

Receiving in secure receiving mode

You may need to prevent your received faxes from being accessed by
unauthorized people. You can turn on secure receiving mode to restrict
printing of received faxes when the machine is unattended. In secure
receiving mode, all incoming faxes go into memory. When the mode is
deactivated, any stored faxes are printed.

Activating secure receiving mode

1 Press Fax.

2 Press Menu and then press OK when Fax Feature appears on the
bottom line of the display.

3 Press the Scroll buttons until Secure Receive appears and press
OK.

4 Press the Scroll buttons until On appears and press OK.
5 Enter a four-digit password you want to use and press OK.

Note
You can activate secure receiving mode without setting a
password, but cannot protect your faxes.

6 Re-enter the password to confirm it and press OK.

7 Press Stop/Clear to return to Standby mode.

When a fax is received in secure receiving mode, your machine stores it
in memory and shows Secure Receive to let you know that there is a fax
received.

Printing received faxes

1 Access the Secure Receive menu by following steps 1 through 3 in
“Activating secure receiving mode”.

2 Press the Scroll buttons until Print appears and press OK.

3 Enter the four-digit password and press OK.

The machine prints all of the faxes stored in memory.

Deactivating secure receiving mode

1 Access the Secure Receive menu by following steps 1 through 3 in
“Activating secure receiving mode”.

2 Press the Scroll buttons until Off appears and press OK.
3 Enter the four-digit password and press OK.

The mode is deactivated and the machine prints all faxes stored in
memory.

4 Press Stop/Clear to return to Standby mode.

Receiving faxes in memory

Since your machine is a multi-tasking device, it can receive faxes while
you are making copies or printing. If you receive a fax while you are
copying or printing, your machine stores incoming faxes in its memory.
Then, as soon as you finish copying or printing, the machine
automatically prints the fax.

9.5
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Printing received faxes on both sides of paper

By using the Duplex button on your machine, you can set the machine to

print received faxes on both sides of paper.

1
2

Press Duplex.

Press the Scroll buttons until the binding option you want appears.

« Off: Prints in Normal mode.

» 1->2Side Short: Prints pages to be read by flipping like a note
pad.

* 1->2Side Long: Prints pages to be read like a book.

N

==l

l

b

a 1->2Side Long

3,1
Hm

a 1->2Side Short

Press OK to save your selection.

If the mode is enabled, the Duplex button is backlit.

Other ways to fax

Sending a fax to multiple destinations

You can use the Multiple Send feature, which allows you to send a fax to
multiple locations. Originals are automatically stored in memory and sent
to a remote station. After transmission, the originals are automatically
erased from memory.

1
2

10

Press Fax.

Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.

Adjust the document resolution and darkness to suit your fax needs.
See page 9.1.

Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

Press the Scroll buttons until Multi Send appears and press OK.

Enter the number of the first receiving fax machine and press OK.

You can use speed buttons, speed dial numbers, or group dial
numbers. For details, see page 10.3.

Enter the second fax number and press OK.

The display asks you to enter another fax number to send the
document.

To enter more fax numbers, press OK when Yes appears and
repeat steps 6 and 7. You can add up to 209 destinations.

Note
You cannot use group dial numbers for another fax number.

When you have finished entering fax numbers, select No at the
Another No.? prompt and press OK or Start.

The original is scanned into memory before transmission. The
display shows memory capacity and the number of pages being
stored in memory.

If an original is placed on the scanner glass, select Yes to add
another pages. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.

The machine begins sending the fax to the numbers you entered in
the order in which you entered them.
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Sending a delayed fax

You can set your machine to send a fax at a later time when you will not
be present.

1 Press Fax.

2 Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.

3 Adjust the document resolution and darkness to suit your fax needs.
See page 9.1.

4 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

5 Press the Scroll buttons until Delay Send appears and press OK.

6 Enter the number of the receiving machine using the number
keypad.

You can use speed buttons, speed dial numbers, or group dial
numbers. For details, see page 10.3.

7 Press OK to confirm the number. The display asks you to enter
another fax number to which to send the document.

8 To enter more fax numbers, press OK when Yes appears and
repeat steps 6 and 7. You can add up to 10 destinations.

Note

You cannot use group dial numbers for another fax number.

9 When you have finished entering fax numbers, press the Scroll
buttons to select No at the Another No.? prompt and press OK.

10 Enter the job name you want and press OK.
For details on how to enter alphanumeric characters, see page 2.3.

If you do not want to assign a name, skip this step.
11 Enter the time using the number keypad and press OK or Start.

Note
If you set a time earlier than the current time, the fax will be
sent at that time on the following day.

The original is scanned into memory before transmission. The
display shows memory capacity and the number of pages being
stored in memory.

12 If an original is placed on the scanner glass, select Yes to add
another page. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.

The machine returns to Standby mode. The display reminds you
that you are in Standby mode and that a delayed fax is set.

Adding pages to a delayed fax

You can add pages to the delayed transmissions previously reserved in
your machine’s memory.

1 Load the originals to be added and adjust document settings.

2 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

3 Press OK when Add Page appears.

4 Press the Scroll buttons until the fax job you want appears and
press OK.

The machine scans the original into memory and shows the total
number of pages and the number of the added pages.

Canceling a delayed fax

1 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Cancel Job appears and press OK.

3 Press the Scroll buttons until the fax job you want appears and
press OK.

4 Press OK when Yes appears.

The selected fax is deleted from memory.

Sending a priority fax

Using the Priority Fax feature, a high priority fax can be sent ahead of
reserved operations. The original is scanned into memory and
immediately transmitted when the current operation is finished. In
addition, priority transmission will interrupt a Multiple Send operation
between stations (i.e., when the transmission to station A ends, before
transmission to station B begins) or between redial attempts.

1 Press Fax.

2 Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.

3 Adjust the document resolution and darkness to suit your fax needs.
See page 9.1.

4 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

5 Press the Scroll buttons until Priority Send appears and press OK.

6 Enter the number of the receiving machine.

You can use speed buttons or speed dial numbers. For details, see
page 10.3.

7 Press OK to confirm the number.
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8 Enter the job name you want and press OK.

The original is scanned into memory before transmission. The
display shows memory capacity and the number of pages being
stored in memory.

9 If an original is placed on the scanner glass, select Yes to add
another page. Load another original and press OK.

When you have finished, select No at the Another Page? prompt.

The machine shows the number being dialed and begins sending
the fax.

Forwarding faxes

You can forward your incoming and outgoing faxes to another fax
machine or email address.

Forwarding sent faxes to another fax machine

You can set the machine to send copies of all outgoing faxes to a
specified destination, in addition to the fax numbers you entered.

1 Press Fax.

2 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Forward appears and press OK.
Press OK when Fax appears.

Press the Scroll buttons until Send Forward appears and press
OK.

6 Press the Scroll buttons to select On and press OK.

Enter the number of the fax machine to which faxes are to be sent
and press OK.

8 Press Stop/Clear to return to Standby mode.

Subsequent sent faxes will be forwarded to the specified fax
machine.

Forwarding sent faxes to email address

You can set the machine to send copies of all outgoing faxes to a
specified destination, in addition to the email address you entered.

1 Press Fax.

2 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Forward appears and press OK.
Press the Scroll buttons until E-mail appears and press OK.

Press the Scroll buttons until Send Forward appears and press
OK.

6 Press the Scroll buttons to select On and press OK.
Enter your email address and press OK.
Enter the email address to which faxes are to be sent and press OK.

9 Press Stop/Clear to return to Standby mode.

Subsequent sent faxes will be forwarded to the specified email
address.

Forwarding received faxes to another fax machine

You can set your machine to forward incoming faxes to another fax
number during a specified time period. When a fax arrives at your
machine, it is stored in memory. Then, the machine dials the fax number
that you have specified and sends the fax.

1 Press Fax.

2 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

Press the Scroll buttons until Forward appears and press OK.
Press OK when Fax appears.
Press the Scroll buttons until Rev. Forward appears and press OK.
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Press the Scroll buttons until Forward appears and press OK.

To set the machine to print out a fax when fax forwarding has been
completed, select Forward&Print.

7 Enter the number of the fax machine to which faxes are to be sent
and press OK.

8 Enter the starting time and press OK.
Enter the ending time and press OK.
10 Press Stop/Clear to return to Standby mode.

Subsequent received faxes will be forwarded to the specified fax
machine.

Forwarding received faxes to email address

You can set your machine to forward incoming faxes to the email address
you entered.

1 Press Fax.

2 Press Menu until Fax Feature appears on the bottom line of the
display and press OK.

Press the Scroll buttons until Forward appears and press OK.
Press the Scroll buttons until E-mail appears and press OK.
Press the Scroll buttons until Rev. Forward appears and press OK.
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Press the Scroll buttons until Forward appears and press OK.

To set the machine to print out a fax when fax forwarding has been
completed, select Forward&Print.

Enter your email address and press OK.
Enter the email address to which faxes are to be sent and press OK.
9 Press Stop/Clear to return to Standby mode.

Subsequent received faxes will be forwarded to the specified email
address.
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1 0 Fax setup

This chapter gives you information on setting up your machine for
receiving and sending faxes.

This chapter includes:

Changing the fax setup options
Changing the default document settings
Printing sent fax report automatically
Change the dial tone detection settings
Setting up Phone Book

Changing the fax setup options

Your machine provides you with various user-selectable options for
setting up the fax system. You can change the default settings for your
preferences and needs.

To change the fax setup options:

1
2

Press Fax.

Press Menu until Fax Setup appears on the bottom line of the
display and press OK.

Press the Scroll buttons to select Sending or Receiving and press
OK.

Press the Scroll buttons until the menu item you want appears and
press OK.

Press the Scroll buttons until the desired status appears or enter
the value for the option you have selected, and press OK.

If necessary, repeat steps 4 through 5.

Press Stop/Clear to return to Standby mode.

Sending options

Option Description
Redial You can specify the number of redial attempts. If you
Times enter 0, the machine will not redial.

Redial Term | Your machine can automatically redial a remote fax
machine if it was busy. You can set an interval
between attempts.

Prefix Dial You can set a prefix of up to five digits. This number
dials before any automatic dial number is started. It is
useful for accessing a PABX exchange.

ECM Mode? | This mode helps with poor line quality and makes
sure any faxes you send are sent smoothly to any
other ECM-equipped fax machine. Sending a fax

using ECM may take more time.

Option

Description

Sent Report

You can set your machine to print a confirmation
report showing whether a transmission was
successful, how many pages were sent, and more.
The available options are On, Off, and On-Error,
which prints only when a transmission is not
successful.

Image TCR® | You can prevent the actual faxed material from being
included in the confirmation report for privacy or
security protection.

Dial Mode This setting may not be available depending on your

country. If you cannot reach this option, your machine
does not support this feature.

You can set the dial mode for your machine to either
tone dialing or pulse dialing. If you have a public
telephone system or a private branch exchange
(PBX) system, you may need to select Pulse.
Contact your local telephone company if you are not
sure which dial mode to use.

Note

If you select Pulse, some phone system features
might not be available. It can also take longer to dial
a fax or phone number.

a. Error Correction Mode
b. Transmission Confirmation Report

Receiving options

Option

Description

Receive Mode

You can select the default fax receiving mode.
For details on receiving faxes in each mode, see
page 9.3.

Ring to Answer | You can specify the number of times the machine

rings before answering an incoming call.

Stamp Rcv
Name

This option allows the machine to automatically
print the page number, and the date and time of
reception at the bottom of each page of a
received fax.

Rcv Start Code | This code allows you to initiate fax reception from

an extension phone plugged into the EXT socket
on the back of the machine. If you pick up the
extension phone and hear fax tones, enter the
code. It is preset to *9* at the factory.
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Option Description

Auto
Reduction

When receiving a fax containing pages as long as
or longer than the paper loaded in the paper tray,
the machine can reduce the size of the original to
fit the size of the paper loaded in the machine.
Turn on this feature if you want to automatically
reduce an incoming page.

With this feature set to Off, the machine cannot
reduce the original to fit onto one page. The
original will be divided and printed in actual size
on two or more pages.

Discard Size When receiving a fax containing pages as long as
or longer than the paper in your machine, you can
set the machine to discard a specific length from
the end of the received fax. The machine will print
the received fax on one or more sheets of paper,
minus the data that would have been on the

specified discard segment.

When the received fax contains pages larger than
the paper in your machine, and Auto Reduction
has been turned on, the machine will reduce the
fax to fit on the existing paper, and nothing will be
discarded.

Junk Fax Setup | Using this feature, the system will not accept
faxes sent from remote stations whose numbers
are stored in the memory as junk fax numbers.
This feature is useful for blocking any unwanted

faxes.

When you turn on this feature, you can access

the following options to set junk fax numbers.

+ Add: allows you to set up to 10 fax numbers.

» Delete: allows you to delete the desired junk
fax number.

+ Delete All: allows you to delete all junk fax
numbers.

DRPD Mode? This mode enables a user to use a single
telephone line to answer several different
telephone numbers. In this menu, you can set the
machine to recognize which ring patterns to
answer. For details about this feature, see

page 9.4.

a. Distinctive Ring Pattern Detection

Changing the default document settings

The fax options, including resolution and darkness, can be set to the most
frequently used modes. When you send a fax, the default settings are
used if they are not changed by using the corresponding button and
menu.

1 Press Fax.

2 Press Menu until Fax Setup appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Change Default appears and press
OK.

4 Press OK when Resolution appears.

5 Press the Scroll buttons until the resolution you want appears and
press OK.

6 Press the Scroll buttons until Darkness appears and press OK.

7 Press the Scroll buttons until the darkness you want appears and
press OK.

8 Press Stop/Clear to return to Standby mode.

Printing sent fax report automatically

You can set the machine to print a report with detailed information about
the previous 50 communication operations, including time and dates.

1 Press Fax.

2 Press Menu until Fax Setup appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Auto Report appears and press OK.
4 Press the Scroll buttons until On appears and press OK.

5 Press Stop/Clear to return to Standby mode.

Change the dial tone detection settings

The Dial Tone Detection feature can ensure that your telephone
exchange is ready to receive the dialing.

1 Press Fax.

2 Press Menu until Fax Setup appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until DT Detection appears and press OK.

4 Press the Scroll buttons until On appears and press OK.
» On: Your machine detects the dial tone before your machine start
dialing.

« Off: The machine starts dialing without checking the dial tone from
your telephone exchanger.

5 Press Stop/Clear to return to Standby mode.

Note

There are regions where the dial tone cannot be detected by
your machine. If the Dial Tone Detection feature is set to On and
dialing does not start automatically, set this feature to Off.
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Setting up Phone Book

You can set up Phone Book with the fax numbers you use most
frequently. Your machine provides you with the following features for
setting up Phone Book:

» Speed buttons
» Speed/Group dial numbers

Note
Before beginning to store fax numbers, make sure that your
machine is in Fax mode.

Speed buttons

The 15 speed buttons on the control panel lets you store frequently-used
fax numbers. You will be able to enter a fax number with the touch of a

button. By utilizing the Shift button, you can store up to 30 numbers on

the speed buttons.

There are two ways to assign numbers to speed buttons. Examine the
procedures below and use the appropriate way which you prefer:

Registering after pressing a speed button
1 Press Fax.

2 Press one of the speed buttons.

3 Press OK when Yes appears.
4

Enter the name you want and press OK.

For details on how to enter alphanumeric characters, see page 2.3.

5 Enter the fax number you want to store and press OK.

Registering after entering a number first
1 Press Fax.

2  Enter the fax number you want to store.

3 Press one of the speed buttons.

4 Press OK when Yes appears.

Note

If you press a speed button already assigned, the display
asks if you want to overwrite. Press OK to confirm Yes and
continue. To start over with another speed button, select
No.

5 Enter the name you want and press OK.

For details on how to enter alphanumeric characters, see page 2.3.

6 Press OK to confirm the number.

Using speed buttons

When you are prompted to enter a fax number while sending a fax:

+ To retrieve a number from speed buttons 1 to 15, press the
corresponding speed button and press OK.

* To retrieve a number from speed buttons 16 to 30, press Shift and
then the corresponding speed button, and press OK.
Speed dial numbers

You can store up to 240 frequently-used fax numbers in speed dial
numbers.

Registering a speed dial number
1 Press Fax.

2 Press Address Book until New&Edit appears on the bottom line of
the display and press OK.

3 Press OK when Speed Dial appears.

4 Enter a speed dial number between 0 and 239 and press OK.

If an entry is already stored in the number you choose, the display
shows the name to allow you to change it. To start over with another
speed dial number, press Back.

5 Enter the name you want and press OK.

For details on how to enter alphanumeric characters, see page 2.3.
6 Enter the fax number you want and press OK.

7 Press Stop/Clear to return to Standby mode.

Editing speed dial numbers

1 Press Address Book until New&Edit appears on the bottom line of
the display and press OK.

Press OK when Speed Dial appears.
Enter the speed dial number you want to edit and press OK.
Change the name and press OK.

Change the fax number and press OK.
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Press Stop/Clear to return to Standby mode.

Using speed dial numbers

When you are prompted to enter a destination number while sending a
fax, enter the speed dial number at which you stored the number you
want.

» For a one-digit (0-9) speed dial number, press and hold the
corresponding digit button on the number keypad.

 For a two- or three-digit speed dial number, press the first digit
button(s) and then hold down the last digit button.
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You can also search through memory for an entry by pressing Address
Book. See page 10.4.
Group dial numbers

If you frequently send the same document to several destinations, you
can group these destinations and set them under a group dial number.
You can then use a group dial number to send a document to all of the
destinations within the group. You can set up to 200 (0 through 199)
group dial numbers using the destination’s existing speed dial numbers.

Registering a group dial number
1 Press Fax.

2 Press Address Book until New&Edit appears on the bottom line of
the display and press OK.

Press the Scroll buttons until Group Dial appears and press OK.
Enter a group dial number between 0 and 199 and press OK.
Enter a speed dial number and press OK.

Press OK when Yes appears.
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Repeat steps 5 and 6 to include other speed dial numbers into the
group.

8 When you have finished, press the Scroll buttons to select No at
the Another No.? prompt and press OK.

9 Press Stop/Clear to return to Standby mode.

Editing a group dial number

You can delete a specific entry from a group or add a new number to the
selected group.

1 Press Address Book until New&Edit appears on the bottom line of
the display and press OK.

2 Press the Scroll buttons until Group Dial appears and press OK.
3  Enter the group dial number you want to edit and press OK.

4 Enter the speed dial number you want to add or delete and press
OK.

If you entered a new speed dial number, Add? appears.

If you enter a speed dial number stored in the group, Delete?
appears.

5 Press OK to add or delete the number.

6 Press OK when Yes appears to add or delete more numbers and
repeat from step 4.

7 When you have finished, press the Scroll buttons to select No at
the Another No.? prompt and press OK.

8 Press Stop/Clear to return to Standby mode.

Using group dial numbers

To use a group dial entry, you need to search for and select it from
memory.

When you are prompted to enter a fax number while sending a fax, press
Address Book. See below.
Searching Phone Book for an entry

There are two ways to search for a number in memory. You can either
scan from A to Z sequentially, or you can search by entering the first
letters of the name associated with the number.

Searching sequentially through the memory
1 If necessary, press Fax.

2 Press Address Book until Search&Dial appears on the bottom line
of the display and press OK.

3 Press the Scroll buttons until the number category you want
appears and press OK.

4 Press OK when All appears.

5 Press the Scroll buttons until the name and number you want
appears. You can search upwards or downwards through the entire
memory in alphabetical order.

Searching with a particular first letter
1 If necessary, press Fax.

2 Press Address Book until Search&Dial appears on the bottom line
of the display and press OK.

3 Press the Scroll buttons until the number category you want
appears and press OK.

4 Press the Scroll buttons until ID appears and press OK.

5 Enter the first few letters of the name you want and press OK.

6 Press the Scroll buttons until the name you want appears and press
OK.

Deleting a Phone Book entry

You can delete entries in Phone Book one by one.

1 Press Address Book until Delete appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until the number category you want
appears and press OK.

3 Press the Scroll buttons until the searching method you want
appears and press OK.

Select Search All to search for an entry by scanning through all
entries in Phone Book.
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6
7

Select Search ID to search for an entry by the first few letters of the
name.

Press the Scroll buttons until the name you want appears and press
OK.

Or, enter the first letters and press OK. Press the Scroll buttons
until the name you want appears and press OK.

Press OK.
Press OK when Yes appears to confirm the deletion.

Press Stop/Clear to return to Standby mode.

Printing Phone Book

You can check your Phone Book settings by printing a list.

1

Press Address Book until Print appears on the bottom line of the
display.

Press OK. A list showing your speed button settings, and speed dial
and group dial entries prints out.
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11 Using USB flash memory

This chapter explains how to use a USB memory device with your
machine.

This chapter includes:

« About USB memory

» Plugging in a USB memory device

» Scanning to a USB memory device
+ Printing from a USB memory device
- Backing up data

« Managing USB memory

About USB memory

USB memory devices are available with a variety of memory capacities
to give you more room for storing documents, presentations, downloaded
music and videos, high resolution photographs, or whatever other files
you want to store or move.

You can do the following on your machine using a USB memory device:
+ Scan documents and save them on a USB memory device.
* Print data stored on a USB memory device.

» Back up Address Book/Phone Book entries and the system settings
of your machine.

* Restore backup files to the machine’s memory.
» Format the USB memory device.
» Check the available memory space.

Plugging in a USB memory device

The USB memory port on the front of your machine is designed for
USB V1.1 and USB V2.0 memory devices. Your machine supports USB
memory devices with capacity of up to 512 MB.

You must use only an authorized USB memory device with an A plug type
connector.

>¢>_ Use only a metal/shielded
S~ USB memory device.

Note
There are two USB plug types.

® _ D

Insert a USB memory device into the USB memory port on the front of
your machine.

Notes

+ Do not remove the USB memory device while the machine is in
operation, or writing to or reading from USB memory. This may
damage your machine.

« If your USB memory device has certain features, such as
security settings and password settings, your machine may not
automatically detect it. For details about these features, see
the device’s User’s Guide.

Scanning to a USB memory device

You can scan a document and save the scanned image onto a USB
memory device. There are two ways of doing this: you can scan to the
device using the default settings, or you can customize your own scan
settings.

Scanning

1 Insert a USB memory device into the USB memory port on your
machine.

2 Load originals face up into the ADF, or place a single original face
down on the scanner glass.

For details about loading an original, see page 5.1.
3 Press Scan/Email.

4 Press OK when Scan to USB appears on the bottom line of the
display.
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Press OK or Start when USB appears.

Your machine begins scanning the original, and then asks if you
want to scan another page.

Press OK when Yes appears to scan more pages. Load an original
and press Start.

Otherwise, press the Scroll buttons to select No and press OK.

After scanning is complete, you can remove the USB memory device
from the machine.

Customizing Scan to USB

You can specify image size, file format, or color mode for each scanning
to USB job.

1
2

Press Scan/Email.

Press Menu until Scan Feature appears on the bottom line of the
display and press OK.

Press OK when USB Memory appears.

Press the Scroll buttons until the setting option you want appears
and press OK.

You can set the following options:

+ Scan Size: Sets the image size.

« Original Type: Sets the original document’s type.
* Resolution: Sets the image resolution.

» Scan Color: Sets the color mode.

» Scan Format: Sets the file format in which the image is to be
saved. When you select TIFF or PDF, you can select to scan
multiple pages.

Press the Scroll buttons until the desired status appears and press
OK.

Repeat steps 4 and 5 to set other setting options.

When you have finished, press Stop/Clear to return to Standby
mode.

Printing from a USB memory device

You can directly print files stored on a USB memory device. You can print
TIFF, BMP, JPEG, PDF, and PRN files.

Direct Print option supported file types:

PRN: PCL 6 compatible.

PRN files can be created by selecting the Print to file check box when
you print a document. The document will be saved as a PRN file,
rather than printed on paper. Only PRN files created in this fashion
can be printed directly from USB memory.

See the Software section to learn how to create a PRN file.

BMP: BMP Uncompressed
TIFF: TIFF 6.0 Baseline
JPEG: JPEG Baseline
PDF: PDF 1.4 and below

To print a document from a USB memory device:

1

Insert a USB memory device into the USB memory port on your
machine. If one has already been inserted, press USB Print.

Your machine automatically detects the device and reads data
stored on it.

Press the Scroll buttons until the folder or file you want appears and
press OK.

If you see D in the front of a folder name, there are one or more
folders in the selected folder.

If you selected a file, skip to the next step.

If you selected a folder, press the Scroll buttons until the file you
want appears.

Press OK, Start, or USB Print to start printing the selected file.

If you selected a TIFF, BMP, or JPEG file in step 2, press the Scroll
buttons to select the number of copies to be printed or enter the
number and press OK.

After printing the file, the display asks if you want to print another
job.

Press OK when Yes appears to print another job, and repeat from
step 2.

Otherwise, press the Scroll buttons to select No and press OK.

Press Stop/Clear to return to Standby mode.
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Printing on both sides of paper

By using the Duplex button on your machine, you can set the machine to
print documents on both sides of paper.

1 Press Duplex.

2 Press the Scroll buttons until the binding option you want appears.
* Off: Prints in Normal mode.

» 1->2Side Short: Prints pages to be read by flipping like a note
pad.

» 1->2Side Long: Prints pages to be read like a book.
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A 1->2Side Long A 1->2Side Short

3 Press OK to save your selection.

If the mode is enabled, the Duplex button is backlit.

Backing up data

Data in the machine’s memory can be accidentally erased due to power
failure or storage failure. Backup helps you protect your Address Book/
Phone Book entries and the system settings by storing them as backup
files on a USB memory device.

Backing up data

1 Insert the USB memory device into the USB memory port on your
machine.

2 Press Menu until System Setup appears on the bottom line of the
display and press OK.

3 Press OK when Machine Setup appears.

4 Press the Scroll buttons until Export Setting appears and press
OK.

5 Press the Scroll buttons until the option you want appears.
» Address Book: Backs up all Address Book/Phone Book entries.
* Setup Data: Backs up all system settings.

6 Press OK to begin backing up the data.
The data is backed up to the USB memory.

7 Press Stop/Clear to return to Standby mode.

Restoring data

1 Insert the USB memory device on which the backup data is stored in
to the USB memory port.

2 Press Menu until System Setup appears on the bottom line of the
display and press OK.

3 Press OK when Machine Setup appears.

4 Press the Scroll buttons until Import Setting appears and press
OK.

5 Press the Scroll buttons until the data type you want appears and
press OK.

6 Press the Scroll buttons until the file containing the data you want to
restore appears and press OK.

7 Press OK when Yes appears to restore the backup file to the
machine.

8 Press Stop/Clear to return to Standby mode.

Managing USB memory

You can delete image files stored on a USB memory device one by one
or all at once by reformatting the device.

Note

After deleting files or reformatting a USB memory device, files
cannot be restored. Therefore, confirm that you no longer need
the data before deleting it.

Deleting an image file

1 Insert the USB memory device into the USB memory port on your
machine.

2 Press Scan/Email.

3 Press OK when Scan to USB appears on the bottom line of the
display.

4 Press the Scroll buttons until File Manage appears and press OK.
5 Press OK when Delete appears.

6 Press the Scroll buttons until the folder or file you want appears and
press OK.

Note
If you see D in the front of a folder name, there are one or
more folders in the selected folder.

If you selected a file, the display shows the size of the file for about
2 seconds. Go to the next step.

If you selected a folder, press the Scroll buttons until the file you
want to delete appears and press OK.

11.3

<Using USB flash memory>




7
8

Press OK when Yes appears to confirm your selection.

Press Stop/Clear to return to Standby mode.

Formatting a USB memory device

1

w

4
5
6
7

Insert the USB memory device into the USB memory port on your
machine.

Press Scan/Email.

Press OK when Scan to USB appears on the bottom line of the
display.

Press the Scroll buttons until File Manage appears and press OK.
Press the Scroll buttons until Format appears and press OK.
Press OK when Yes appears to confirm your selection.

Press Stop/Clear to return to Standby mode.

Viewing the USB memory status

You can check the amount of memory space available for scanning and
saving documents.

1

Insert the USB memory device into the USB memory port on your
machine.

Press Scan/Email.

Press OK when Scan to USB appears on the bottom line of the
display.

Press the Scroll buttons until Check Space appears and press OK.

The available memory space appears on the display.

Press Stop/Clear to return to the Standby mode.
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12 Supplies and accessories

This chapter provides information on purchasing toner cartridges and
accessories available for your machine.

Toner cartridges

When the toner runs out, you can order the following types of toner
cartridges for your machine:

Type Yield?

Standard yield Approx. 8,000 pages

a. Declared yield value in accordance with ISO/IEC 19752.

Accessories

You can purchase and install accessories to enhance your machine’s
performance and capacity.

The following accessories are available for your machine:

Accessory

Description

Optional tray

If you are experiencing frequent paper supply
problems, you can attach an additional 250
sheet tray. You can print documents on various
sizes and types of print materials.

Memory DIMM

Extends your machine’s memory capacity.

Note

Your machine comes with 64 MB of on-board memory and a
32 MB DIMM. 7o expand the memory of your machine, you
must remove the existing DIMM and purchase a larger one.

12.1
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1 3 Ma| ntenance Report/List Description

Network Info. This list shows information on your machine’s
This chapter provides information for maintaining your machine and the network connection and configuration.
toner cartridge.

NetScan Report | This report shows information for the Network
Scan records including IP address, time and

e Printing reports date, the number of pages scanned, and results.
This report is automatically printed every

50 network scan jobs.

This chapter includes:

» Clearing memory

« Cleaning your machine
User Auth List This list shows authorized users who are allowed

« Maintaining the toner cartridge ; .
to use the email function.

- Managing your machine from the website

« Checking th hine’s serial number -
ecking the mac Printing a report

— 1 Press Menu until System Setup appears on the bottom line of the
Prlntlng reports display and press OK.

Your machine can provide various reports with useful information you will 2 Press the Scroll buttons until Report appears and press OK.

need. The following reports are available: 3 Press the Scroll buttons until the report or list you want to print

appears and press OK.

Report/List Description
To print all reports and lists, select All Report.
Configuration This list shows the status of the user-selectable
options. You may print this list to confirm your 4 Press OK when Yes appears to confirm printing.

changes after changing seitings. The selected information prints out.

Address Book This list shows all of the fax numbers and email

addresses currently stored in the machine’s Other available reports
memory.
Y Your machine prints the following reports automatically or depending on
Send Report This report shows the fax number, the number of your setting.

pages, the elapsed time of the job, the
communication mode, and the communication
results for a particular fax job.

You can set up your machine to automatically
print a transmission confirmation report after
each fax job. See page 10.1.

* Multi-communication Report: prints automatically after sending
faxes from more than one location.

+ Power Failure Report: prints out automatically when power is
restored after a power failure if any data loss occurs due to the power
failure.

Sent Report This report shows information on the faxes and
emails you have recently sent.

You can set the machine to automatically print
this report every 50 communications. See
page 10.2.

Fax Rcv Report | This report shows information on the faxes you
have recently received.

Schedule Jobs | This list shows the documents currently stored
for delayed faxes along with the starting time and
type of each operation.

JunkFax Report | This list shows the fax numbers specified as junk
fax numbers. To add or delete numbers to or
from this list, access the Junk Fax Setup menu.

13.1 <Maintenance>




Clearing memory

You can selectively clear information stored in your machine’s memory.

N o o a b

Note

Before clearing the memory, make sure that all fax jobs have
been completed, or you will lose those jobs.

Press Menu until System Setup appears on the bottom line of the
display and press OK.

Press the Scroll buttons until Clear Setting appears and press OK.

Press the Scroll buttons until the item you want to clear appears.

Options Description

All Settings Clears all of the data stored in memory and
resets all of your settings to the factory default.

Fax Setup Restores all of the fax options to the factory
default.

Copy Setup Restores all of the copy options to the factory
default.

Scan Setup Restores all of the scan options to the factory

default.

System Setup

Restores all of the system options to the
factory default.

Network

Restores all of the network options to the
factory default.

Address Book

Clears all of the fax number and email address
entries stored in memory.

Sent Report

Clears all records of sent faxes and emails.

Fax Rcv Clears all records of received faxes.
Report

NetScan Clears the information on network scan
Report sessions in memory.

Press OK when Yes appears.

Press OK again to confirm clearing.

Repeat steps 3 through 5 to clear another item.

Press Stop/Clear to return to Standby mode.

Cleaning your machine

To maintain print and scan quality, follow the cleaning procedures below
each time the toner cartridge is replaced or if print and scan quality
problems occur.

Note

Cleaning the cabinet of the machine with cleaning materials
containing large amounts of alcohol, solvent, or other strong
substances can discolor or distort the cabinet.

Cleaning the outside

Clean the cabinet of the machine with a soft lint-free cloth. You can
dampen the cloth slightly with water, but be careful not to let any water
drip onto or into the machine.

Cleaning the inside

During the printing process, paper, toner, and dust particles can
accumulate inside the machine. This buildup can cause print quality
problems, such as toner specks or smearing. Cleaning the inside of the
machine clears or reduces these problems.

1 Turn the machine off and unplug the power cord. Wait for the
machine to cool down.

2 Open the front cover and pull the toner cartridge out. Set it on a
clean flat surface.

Notes

» To prevent damage to the toner cartridge, do not expose it to
light for more than a few minutes. Cover it with a piece of
paper, if necessary.

» Do not touch the green surface underside of the toner
cartridge. Use the handle on the cartridge to avoid touching
this area.
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3 With a dry lint-free cloth, wipe away any dust and spilled toner from Cieaning the scan unit

the toner cartridge area and the toner cartridge cavity.
Keeping the scan unit clean helps ensure the best possible copies. We

suggest that you clean the scan unit at the start of each day and during
the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.
2 Open the scanner lid.

3  Wipe the surface of the scanner glass and ADF glass until it is clean
and dry.

Note

While cleaning the inside of the machine, be careful not to touch
the transfer roller, located underneath the toner cartridge. Oil
from your fingers can cause print scan quality problems.

4 Locate the long strip of glass (LSU) inside the top of the cartridge
compartment, and gently swab the glass to see if dirt turns the white
cotton black.

white sheet
ADF glass
scanner lid

scanner glass

4 Wipe the underside of the scanner lid and white sheet until it is
clean and dry.

5 Close the scanner lid.

5 Reinsert the toner cartridge and close the front cover. Maintaining the toner cartridge

6 Plug in the power cord and turn the machine on.
Toner cartridge storage

To get the most from the toner cartridge, keep the following guidelines in
mind:
» Do not remove the toner cartridge from its package until ready for use.

* Do not refill the toner cartridge. The machine warranty does not
cover damage caused by using a refilled cartridge.

« Store toner cartridges in the same environment as your machine.

» To prevent damage to the toner cartridge, do not expose it to light for
more than a few minutes.

13.3 <Maintenance>




Expected cartridge life

The toner cartridge yield depends on the amount of toner that print jobs
require. Average yield for a new toner cartridge is 8,000 standard pages
in accordance with the ISO/IEC 19752 standard. (Average yield for the
original toner cartridge supplied with the machine is 4,000 standard
pages.) The actual number may also be different depending on the print
density of the pages you print on, and the number of pages may be
affected by operating environment, printing interval, media type, and
media size. If you print a lot of graphics, you may need to change the
cartridge more often.

Redistributing toner

When the toner cartridge is near the end of its life:
» White streaks or light printing occurs.

+ Toner Low appears on the display.

+ The Status LED blinks red.

If this happens, you can temporarily reestablish print quality by
redistributing the remaining toner in the cartridge. In some cases, white
streaks or light printing will still occur even after you have redistributed the
toner.

1 Open the front cover.

2 Pull the toner cartridge out.

3 Thoroughly roll the cartridge 5 or 6 times to distribute the toner
evenly inside the cartridge.

Notes

« If toner gets on your clothing, wipe it off with a dry cloth and
wash clothing in cold water. Hot water sets toner into fabric.

» Do not touch the green underside of the toner cartridge. Use
the handle on the cartridge to avoid touching this area.

4 Hold the toner cartridge by the handle and slowly insert the cartridge
into the opening in the machine.

Tabs on the sides of the cartridge and corresponding grooves within
the machine will guide the cartridge into the correct position until it
locks into place completely.
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5 Close the front cover. Make sure that the cover is securely closed.

Replacing the toner cartridge

When the toner cartridge is completely empty:
» Toner Empty appears on the display.
» The Status LED blinks red.

» The machine stops printing. Incoming faxes are saved in memory.

At this stage, the toner cartridge needs to be replaced. For order
information for toner cartridges, see page 12.1.

Note
You can set the machine to disregard the Toner Empty
message and to continue printing. See page 13.6.

1 Open the front cover.

2 Pull the toner cartridge out.

6

Remove the packing tape and roll the cartridge 5 or 6 items to
distribute the toner.

Thoroughly roll the cartridge to assure maximum copies per
cartridge. Save the box and the plastic bag for shipping.

Notes

« If toner gets on your clothing, wipe it off with a dry cloth and
wash clothing in cold water. Hot water sets toner into fabric.

» Do not touch the green underside of the toner cartridge. Use
the handle on the cartridge to avoid touching this area.

Hold the toner cartridge by the handle and slowly insert the cartridge
into the opening in the machine.

Tabs on the sides of the cartridge and corresponding grooves within
the machine will guide the cartridge into the correct position until it
locks into place completely.

Close the front cover. Make sure that the cover is securely closed.

Cleaning the drum

If there are streaks or spots on your print, the OPC drum of the toner
cartridge may require cleaning.

1

Before starting the cleaning procedure, make sure that paper is
loaded in the machine.

2 Press Menu until System Setup appears on the bottom line of the
display and press OK.

3 Press the Scroll buttons until Maintenance appears and press OK.

4 Press OK when Clean Drum appears.
The machine prints out a cleaning page. Toner particles on the drum
surface are affixed to the paper.
If the problem remains, repeat steps 1 through 4.

3 Remove the new toner cartridge from its bag.
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Sending new toner notification

You can set your machine to automatically send a fax to your service
company or dealer to notify them that your machine requires a new toner
cartridge when the toner cartridge needs to be replaced. The fax number
needs to be set by your dealer prior to using this feature, otherwise the

machine cannot send a notification even though you turn this service on.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Maintenance appears and press OK.

(2]

Press the Scroll buttons until Remote Service appears and press
OK.

4 Enter a password and press OK.

5 Re-enter the password and press OK.

6 Press the Scroll buttons to select On and press OK.
7 Press Stop/Clear to return to Standby mode.

Once this feature has been enabled, you need to enter the password
each time you disable or enable it.

Printing continuously when the Toner Empty
message appears

When the toner cartridge is nearly empty, the machine shows the Toner
Empty message and stops printing. You can set the machine to disregard
this message when it appears and to continue printing, even though print
quality is not optimal.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Maintenance appears and press OK.

3 Press the Scroll buttons until Ignore Toner appears and press OK.

4 Press the Scroll buttons until the desired status appears and press
OK.

If you select off, the received fax cannot be printed until you install a
new toner cartridge. However, faxes can be received into memory
as long as it allows

5 Press Stop/Clear to return to Standby mode.

Clearing the Toner Empty Replace Toner message

When the Toner Empty Replace Toner message appears you can
configure not to see this message again not to disturb you.

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Maintenance appears and press OK.

3 Press the Scroll buttons until CLR Empty Msg. appears and press
OK.

4 Select On and press OK.

5 Now the Toner Empty Replace Toner message does not appear
but the Replace Toner message will remain for reminding you that
the new cartridge needs to be installed for quality.

Note

Once you have selected On, this setting will be permanently
written to the memory of the toner cartridge, and this menu will
be disappeared from the Maintenance menu.

Managing your machine from the website

If you have connected your machine to a network and set up TCP/IP
network parameters correctly, you can manage the machine via Web
Image Monitor Type 104, an embedded web server. Use Web Image
Monitor Type 104 to:

+ View the machine’s device information and check its current status.
+ Change TCP/IP parameters and set up other network parameters.
» Change the printer properties.

+ Set the machine to send email notifications to let you know the
machine’s status.

+ Get support for using the machine.
To access Web Image Monitor Type 104:
1 Start a web browser, such as Internet Explorer, from Windows.

2 Enterthe machine IP address (http://xxx.xxx.xxx.xxx) in the address
field and press the Enter key or click Go.

Your machine’s embedded website opens.

Checking the machine’s serial number

When you call for service, the machine’s serial number may be required.

You can check the serial number by taking the following steps:

1 Press Menu until System Setup appears on the bottom line of the
display and press OK.

2 Press the Scroll buttons until Maintenance appears and press OK.

3 Press the Scroll buttons until Serial Number appears and press
OK.

4 Check your machine’s serial number.

5 Press Stop/Clear to return to Standby mode.
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3 Pull the jammed paper gently out of the ADF.

1 4 Troubleshooting

This chapter gives helpful information for what to do if you encounter an
error.

This chapter includes:

+ Clearing document jams

« Clearing paper jams

« Understanding display messages
« Solving other problems

Clearing document jams

When an original jams while passing through the ADF, Document Jam
appears on the display.

Caution Note
To avoid tearing the document, pull out the jammed document If you do not see the paper in this area, refer to Roller misfeed.
gently and slowly. See page 14.2.
1 Remove any remaining pages from the ADF. 4 Close the ADF cover. Then load the removed pages, if any, back into
the ADF.

2 Open the ADF cover.

ADF cover

Note
To prevent document jams, use the scanner glass for thick, thin, or
mixed paper-type originals.
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Roller misfeed

1 Open the scanner lid.

2 Seize the misfed paper, and remove the paper from the feed area by
carefully pulling it to the right using both hands.

scanner lid

3 Close the scanner lid. Then load the removed pages back into the
ADF.

Clearing paper jams

When a paper jam occurs, Paper Jam appears on the display. Refer to
the table below to locate and clear the paper jam.

Message Location of jam Go to
[Paper Jam 0] In the paper feed area (tray 1, below and
Open/Close Door optional tray 2, or multi- page 14.3

purpose tray)

[Paper Jam 1] In the fuser area or around the | page 14.3
Open/Close Door toner cartridge
[Paper Jam 2] In the paper exit area page 14.4
Check Inside
[Duplex Jam 0] In the duplex unit page 14.5
Check Inside
[Duplex Jam 1] Between the duplex unit and page 14.6
Check Inside fuser area

Note

To avoid tearing the paper, pull out the jammed paper gently
and slowly. Follow the instructions in the following sections to
clear the jam.

In the tray 1

1 Open and close the front cover. The jammed paper is automatically
ejected from the machine.

If the paper does not exit, go to the next step.

2 Pull the tray 1 open.

If the paper does not move when you pull, or if you do not see the
paper in this area, check the fuser area around the toner cartridge.
See page 14.3.

4 Insert the tray 1 into the machine until it snaps into place. Printing
automatically resumes.

14.2
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In the optional tray 2 In the multi-purpose tray
1 Pull the optional tray 2 open. 1 If the paper is not feeding properly, pull the paper out of the machine.

2 Remove the jammed paper from the machine.

2 Open and close the front cover to resume printing.

In the fuser area or around the toner cartridge
If the paper does not move when you pull, or if you do not see the

paper in this area, stop and go to step 3. Warning
A The fuser area is hot. Take care not to burn your fingers when
3 Pullthe tray 1 half.

removing paper from the machine.

4  Pull the paper straight up and out. 1 Open the front cover and pull the toner cartridge out, lightly pushing it
down.

5 Insert the trays back into the machine. Printing automatically resumes.
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2 Remove the jammed paper by gently pulling it straight out. 4 If you see the jammed paper, push the pressure lever on each side up
and remove the paper. Skip to step 9.

1)
3 Replace the toner cartridge and close the front cover. Printing ‘ ;
automatically resumes. pressure lever
In the paper exit area If you still do not see the paper, go to the next step.

5 Release the white strip, the rear cover stopper, and fully open the rear

1 Open and close the front cover. The jammed paper is automatically cover. as shown.

ejected from the machine.

2  Gently pull the paper out of the output tray.

rear cover stopper

rear cover

If you do not see the jammed paper or if there is any resistance when
you pull, stop and go to the next step.

3 Open the rear cover.
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6 Unfold the duplex guide fully. 8 Pull the jammed paper out.

If the jammed paper does not move when you pull, push the pressure
lever on each side up to loose the paper, and then remove it.

1 duplex guide

7 While pushing the fuser lever to the right, open the fuser door.

e 1 pressure lever

9 Return the lever, door, stopper, and guide to their original position.

10 Close the rear cover. Printing automatically resumes.

In the duplex unit area

If the duplex unit is not inserted correctly, paper jam may occur. Make sure
that the duplex unit is inserted correctly.

Duplex Jam 0

1 Pull the duplex unit out of the machine.

1 fuser lever

2 fuser door

duplex unit
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2 Remove the jammed paper from the duplex unit. 3 Pull the jammed paper out.

If the paper does not come out with the duplex unit, remove the paper
from the bottom of the machine.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided.
When a paper jam occurs, follow the steps outlined on page 14.2.

+ Follow the procedures on page 5.5. Ensure that the adjustable guides
are positioned correctly.

» Do not overload the tray. Ensure that the paper level is below the paper
capacity mark on the inside wall of the tray.

+ Do not remove paper from the tray while your machine is printing.
» Flex, fan, and straighten paper before loading.

» Do not use creased, damp, or highly curled paper.
» Do not mix paper types in a tray.

» Use only recommended print media. See page 5.8.

Duplex Jam 1 + Ensure that the recommended print side of print media is facing down in

1 Open the rear cover. the tray, or facing up in the multi-purpose tray.

« If paper jams occur frequently when you print on A5-sized paper:
2 Unfold the duplex guide fully. paper a y youp bap

Load the paper into the tray with the long edge facing the front of the tray.

In the printer properties window, set the page orientation to be rotated 90

\
JL duplex guide degrees. See the Software section.
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Understanding display messages Message Meaning Suggested solutions
Messages appear on the Status Monitor program window or the control gzzﬁf I‘|J1asrir<‘:lg g:ﬁr?g; Zi;lj:;‘med ?fsa.r the jam. See page

panel display to indicate the machine’s status or errors. Refer to the tables
below to understand the messages’ meaning and correct the problem if
necessary. Messages and their meanings are listed in alphabetical order.

Note

When you call for service, it is very convenient to tell the service
representative the display message.

printing.

Duplex Jam 1
Open/Close Door

Paper has jammed
during duplex

Clear the jam. See page
14.6.

Message

Meaning

Suggested solutions

Authentication
Failure

The ID or password
you entered is
incorrect.

Enter the correct ID or
password.

Cancel?
4 Yes »

Your machine’s
memory has
become full while
trying to store an
original into memory.

To cancel the fax job,
press the OK button to
accept Yes.

If you want to send those
pages that have been
successfully stored,
press the OK button to
accept No. You should
send the remaining
pages later, when
memory is available.

printing.
Enter Again You entered an Enter the correct item
unavailable item. again.
File Access Login to the network | Change the server
Denied server was settings.
successful.

However, access to
the file on the
network server was
denied.

File Name Exist

The file name you
have entered
already exists.

Enter a different file
name.

[COMM. Error]

The machine has a
communication
problem.

Ask the sender to try
again.

File Name Over
Limit

The file names you
can use are from
doc001 to doc999.
However, all file
names are used
already.

Delete unnecessary files.

Connection Error

Connection with the
SMTP server failed.

Check the server settings
and the network cable.

File Format
Not Supported

The selected file
format is not
supported.

Use the correct file
format.

Connection Failed

The protocol you
have entered is not
supported or server
port is wrong.

Check the protocol or
server port.

Fuser Door Open

The fuser door is not
securely latched.

Open the rear cover and
close the fuser door until
it locks into place.

For the location of the
fuser door, see

page 14.5.

Data Read Fail
Check USB Mem.

Time expired while
reading data.

Try again.

Data Write Fail
Check USB Mem.

Storing to the USB
memory failed.

Check the available USB
memory space.

Document Jam

The loaded original
has jammed in the
ADF.

Clear the jam. See page
14.1.

Door Open

The front cover or
rear cover is not
securely latched.

Close the cover until it
locks into place.

Group Not
Available

You have tried to
select a group
location number
where only a single
location number can
be used, such as
when adding
locations for a
Multiple Send
operation.

Use a speed dial number
or dial a number
manually using the
number keypad.

[Incompatible]

The machine has
received a fax from
which is registered
as a junk fax..

The received fax data will
be deleted.

Reconfirm junk fax setup,
see page 10.2.
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Message

Meaning

Suggested solutions

Message

Meaning

Suggested solutions

Invalid Server

The server address

Enter the correct server

[No Answer]

The receiving fax

Try again. Make sure that

Address you have entered is | address. machine has not the receiving machine is
invalid. answered after operational.
several redial
Line Busy The receiving fax Try again after a few attempts.
machine did not minutes.
answer or the line is Not Assigned The speed button or | Enter the number or
already engaged. speed dial number email address manually
you tried to use has | using the number keypad
[Line Erl’or] Your machine Try again. If the problem no number or email or store the number or
cannot connect with | persists, wait an hour or address assigned to | address.
the receiving fax so for the line to clear it.
machine or has lost and try again.
contactbecause ofa | O turn the ECM mode [No Paper] The paperinthetray | Load paper in the tray.
problem with the on. See page 10.1. Add Paper has run out. See page 5.5.
hone line.
P One Page is Single page data Reduce the resolution
Low Heat Error There is a problem Unplug the power cord Too Large exceeds the and try again.

Cycle Power

in the fuser unit.

and plug it back in. If the
problem persists, please
call for service.

configured mail size.

Open Heat Error
Cycle Power

LSU Motor Error
Cycle Power

A problem has
occurred in the LSU
(Laser Scanning
Unit).

Unplug the power cord
and plug it back inches. If
the problem persists,
please call for service.

There is a problem
in the fuser unit.

Unplug the power cord
and plug it back in. If the
problem persists, please
call for service.

Operation Not
Assigned

LSU Hsync Error

A problem has

Unplug the power cord

You are in the Add
Page/Cancel Job
operation, but there

Check the display to see
if there are any
scheduled jobs.

Cycle Power occurred inthe LSU | and plug it back inches. If are no jobs stored.
(Laser Scanning the problem persists,
Unit). please call for service. Over Heat Error There is a problem Unplug the power cord
Cycle Power in the fuser unit. and plug it back in. If the
Main Motor There is a problem Open and then close the problem persists, please
Locked in the main motor. front cover. call for service.
Mail Exceeds The malil size is Divide your mail or Paper Jam 0 Paper has jammed Clear the jam. See page

Server Support

larger than the
supported size by

reduce the resolution.

Open/Close Door

in the feeding area
of the tray.

14.2 and page 14.3.

Paper has jammed
in the fuser area.

Clear the jam. See page
14.3.

Paper has jammed
in the paper exit
area.

Clear the jam. See page
14.4.

SMTP server.
Paper Jam 1
Memory Full The memory is full. Delete unnecessary fax Open/Close Door
jobs and retransmit after
more memory becomes Paper Janj 2
available. Alternatively, Check Inside
split the transmission into
h tion.
more than one operation Power Failure
MP Tray There is no paper in | Load paper in the multi-

Paper Empty

the multi-purpose
tray.

purpose tray. See page
5.7.

Network Error

There is a problem
with the network.

Contact your network
administrator.

Power has turned off
then on and the
machine’s memory
has not been back

up.

The job which you were
trying to do before the
power failure must be
completely re-done.
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Message

Meaning

Suggested solutions

Retry Redial?

The machine is
waiting for a
specified time
interval to redial a
previously busy
station.

You can press OK to
immediately redial, or
Stop/Clear to cancel the
redial operation.

Scanner locked

The scanner module
is locked

Unlock the scanner and
press Stop/Clear.

Self Diagnostic
LSU

The LSU (Laser
Scanning Unit) in
your printer is
checking some
problems detected.

Please wait a few
minutes.

Self Diagnostic

The engine in your

Please wait a few

Temperature machine is checking | minutes.
some problems
detected.
Send Error There is a problem Configure the
(AUTH) in SMTP authentication setting.
authentication.
Send Error There is a problem Configure the DNS
(DNS) in DNS. setting.
Send Error There is a problem Configure the POP3
(POP3) in POP3. setting.
Send Error There is a problem Change to the available
(SMTP) in SMTP. server.
Send Error There is a problem Configure your network

(Wrong Config)

on the network
interface card.

interface card correctly.

[Stop Pressed]

Stop/Clear has
been pressed during
a fax transmission.

Try again.

Tray 1
Paper Empty

There is no paper in
the tray 1.

Load paper in the tray 1.
See page 5.5.

Tray 2
Paper Empty

There is no paper in
the optional tray 2.

Load paper in the
optional tray 2. See page
5.5.
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Toner cartridge-related messages

Message Meaning Suggested solutions
Install Toner A toner cartridge is not installed. Install a toner cartridge.
Invalid Toner The toner cartridge you have Install a genuine toner cartridge, designed for your printer.
installed is not for your printer.
Toner Low The toner cartridge is almost Take out the toner cartridge and thoroughly shake it. By doing this, you can temporarily

empty.

reestablish printing operations.

NonGenuine Toner
<« Stop »

The toner cartridge installed is not
a genuine cartridge.

You can select either Stop or Continue. If you do not select any, the printer will work as
Stop is selected.

If you select Stop, you cannot print until the genuine cartridge is installed. However, you
can still print any kind of reports.

If you select Continue, you can keep printing but the quality cannot be guaranteed, and the
product support is no longer provided.

If you want to change the selection, turn the printer off and on to have this message appear
again, and then re-select Stop or Continue.

NonGenuine Toner
Replace Toner1

The toner cartridge installed is not
a genuine cartridge.

This message appears when you selected Stop at the NonGenuine Toner prompt.
Install the genuine toner cartridge.

NonGenuine Toner
Replace Toner

The toner cartridge installed is not
a genuine cartridge.

This message appears when you selected Continue at the NonGenuine Toner prompt.
Install the genuine toner cartridge.

Toner Empty
Replace Toner

The toner in the cartridge has run
out.

Install a new genuine toner cartridge.

You can keep printing but the quality cannot be guaranteed, and the product support is no
longer provided.

You can configure not to see the Toner Empty Replace Toner message. See page 13.6.

Replace Toner

The toner in the cartridge has run
out.

This message appears when you turned off the Toner Empty Replace Toner message.
See page 13.6.

Install a new genuine toner cartridge.

You can keep printing but the quality cannot be guaranteed, and the product support is no
longer provided.

Toner Exhausted
<« Stop »

The lifespan of the toner cartridge
is reached.

You can select either Stop or Continue. If you do not select any, the printer will work as
Stop is selected.

If you select Stop, you cannot print until the genuine cartridge is installed.

If you select Continue, you can keep printing but the quality cannot be guaranteed, and the
product support is no longer provided.

If you want to change the selection, turn the printer off and on to have this message appear
again, and then re-select Stop or Continue.

Toner Exhausted
Replace Toner1

The lifespan of the toner cartridge
is reached.

This message appears when you selected Stop at the Toner Exhausted prompt.
Install the genuine toner cartridge.

Toner Exhausted
Replace Toner

The lifespan of the toner cartridge
is reached.

This message appears when you selected Continue at the Toner Exhausted prompt.
Install the genuine toner cartridge.
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Solving other problems

Printing problems

The following chart lists some conditions that may occur and the Condition Possible cause Suggested solutions
recommended solutions. Follow the suggested solutions until the problem -
is corrected. If the problem persists, please call for service. The . The m_achnne Is not Check the power cord
machine receiving power. connections. Check the power
i does not switch and the power source.
Paper feeding problems print.
The machine is not Select Printer Driver Type 104
Condition Suggested solutions selected as the PCL 6 as your default printer in
default printer. your Windows.
Paper is jammed | Clear the paper jam. See page 14.2.
during printing. Check the machine for the following:
Paper sticks + Ensure that there is not too much paper in the tray. * The fro.nt'cover is not closed, CIOS? the cover.
» Paper is jammed. Clear the paper jam. See page 14.2.
together. The tray can hold up to 250 sheets of paper, .
4 . » No paper is loaded. Load paper. See page 5.5.
depending on the thickness of your paper. . . !
: » The toner cartridge is not installed. Install the toner

» Make sure that you are using the correct type of cartridae
paper. See page 5.8. ge-. .

. Remove ¢ from the trav and flex or fan th If a system error occurs, contact your service

paper from the ray and flex or fan the representative.
paper.

* Humid conditions may cause some paper to stick The connection Disconnect the printer cable and
together. cable between the reconnect it.

- : : computer and the

Multiple sheets of | « Different types of paper may be stacked in the tray. machine is not

paper do not Load paper of only one type, size, and weight. connected properly.

feed. + If multiple sheets have caused a paper jam, clear

the paper jam. See page 14.2. The connection If possible, attach the cable to

cable between the another computer that is working

Paper does not » Remove any obstructions from inside the machine. computer and the properly and print a job. You can

feed into the « Paper has not been loaded correctly. Remove machine is defective. | also try using a different printer

machine. paper from the tray and reload it correctly. cable.

+ There is too much paper in the tray. Remove

Pap y The port setting is Check the Windows printer
excess paper from the tray. . ‘ ing t K that th

* The paper is too thick. Use only paper that meets incorrect. setling to make sure that Ine

L . . print job is sent to the correct
the specifications required by the machine. See
58 port. If the computer has more
. ﬁage g ld t feed into th hine. th than one port, make sure that the
an original does not feed into the machine, the machine is attached to the
ADF rubber pad may require to be replaced. correct one.
Contact your service representative.
: : The machine may be | Check the printer properties to
The paper keeps + There is too much paper in the tray. Remove configured ensure that all of the print
jamming. excess paper from the tray. If you are printing on incorrecﬂy_ Settings are correct.
special materials, use the multi-purpose tray.

« An incorrect type of paper is being used. Use only The prin.ter driver Repair the printer §oftware. See
paper that meets the specifications required by the may be incorrectly the Software section.
machine. See page 5.8. installed.

+ There may be debris inside the machine. Open the . .
front cover and remove the debris. The mathn_e IS Check the display message on

« If an original does not feed into the machine. th malfunctioning. the control panel to see if the

an original does not teed into the machiné, the machine is indicating a system

ADF rubber pad may require to be replaced. error

Contact your service representative. i
Transparencies Use only transparencies specifically designed for
stick together in laser printers. Remove each transparency as it exits
the paper exit. from the machine.
Envelopes skew Ensure that the paper guides are against both sides
or fail to feed of the envelopes.
correctly.
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Condition Possible cause Suggested solutions Condition Possible cause Suggested solutions
The The paper source For many software applications, Pages The toner cartridge Redistribute the toner, if
machine selection in the the paper source selection is print, but is defective or out of | necessary. See page 13.4.
selects printer properties found under the Paper tab within are blank. toner. If necessary, replace the toner
print may be incorrect. the printer properties. Select the cartridge.
materials correct paper source. See the
from the printer driver help screen. The file may have Check the file to ensure that it
wrong blank pages. does not contain blank pages.
paper
source. Some parts, such as | Contact a service representative.
the controller or the
A print job The job may be very | Reduce the complexity of the board, may be
is complex. page or try adjusting the print defective.
extremely quality settings.
slow. The The setting in the Select Download as Bit Image
If you are using From the Start menu, choose illustrations | software application | inthe TrueType Options window
Windows 98/Me, the | Settings and then Printers. print is wrong. of the graphic properties and
Spool Setting may Right-click the Printer Driver incorrectly print the document again.
be set incorrectly. Type 104 PCL 6 machine icon, in Adobe
choose Properties, click the lllustrator.
Details tab, and then choose the
Spool Settings button. Select The printer does not print PDF file Incompatibility between the PDF
the desired spool setting. correctly. Some parts of graphics, file and the Acrobat products:
: : : — text, or illustrations are missing. Printing the PDF file as an image
Half the The_ page orientation | Change the page orlentatlorj in may solve this problem. Turn on
page is setting may be your application. See the printer Print As Image from the Acrobat
blank. incorrect. driver help screen. printing options.
The paper size and | Ensure that the paper size in the Note: It will take longer to print
the paper size printer driver settings matches when you print a PDF file as an
settings do not the paper in the tray. image.
match. Or, ensure that the paper size in
the printer driver settings
matches the paper selection in
the software application settings
you use.
The The printer cable is Disconnect the printer cable and
machine loose or defective. reconnect. Try a print job that
prints, but you have already printed
the text is successfully. If possible, attach
wrong, the cable and the machine to
garbled, or another computer and try a print
incomplete. job that you know works. Finally,

try a new printer cable.

The wrong printer
driver was selected.

Check the application’s printer
selection menu to ensure that
your machine is selected.

The software
application is
malfunctioning.

Try printing a job from another
application.

The operating
system is
malfunctioning.

Exit Windows and reboot the
computer. Turn the machine off
and then back on again.
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Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly, you
may notice a reduction in print quality. See the table below to clear the

problem.

Condition

Suggested solutions

Light or faded print

If a vertical white streak or faded area appears

on the page:
Aa Cc » The toner supply is low. You may be able to
Aa-hCc temporarily extend the toner cartridge life. See
page 13.4. If this does not improve the print
Aa Ce quality, install a new toner cartridge.
Aa CC » The paper may not meet paper specifications;
Aa Cc for example, the paper is too moist or too
rough. See page 5.8.
« If the entire page is light, the print resolution
setting is too low or the toner save mode is on.
Adjust the print resolution and turn the toner
save mode off. See the help screen of the
printer driver and page 2.4, respectively.
» A combination of faded or smeared defects
may indicate that the toner cartridge needs
cleaning. See page 13.5.
» The surface of the LSU part inside the
machine may be dirty. Clean the LSU. See
page 13.2.

Toner specks » The paper may not meet specifications; for
e . example, the paper is too moist or too rough.
Aa > ,CC. See page 5.8.

Aab Cc * The transfer roller may be dirty. Clean the
-A'a': CC inside of your machine. See page 13.2.
A~ » The paper path may need cleaning. See page
AaBhCc. 13.2.
AalhCe
Dropouts If faded areas, generally rounded, occur
randomly on the page:
AaBbCc » A single sheet of paper may be defective. Try
AaBbCc reprinting the job.
» The moisture content of the paper is uneven
AaBbQC or the paper has moist spots on its surface.
AaBbCc Try a different brand of paper. See page 5.8.
AaBbCc + The paper lot is bad. The manufacturing

processes can cause some areas to reject
toner. Try a different kind or brand of paper.
If these steps do not correct the problem,
contact a service representative.

Condition Suggested solutions
Vertical lines If black vertical streaks appear on the page:
) ~ 1 » The drum inside the toner cartridge has
Aa Bb(:(. probably been scratched. Remove the toner
AaBbCg¢ cartridge and install a new one. See
AaBbCc page 13.5.
AaBbCa If white vertical streaks appear on the page:
AaBbCa + The surface of the LSU part inside the
machine may be dirty. Clean the LSU. See
page 13.2.
Gray background If the amount of background shading becomes
unacceptable:
AaBbCc + Change to a lighter weight paper. See
AaBbCc page 5.8.
+ Check the machine’s environment: very dry
ﬁ:agggc (low humidity) or high humidity (higher than
a C 80% RH) conditions can increase the amount
AaBbCc of background shading.

* Remove the old toner cartridge and install a
new one. See page 13.5.

Toner smear

AaBbCc
AaBhCc
AaBhCc
AaBbCc
AaBbCc

+ Clean the inside of the machine. See
page 13.2.

» Check the paper type and quality. See
page 5.8.

» Remove the toner cartridge and install a new
one. See page 13.5.

Vertical repetitive
defects

AaBch’
AaBbCc_
AaBbCc
AaBch’

AaBbCc

If marks repeatedly appear on the printed side of
the page at even intervals:

» The toner cartridge may be damaged. If a
repetitive mark occurs on the page, print a
cleaning sheet several times to clean the
cartridge; see page 13.5. After the printout, if
you still have the same problems, remove the
toner cartridge and install a new one. See
page 13.5.

 Parts of the machine may have toner on them.
If the defects occur on the back of the page,
the problem will likely correct itself after a few
more pages.

» The fusing assembly may be damaged.
Contact a service representative.
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Condition

Suggested solutions

Condition

Suggested solutions

Background scatter

Background scatter results from bits of toner
randomly distributed on the printed page.

» The paper may be too damp. Try printing with
a different batch of paper. Do not open
packages of paper until necessary so that the
paper does not absorb too much moisture.

« If background scatter occurs on an envelope,
change the printing layout to avoid printing
over areas that have overlapping seams on
the reverse side. Printing on seams can cause
problems.

« If background scatter covers the entire surface
area of a printed page, adjust the print
resolution through your software application or
the printer properties.

Wrinkles or creases

AaBbCc

 Ensure that the paper is loaded properly.

» Check the paper type and quality. See
page 5.8.

» Turn over the stack of paper in the tray. Also
try rotating the paper 180° in the tray.

 Try printing to the rear cover.

Back of printouts
are dirty

AaBbCc
AaBbCc
AaBbCc
AaBbCc
BbCc

Check for leaking toner. Clean the inside of the
machine. See page 13.2.

Black pages

» The toner cartridge may not be installed
properly. Remove the cartridge and reinsert it.

» The toner cartridge may be defective and
need replacing. Remove the toner cartridge
and install a new one. See page 13.5.

» The machine may require repair. Contact a
service representative.

Misformed « If characters are improperly formed and
characters producing hollow images, the paper stock may
be too slick. Try a different paper. See page
AaBbCc 5.8.
AaBbCc « If characters are improperly formed and
AaBbCc producing a wavy effect, the scanner unit may
AaBbCc need service. For service, contact a service
AaBbCc representative.
AaBbCc
Page skew » Ensure that the paper is loaded properly.
» Check the paper type and quality. See
AaBbCC page 5.8.
AaBbCC » Ensure that the paper or other material is
AaBbC loaded correctly and the guides are not too
AaBbC C tight or too loose against the paper stack.
C
AaBbC
C
Curl or wave » Ensure that the paper is loaded properly.
~ » Check the paper type'a_nd quality. Both high
cc temperature and humidity can cause paper
ﬁaBbCC curl. See page 5.8.
aBp C C » Turn over the stack of paper in the tray. Also
aBb try rotating the paper 180° in the tray.
AaBbgc » Try printing to the rear cover.
AgppCC
S e

Loose toner

AaBb(Cc
AaBpCc

+ Clean the inside of the machine. See
page 13.2.

» Check the paper type and quality. See
page 5.8.

» Remove the toner cartridge and install a new
one. See page 13.5.

« If the problem persists, the machine may
require repair. Contact a service
representative.

Character Voids

Character voids are white areas within parts of
characters that should be solid black:

« If you are using transparencies, try another
type of transparency. Because of the
composition of transparencies, some
character voids are normal.

* You may be printing on the wrong surface of
the paper. Remove the paper and turn it
around.

» The paper may not meet paper specifications.
See page 5.8.
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Condition

Suggested solutions

Horizontal stripes
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If horizontally aligned black streaks or smears
appear:

» The toner cartridge may be installed
improperly. Remove the cartridge and reinsert
it.

» The toner cartridge may be defective. Remove
the toner cartridge and install a new one. See
page 13.5.

« If the problem persists, the machine may
require repair. Contact a service
representative.

Copying problems

Condition

Suggested solutions

Copies are too light
or too dark.

Use Darkness to darken or lighten the
background of the copies.

Smears, lines,
marks, or spots
appears on copies.

If defects are on the original, press Darkness
to lighten the background of your copies.

If no defects are on the original, clean the scan
unit. See page 13.3.

Curl

If the printed paper is curled or paper does not
feed into the machine:

» Turn over the stack of paper in the tray. Also
try rotating the paper 180¢ in the tray.
» Try printing to the rear cover.

Copy image is
skewed.

Ensure that the original is face down on the
scanner glass or face up in the ADF.
Check that the copy paper is loaded correctly.

Blank copies print
out.

Ensure that the original is face down on the
scanner glass or face up in the ADF.

Image rubs off the
copy easily.

Replace the paper in the tray with paper from a
new package.

In high humidity areas, do not leave paper in
the machine for extended periods of time.

An unknown image
repetitively appears
on a next few
sheets or loose
toner, light print, or
contamination
occurs.

Your printer is probably being used at an altitude
of 2,500 m (8,200 ft) or above.

The high altitude may affect the print quality
such as loose toner or light imaging. You can set
this option through Printer Settings Utility or
Printer tab in printer driver's properties. Refer to
the Software section for details.

Frequent copy
paper jams occur.

Fan the stack of paper, then turn it over in the
tray. Replace the paper in the tray with a fresh
supply. Check/adjust the paper guides, if
necessary.

Ensure that the paper is the proper paper
weight. 75 g/m? bond paper is recommended.
Check for copy paper or pieces of copy paper
remaining in the machine after a paper jam has
been cleared.

Toner cartridge
produces fewer
copies than
expected before
running out of

Your originals may contain pictures, solids, or
heavy lines. For example, your originals may
be forms, newsletters, books, or other
documents that use more toner.

The machine may be turned on and off

toner. frequently.
» The scanner lid may be left open while copies
are being made.
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Scanning problems

Condition

Suggested solutions

The scanner does

not work.

Make sure that you place the original to be
scanned face down on the scanner glass, or
face up in the ADF.

There may not be enough available memory
to hold the document you want to scan. Try
the Prescan function to see if that works. Try
lowering the scan resolution rate.

Check that the USB or parallel cable is
connected properly.

Make sure that the USB or parallel cable is
not defective. Switch the cable with a known
good cable. If necessary, replace the cable.
If you are using a parallel cable, ensure that it
is compliant with IEEE 1284 standards.
Check that the scanner is configured
correctly. Check scan setting in the SmarThru
Configuration or the application you want to
use to make certain that the scanner job is
being sent to the correct port.

The unit scans
very slowly.

Check if the machine is printing received
data. If so, scan the document after the
received data has been printed.

Graphics are scanned more slowly than text.
Communication speed slows in scan mode
because of the large amount of memory
required to analyze and reproduce the
scanned image. Set your computer to the
ECP printer mode through BIOS setting. It
will help to increase the speed. For details
about how to set BIOS, refer to your
computer user’s guide.

Condition

Suggested solutions

Message appears
on your computer
screen:

» “Device can't be

set to the H/'W
mode you want.”
“Port is being
used by another
program.”

“Port is
Disabled.”
“Scanner is busy
receiving or
printing data.
When the
current job is
completed, try
again.”

“Invalid handle.”
“Scanning has
failed.”

There may be a copying or printing job in
progress. When that job is complete, try your
job again.

The Selected port is currently being used.
Restart your computer and try again.

The printer cable may be improperly
connected or the power may be off. You must
use a parallel cable that supports IEEE 1284
bi-directional communications.

The scanner driver is not installed or the
operating environment is not set up properly.
Ensure that the machine is properly
connected and the power is on, Then restart
your computer.

The USB cable may be improperly connected
or the power may be off.

Do not use parallel and USB cables at the
same time.
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ScanClair problems

Condition

Suggested solutions

Condition

Suggested solutions

| cannot find a
scanned image
file.

You can check the scanned file’s destination in
the Advanced page in the ScanClair program’s
Properties screen.

Faxes are not
received
automatically.

» The receiving mode should be set to Fax.

» Make sure that there is paper in the tray.

+ Check to see if the display shows any error
message. If it does, clear the problem.

| cannot find the
scanned image

» Check if the scanned file’s application is on your
computer.

The machine does
not send.

» Make sure that the original is loaded in the
ADF or on the scanner glass.

» Sending should show up on the display.

» Check the fax machine you are sending to,
to see if it can receive your fax.

file after + Check Send image immediately to the

scanning. specified folder using an associated default
application in the Advanced page in the
ScanClair program’s Properties screen to open
the scanned image immediately after scanning.

| forgot my ID Check your ID and PIN in the Server page in the

and PIN. ScanClair program’s Properties screen.

| cannot view To view the Help file, you need to have Internet

the Help file. Explorer 4 service pack 2 or above.

The incoming fax
has blank spaces
or is of poor-
quality.

» The fax machine sending you the fax may be
faulty.

» A noisy phone line can cause line errors.

» Check your machine by making a copy.

» The toner cartridge may be empty. Replace
the toner cartridge, referring to page 13.5.

| cannot use the
ScanClair.

Check your operating system. Supporting
operating systems are Windows 98/Me/NT 4.0/
2000/XP/2003.

Some of the words
on an incoming fax
are stretched.

The fax machine sending you the fax had a
temporary document jam.

Fax problems

There are lines on
the originals you
send.

Check your scan unit for marks and clean it.
See page 13.3.

Condition

Suggested solutions

The machine is not
working, there is no

» Unplug the power cord and plug it in again.
» Ensure that there is power to the electrical

The machine dials
a number, but a
connection with the
other fax machine
fails.

The other fax machine may be turned off, out
of paper, or cannot answer incoming calls.
Speak with the other machine operator and ask
her/him to sort out the problem.

display and the outlet.

buttons are not

working.

No dial tone » Check that the phone line is connected
sounds. properly.

» Check that the phone socket in the wall is
working by plugging in another phone.

Faxes do not store

There may not be enough memory space to

The numbers
stored in memory
do not dial
correctly.

Make sure that the numbers are stored in
memory correctly. Print a Phone Book list,
referring to page 10.5.

in memory. store the fax. If the display shows the Memory
Full message, delete from memory any faxes
you no longer need and then try again to store
the fax.

Blank areas You may have chosen the wrong paper

appear at the
bottom of each
page or on other
pages, with a small
strip of text at the
top.

settings in the user option setting. For details
about paper settings, see page 5.8.

The original does
not feed into the
machine.

» Make sure that the paper is not wrinkled and
you are putting it in correctly. Check that the
original is the right size, not too thick or thin

» Make sure that the ADF is firmly closed.

» The ADF rubber pad may need to be
replaced. Contact your service
representative.

Message
confirmation report
shows: No Dial
Tone and a
transmission is not
successful.

Turn off DT Detection (Dial Tone Detection)
feature of your machine. See page 10.2.
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Common Windows problems

Condition

Suggested solutions

“File in Use”
message appears
during installation.

Exit all software applications. Remove all
software from the StartUp Group, then restart
Windows. Reinstall the printer driver.

“Error Writing to + Ensure that the cables are connected

LPTx” message correctly, the machine is on.

appears. « If bi-directional communication is not turned
on in the driver, it will also cause this
message.

“General Close all other applications, reboot Windows

Protection Fault”,
“Exception OE”,
“Spool32”, or
“lllegal Operation”

messages appear.

and try printing again.

“Fail To Print”, “A
printer timeout
error occurred.”

messages appear.

These messages may appear during printing.
Just keep waiting until the machine finishes
printing. If the message appears in standby
mode or after printing has been completed,
check the connection and/or whether an error
has occurred.

Note

Refer to Microsoft Windows 98/Me/NT 4.0/2000/XP User’s Guide
that came with your PC for further information on Windows error

messages.

Common PostScript problems

The following situations are PS language specific and may occur when

several printer languages are being used.

Note

To receive a printed or screen-displayed message when

PostScript errors occur, open the Print Options window and click

the desired

selection next to the PostScript errors section.

Problem

Possible Cause Solution

PostScript file
cannot be
printed.

The PostScript
driver may not be
installed correctly.

* Install the PostScript
driver, referring to the
Software section.

 Print a configuration page
and verify that the PS
version is available for
printing.

« If the problem persists,
contact a service
representative.

Problem Possible Cause Solution

“Limit Check The print job was | You might need to reduce

Error’message | too complex. the complexity of the page or

appears. install more memory.

A PostScript The print job may | Make sure that the print job

error page not be PostScript. | is a PostScript job. Check to

prints. see whether the software
application expected a setup
or PostScript header file to
be sent to the machine.

The optional The printer driver | Open the PostScript driver

tray 2 is not has not been properties, select the Device

selected in the | configured to Settings tab, and set the

driver. recognize the Tray2 option of the

optional tray 2. Installable Options section

to Installed.

When print a The resolution Make sure that the resolution

document in setting in the setting in your printer driver

Macintosh with | printer driver may | matches that in Acrobat

Acrobat not be matched Reader.

Reader 6.0 or with that in

higher, colors Acrobat Reader.

print

incorrectly.

Common Macintosh problems

Problem

Suggested solutions

The printer does not print
PDF file correctly. Some
parts of graphics, text, or
illustrations are missing.

Incompatibility between the PDF file and
the Acrobat products:

Printing the PDF file as an image may
solve this problem. Turn on Print As
Image from the Acrobat printing options.
Note: It will take longer to print when
you print a PDF file as an image.

the spooler in

The document has
printed, but the print job
has not disappeared from

Mac OS 10.3.2.

higher.

Update your Mac OS to OS 10.3.3. or

14.18
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1 5 Installing accessories

Your machine is a full-featured one that has been optimized to meet most
of your printing needs. Recognizing that each user may have different
requirements, however, we make several accessories available to
enhance your machine’s capabilities.

This chapter includes:
« Precautions when installing accessories
« Installing a memory DIMM

Precautions when installing accessories

Disconnect the power cord

Never remove the control board cover while the power is being supplied.

To avoid the possibility of an electrical shock, always disconnect the
power cord when installing or removing ANY internal or external
accessories.

Discharge static electricity

The control board and internal accessories (network interface card or
memory DIMM) are sensitive to static electricity. Before installing or
removing an internal accessories, discharge static electricity from your
body by touching something metal, such as the metal back plate on any
device plugged into a grounded power source. If you walk round before
finishing installation, discharge any static electricity once again.

Installing a memory DIMM

Your machine has a dual in-line memory module (DIMM) slot. Use this
DIMM slot to install additional memory.

Your machine has 96 MB of memory. It can be expanded to 320 MB.
However, you must remove the preinstalled memory DIMM before
upgrading the memory.

For order information for optional memory DIMMSs, see page 12.1.

1 Turn the machine off and unplug all cables from the machine.

2 Grasp the control board cover and slide toward you to open it.

control board cover

3 Completely open the latch on each side of the DIMM slot and
remove the preinstalled memory DIMM.

3

\
o

latch
memory DIMM

4 Take out a new memory DIMM from the plastic bag.

5 Holding the memory DIMM by the edges, align the notches on the
memory DIMM with the grooves on the memory DIMM slot.

Note
The notches and grooves illustrated above may not match
those on an actual DIMM and the slot.

15.1
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6 Push the DIMM straight into the DIMM slot until it snaps into place. Activating the added memory in the PS printer
Make sure the latches fit over the notches located on either side of properties

the DIMM.

After installing the memory DIMM, you need to select it in the printer
properties of the PostScript printer driver so that you can use it.

O 1 Make sure that the PostScript printer driver is installed on your
computer. For details about installing the PS printer driver, see the

0 Software section.

2 Click the Windows Start menu.

3 For Windows 98/Me/NT 4.0/2000, select Settings and then
Printers.

7 Replace the control board cover. For Windows XP, select Printers and Faxes.

4 Select the Printer Driver Type 104 PS printer.

5 Click the right mouse button on the machine icon and select
Properties.

6 For Windows 98/Me, select Device Options.
For Windows NT 4.0/2000/XP, select Device Settings.

7 Select the amount of memory you installed from Printer Memory in
the Installable Options section.

For Windows 98, select Installable Options — VMOption —
change setting for:VMOption — change memory.

8 Click OK.

8 Reconnect the power cord and printer cable, and turn the machine
on.
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1 6 Specifications

This chapter includes:

General specifications

Scanner and copier specifications

Printer specifications

Facsimile specifications

General specifications

Item

Description

ADF

Up to 50 sheets (75 g/m?)

ADF document size

Width: 142 to 216 mm
Length: 148 to 356 mm

Paper input capacity

Tray 1/2: 250 multi-pages for plain paper
(75 g/m?)

Multi-purpose tray: 50 pages for plain paper,
5 pages for card stock, labels,
transparencies, and envelopes

(60 to 163 g/m?)

Paper output
capacity

Output tray: 150 sheets (face down)
Rear cover: 1 sheet (face up)

Consumables

1-piece toner cartridge system

Power rating

110 - 127 VAC, 50/60 Hz, 6.4 A
220 - 240 VAC, 50/60 Hz, 3.2 A

Power consumption

Average: Less than 520 W
Power save mode: Less than 20 W

Noise level?

Standby mode: Less than 39 dBA
Printing: Less than 54 dBA
Copying mode: Less than 55 dBA
Warm up: Less than 49 dBA

Warm-up time

Less than 20 seconds (from sleep mode)

Operating
environment

Temperature: 10 °C to 32 °C
Humidity: 20% to 80% RH

Display

16 characters x 2 lines

Toner cartridge yieldb

8,000 pages (for starter, 4,000 pages)

Memory

96 MB (max. 320 MB)

External dimension
(WxDxH)

466 x 435.4 x 458 mm
(18.3x 17.1 x 18 in)

Item

Description

Weight (including
consumables)

18.9 Kg (41.6 Ib)

Package weight Paper: 2.8 Kg (6.17 Ib)
Plastic: 0.7 Kg (1.54 Ib)
Duty cycle Monthly print: Up to 25,000 pages

a. Sound Pressure Level, ISO 7779

b. Average cartridge yield declared in accordance with ISO/ IEC 19752. The
number of pages may be affected by operating environment, printing interval,
media type, and media size.

Printer specifications

Item

Description

Printing method

Laser Beam Printing

Printing speed?

Up to 28 ppm in A4 (30 ppm in Letter)

Duplex printing
speed

Up to 19 ipm in A4 (21 ipm in Letter)

First print out time

8.5 seconds (from ready)

Print resolution

Up to 1,200 x 1,200 dpi effective output

Printer language

PCL 6, PS3

OS Compatibility

Windows 98/Me/NT 4.0/2000/XP/2003
Macintosh 10.3 ~ 10.4

Interface

IEEE 1284 Parallel
High Speed USB 2.0
Ethernet 10/100 Base TX (Embedded type)

a. Print speed will be affected by operating system used, computing performance,
application software, connecting method, media type, media size, and job

complexity.
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Scanner and copier specifications

Item

Description

Compatibility

TWAIN standard / WIA standard

Scanning method

ADF and Flat-bed Color CCD (Charge
Coupled Device) module

Resolution

Optical: 600 x 1,200 dpi (mono and color)
Enhanced: 4,800 x 4,800 dpi

Effective scanning

Scanner glass: 297 mm

length ADF: 356 mm
Effective scanning Max 208 mm
width

Color bit depth 24 bit

Mono bit depth

1 bit for Black & White mode
8 bit for Gray mode

Copy speed?®

Up to 28 ppm in A4 (30 ppm in Letter)

Copy resolution

Scan: up to 600 x 300 (text, text/photo)

up to 600 x 600 (photo using platen)

up to 600 x 300 (photo using ADF)
Print: up to 600 x 600 (text, text/photo, photo)

Zoom rate

Scanner glass: 25 to 400%
ADF: 25 to 100%

Multiple copies

1 to 99 pages

Grayscale

256 levels

a. Copy Speed is based on Single Document Multiple Copy.

Facsimile specifications

ltem Description
Compatibility ITU-T Group 3
Applicable line Public Switched Telephone Network (PSTN)
or behind PABX
Data coding MH/MR/MMR/JBIG/JPEG

Color fax transmission: JPEG

Modem speed

33.6 Kbps

Transmission
speed

Approx. 3 seconds/page?

Maximum
document length

Scanner glass: 297 mm
Automatic document glass: 356 mm

Resolution Standard: 203 x 98 dpi
Fine: 203 x 196 dpi
Super Fine: 300 x 300 dpi
Photo: 203 x 196 dpi
Color: 200 x 200 dpi
Memory 6 MB
Halftone 256 levels
Auto dialer Speed dialing (up to 240 numbers)

a. Transmission time applies to memory transmission of text data with ECM
compression using only ITU-T No.1 Chart.
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INDEX

Numerics
2/4-up, special copy 6.2

A

accessories

installing

memory DIMM 15.1

order information 12.1
Address Book, use 8.5
ADF 1.2
ADF, load 5.1
alarm sound 2.3

Ans/Fax mode, receiving mode 9.4

B

background image, erase 6.4

C

characters, enter 2.3
cleaning
drum 13.5
inside 13.2
LSU 13.3
outside 13.2
scan unit 13.3
clock mode 2.2
clone, special copy 6.4
collation, special copy 6.2
component location 1.2
control panel 1.3
copying
2/4-up 6.2
collation 6.2
default setting, change 6.2
erasing background 6.4
ID card copy 6.3
poster 6.3
time out, set 6.4

D

date and time, set 2.2

default mode, change 2.2

delayed fax 9.7

DIMM, install 15.1

display language, change 2.2

DRPD (Distinctive Ring Pattern Detection)
9.4

drum, clean 13.5

E

Erasing background, special copy 6.4
error messages 14.7

F

fax header, set 9.1
Fax mode, receiving mode 9.4
fax number, set 9.1
faxing
default settings, change 10.2
delayed faxes 9.7
fax setup 10.1
forwarding faxes 9.8
Multiple Send faxes 9.6
original settings 9.1
priority faxes 9.7
receiving faxes 9.3
sending faxes 9.2
forwarding faxes 9.8

G

Group dial numbers, set 10.4

H
high altitude 14.15

ID card, special copy 6.3
installing accessories
memory 15.1

J

jam, clear
document 14.1
paper 14.2

job timeout, set 2.4

K
key sound 2.3

L

loading originals
ADF 5.1
scanner glass 5.1
loading paper
multi-purpose tray 5.7
tray 1/optional tray2 5.5

M

machine ID, set 9.1
Macintosh problems 14.18
memory DIMM, install 15.1
memory, clear 13.2
Multiple Send faxes 9.6
multi-purpose tray 5.7

N

network scan
scanning 8.3
timeout, set 8.4

network setup
EtherTalk 4.2




operating systems 4.1
TCP/IP 4.1
new toner notification, send 13.6
n-up (multiple pages per sheet)
copying 6.2

o)

originals
jam, clear 14.1
loading 5.1

output location, select 5.8
output tray 5.8

P

paper guidelines 5.4
paper jam, clear
duplex area 14.5

fuser area or around toner cartridge

14.3
multi-purpose tray 14.3
optional tray 2 14.3
paper exit area 14.4
tray 1 14.2
paper level indicator 5.5
paper load
multi-purpose tray 5.7
tray 1/optional tray 2 5.5
paper size
setting 5.8
specifications 5.3
paper tray, set
copy 6.1
fax 9.3
paper type
setting 5.8
specifications 5.3
Phone Book
group dial numbers 10.4
speed buttons 10.3
speed dial numbers 10.3
poster, special copy 6.3
PostScript problems 14.18
power save mode 2.4
print quality problems, solve 14.13
printing
reports 13.1
USB memory 11.2
priority fax 9.7
problem, solve
copying 14.15
error messages 14.7
faxing 14.17
Macintosh 14.18

paper feeding 14.11
PostScript errors 14.18
printing 14.11

printing quality 14.13
ScanClair Type 104 14.17
scanning 14.16
Windows 14.18

R

rear cover, use 5.9
receiving a fax
in Ans/Fax mode 9.4
in DRPD mode 9.4
in Fax mode 9.4
in Secure Receiving mode 9.5
in Tel mode 9.4
in the memory 9.6
receiving modes 9.3
redialing
automatically 9.3
manually 9.3
replacing
toner cartridge 13.5
replacing, toner cartridge 13.6
reports, print 13.1
ringer 2.3

S

scan power save mode 2.4
ScanClair Type 104 program
adding scanners 8.2

problems 14.17
scanner glass

cleaning 13.3

loading documents 5.1
scanning

default setting, change 8.5

scan settings 8.5

to application 8.1

to email 8.4

to FTP server 8.4

to network computer 8.3

to SMB server 8.5

USB flash memory 11.1
secure receiving mode 9.5
sending a fax

automatically 9.2

manually 9.2
sounds, set 2.3
speaker sound 2.3
speaker volume 2.3
special copy features 6.2
special print media, guidelines 5.4

specifications

facsimile 16.2

general 16.1

paper 5.3

printer 16.1

scanner and copier 16.2
speed buttons, set 10.3
speed dial numbers, set 10.3
Status LED 1.4
supplies

order information 12.1
system requirements

Macintosh 3.2

%

Tel mode, receiving mode 9.4
toner cartridge
cleaning 13.5
maintaining 13.3
redistributing 13.4
replacing 13.5, 13.6
toner save mode, use 2.4

U

USB flash memory
data backup 11.3
managing 11.3
printing 11.2
scanning 11.1

'

volume, adjust
ringer 2.3
speaker 2.3

w
Windows problems 14.18
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Installing Printer
Software in Windows

This chapter includes:
e Installing Printer Software
e Reinstalling Printer Software

e Removing Printer Software

Installing Printer Software

You can install the printer software for local printing or network
printing. To install the printer software on the computer,
perform the appropriate installation procedure depending on
the printer in use.

A printer driver is software that lets your computer
communicate with your printer. The procedure to install drivers
may differ depending on the operating system you are using.

All applications should be closed on your PC before beginning
installation.

Installing Software for Local Printing

A local printer is a printer directly attached to your computer
using the printer cable supplied with your printer, such as a USB
or parallel cable. If your printer is attached to a network, skip
this step and go to “Installing Software for Network Printing” on
page 7.

You can install the printer software using the typical or custom
method.

NoOTE: If the "New Hardware Wizard” window appears during
the installation procedure, click = in the upper right corner of
the box to close the window, or click Cancel.

4

Typical Installation

This is recommended for most users. All components necessary
for printer operations will be installed.

1 Make sure that the printer is connected to your computer
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation
window appears.

If the installation window does not appear, click Start and
then Run. Type X:\Setup.exe, replacing “X" with the
letter which represents your drive and click OK.

2 Type 104 X

YWelcome to Type 104 Setup

Thiz wizard will help install Type 104 companents.
Itis striongly recommended that you quit all Windows applications before
unhing Setup.

Thiz printer will automatically substitute fonts shown on your screen with
similar looking fonts located in the printer

To avoid substitution, go to the "Extras” tab of the printer driver and do
nat check “Use Printer Fonts"

View User's Guide |

Select a language from the list below.

English j

%2.00.59.05

3 Click Next.
¢ If necessary, select a language from the drop-down list.

¢ View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

4 Select Typical installation for a local printer. Click
Next.

<2 Type 104 3

Select Installation Type

Select type that pau want and click [Mext] buttan.

[Typical instailation for & . L
o .
0 localprinter Install defaulk components for & device that is directly connected to user's

computer

o~ Typical installation for a

network printer Install softwares for & device that is on network

You can select installation options. This option is recommended for
professional users.

" Custom installation

<Back | Next> | Cancel
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NOTE: If your printer is not already connected to the
computer, the following window will appear.

¢ If you don’t want to connect the printer at this time, click
Next, and No on the following screen. Then the installation
will start and a test page will not be printed at the end of the

e The installation window that appears in this User’s

Connect Device

Setup can not find & connected device. Check connection between your computer
and the printer

It pou want ta install Type 104 properly you have to connect Type 104
befare installation. You may connect the device using the printer cable

as the figure shows, then tum on the power of Type 104,
Click [Mext>].

Pleaze refer ta the following conhection methad.
1. Connect the device to your computer

2. Turh on the power of the device

3.1t "New Hardware 'wizard" is appeared, close it

4. Click [Next]

After connecting the printer, click Next.

installation.

Guide may differ depending on the printer and
interface in use.

5 After the installation is finished, a window asking you to
print a test page appears. If you choose to print a test

7

page, select the checkbox and click Next.
Otherwise, just click Next and skip to step 7.
If the test page prints out correctly, click Yes.

If not, click No to reprint it.
Click Finish.

Type 104

Setup Completed

Setup has finished instaling Type 104 on your computer.

NOTE: After setup is complete, if your printer driver doesn’t
work properly, reinstall the printer driver. See “Reinstalling

Printer Software” on page 10.

5

Custom Installation

You can choose individual components to install.

1 Make sure that the printer is connected to your computer
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation
window appears.
If the installation window does not appear, click Start and
then Run. Type X:\Setup.exe, replacing “X" with the
letter which represents your drive and click OK.

YWelcome to Type 104 Setup

Thiz wizard will help install Type 104 companents.
Itis striongly recommended that you quit all Windows applications before
unhing Setup.

Thiz printer will automatically substitute fonts shown on your screen with
similar looking fonts located in the printer

To avoid substitution, go to the "Extras” tab of the printer driver and do
nat check “Use Printer Fonts"

View User's Guide |

Select a language from the list below.

English j
e2.00.59.05

3 Click Next.
e If necessary, select a language from the drop-down list.

¢ View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

4 Select Custom installation. Click Next.

1 Type 104

Select Installation Type

Select type that you want and click [Next] button,

o~ Typical installation for &

local printer Install default components for a device that is directly connected to user's

Conmputer

o~ Typical installstion for &
network, printer

Install softwares for 3 device that is on network,

You can select installation options. This option is recommended for
professional users.

«Back | Nexts | Cancel
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5 Select your printer and click Next. 6 Select the components to be installed and click Next.

1 Type 104

Select Printer Port

Select components that you would like to install

Select a port that will be used for your printer

f* Local or TCPAP Port Select components
" Shared Frinter [UNC]

" 4dd TCP/IP Part

] Select components that you would like to install
[iA Printer Driver Type 104 PS printer driver

5]

[iA Status Monitor

[iA Printer Settings Utiity

ASmarThu

Select a printer from the list below. IF you don't see your printer below, click [Update] to refresh the list.

Printer Mame ‘ IP/Part Name
¢~ MFP Type 104 USBO01

Change Destination Folder

Install Type 104 to:
@ C:\Program Files\MFP Type 104

NOTE: If 3 firewsall has been enabled on this PC, this may be preventing the installer from Update
detecting the printer. Tempararily disable the firewall on this PC before continuing with the:
installation,

«Back ‘ Cancel ‘

«Back | Nexts | Cancel |

NOTE: You can change the desired installation folder by

NOTE: If your printer is not already connected to the o
clicking [Browse].

computer, the following window will appear.

Connect Device 7 After the installation is finished, a window asking you to
print a test page appears. If you choose to print a test

page, select the checkbox and click Next.
Otherwise, just click Next and skip to step 9.

Setup can not find a connected device. Check connection between pour computer
and the printer

If pou want to install Tupe 104 praperly you have to connect Type 104
before installation. You may connect the device using the printer cable

as the figure shows, then turh on the power of Type 104,
Click [Mext>].

8 If the test page prints out correctly, click Yes.

l
|
|
|
|
|
|
|
|
|
|
|
[
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
[
|
|
[
|
|
|
|
|
|

Please refer ta the following connection methad. :

1. Connect the device to your computer | If not C“Ck No to reprl nt |t

7 .

2. Tum on the power of the device | . I

) o _ ‘ 9 Click Finish.
3. It "Mew Hardware ‘Wizard" iz appeared, close it
|
|
|
|
[
|
|
[
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
[
|
|
|
|
|
|
|
|
|
|
|
|
|
|
l

4. Click [Nex]

Type 104

Setup Completed

<Back ‘ O ety Cangel ‘

o After connecting the printer, click Next.

o If you don't want to connect the printer at this time, click
Next, and No on the following screen. Then the installation
will start and a test page will not be printed at the end of the
installation.

e The installation window that appears in this User’s
Guide may differ depending on the printer and
interface in use.

Setup has finished instaling Type 104 on your computer.

6
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Installing Software for Network
Printing

When you connect your printer to a network, you must first
configure the TCP/IP settings for the printer. After you have
assigned and verified the TCP/IP settings, you are ready to
install the software on each computer on the network.

You can install the printer software using the typical or custom
method.

Typical Installation

This is recommended for most users. All components necessary
for printer operations will be installed.

1 Make sure that the printer is connected to your network
and powered on. For details about connecting to the
network, see the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation
window appears.
If the installation window does not appear, click Start and

then Run. Type X:\Setup.exe, replacing "X"” with the
letter which represents your drive and click OK.

#3 Type 104 3

Welcome to Type 104 Setup

This wizard will help install Type 104 components.
Itis strangly recommended that you quit all ‘Windows applications before
running Setup,

This printer will automatically substitute fonts shown on your screen with
similar looking fonts located in the printer.

To avoid substitution, go to the "Extras” tab of the printer driver and do
not check se Printer Fonts"

Wiew User's Guide ‘

Select a language from the list below.

English =l
V2.00.59.05

3 Click Next.
¢ If necessary, select a language from the drop-down list.

e View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

7

Select Typical installation for a network printer. Click
Next.

22 Type 104 X

Select Installation Type

Select type that pau want and click [Mext] buttan.

Typical installation for &

Jocal printer Install default components for & device that is directly connected to user's

computer

o~ Typical installation for 3

retwerk printer Install softwares for & device that is on network

" Custom installation You can select installation options. This option is recommended for
professional users.

<Back | Next> | Cancel |

The list of printers available on the network appears.
Select the printer you want to install from the list and then
click Next.

2 Type 104 X

Select Printer Port

Select a port that will be used for wour printer

& TCP/IP Port
" Shared Printer [LUNC)
" Add TCP/IP Port

Select a printer from the list below. I pou don't see your printer below, click [Update] to refresh the list.

Frinter Name IP/Port Hame
 MFPOD0OFOASEFOG 10.88.188.107

NOTE: If a firewall has been enabled an this PC. this may be preventing the installer fram

detecting the printer. Tempararily dizable the firewall on this PC before continuing with the
installation.

<Back | | Cancel |

o If you do not see your printer on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
printer to the network. To add the printer to the
network, enter the port name and the IP address for the
printer.

¢ To find a shared network printer (UNC Path), select
Shared Printer [UNC] and enter the shared name
manually or find a shared printer by clicking the Browse
button.

After the installation is finished, a window appears asking
you to print a test page. If you so desire, select the
checkbox and click Finish.

Installing Printer Software in Windows



Otherwise, just click Finish.

Type 104

Setup Completed

[ I'd ke to print a test page.

Setup has finished instaling Typpe 104 on your computer.

NOTE: After setup is complete, if your printer driver doesn’t
work properly, reinstall the printer driver. See “Reinstalling
Printer Software” on page 10.

Custom Installation

You can choose individual components to install and set a
specific IP address.

1 Make sure that the printer is connected to your network
and powered on. For details about connecting to the
network, see the supplied printer’s User’s Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation
window appears.
If the installation window does not appear, click Start and

then Run. Type X:\Setup.exe, replacing "X"” with the
letter which represents your drive and click OK.

1 Type 104

Welcome to Type 104 Setup

This wizard will help install Type 104 components
It iz strangly recammended that pou quit all Windaws applications befare
unning 5 etup,

This printer will automatically substitute fonts shown on your screen with
similar looking fonts located in the printer.

To avoid substitution, go to the "Extraz” tab of the printer driver and do
not check "Use Printer Fonts™,

View User's Guide ‘

Select a language from the list below.

English j
V2.00.59.05

3 Click Next.
o If necessary, select a language from the drop-down list.

8

¢ View User’s Guide: Allows you to view the User’s
Guide. If your computer doesn’t have Adobe Acrobat,
click on this option and it will automatically install Adobe
Acrobat Reader for you.

4 Select Custom installation. Click Next.

£ Type 104

Select Installation Type

Select type that pau want and click [Mext] buttan.

Typical installation for &

Jocal printer Install default components for & device that is directly connected to user's

computer

o~ Typical installation for a

network printer Install softwares for & device that is on network

i iCustom |nsla||at\ur§ You can select installation options. This option is recommended for
professional users.

<Back | Next> | Cancel |

5 The list of printers available on the network appears.
Select the printer you want to install from the list and then
click Next.

Select Printer Port

Select a port that will be wsed for your printer

* Local o TCPAP Port
" Shared Printer [UNC)
" Add TCP/IP Port

Select a printer from the list belaw, [f pou don't zee pour printer below, click [Update] to refresh the list.

Frinter Name IP/Fort Hame
 MFPODDOFOASEFOE 10.88.188.107
 MFP Tppe 104 USBOO01

NOTE: If a firewall has been enabled on this PC, this may be preventing the installer from Update
detecting the printer. Temporanly disable the firewall on this PC before continuing with the
installation

<Back | | Cancel |

¢ If you do not see your printer on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
printer to the network. To add the printer to the
network, enter the port name and the IP address for the
printer.

¢ To find a shared network printer (UNC Path), select
Shared Printer [UNC] and enter the shared name
manually or find a shared printer by clicking the Browse
button.

Installing Printer Software in Windows



NOTE: If you want to set a specific IP address on a specific
network printer, click the Set IP Address button. The Set IP

Address window appears. Do as follows:

#3 Type 104

Set IP Address

‘T'ou can set or change IP addiess for the network printer

Printer Mame ‘ IP Address ‘ MaL Address

¢~ MFPOO00FOA4FECO 10.88.188.31 O000FOA4FECO

¢ MFPO000F0ASEFOE 10.88.188.107 O000FOA5EF 06

Infarmation Update

Printer MAC Address |

IP Address : . .

__Congue_|
Subnet Mask : ,7
Default Gatersay . .

<Back, ‘ Cancel ‘

a. Select a printer to be set with a specific IP address from the

list.

b. Configure an IP address, subnet mask, and gateway for the
printer manually and click Configure to set the specific IP

address for the network printer.
c. Click Next.

7 After the installation is finished, a window appears asking
you to print a test page. If you so desire, select the
checkbox and click Finish.

Otherwise, just click Finish.

Type 104

Setup Completed

™ I'dlike to print a test page.

Setup has finished instaling Type 104 on your computer.

NOTE: After setup is complete, if your printer driver doesn’t
work properly, reinstall the printer driver. See “Reinstalling
Printer Software” on page 10.

6 Select the components to be installed. After selecting the
components, the following window appears. You can also

the network, set the printer as the default printer, and
change the port name of each printer. Click Next.

Set Printer

Change printer settings ta be installed

{2y Printer Driver Type 104 PCLE [IF_10.88.185.107 - @
Q Frinter Criver Type 104 PS IP_10.88.188.107 - .

be the default printer, click the button in Defaul field.

™ Setting up this printer on a server

<Back,

Frinter Name Fort Default Printer Shared Name

MName Field.If you want ather users on the netwark to access this printer, click the check box in

@ “T'ou can change the printer name by selecting the name and entering a new name in the Frinter
Share Mame field and enter a share name that uzers will easily identify. |f pou want this printer ta

‘ Cancel ‘

To install this software on a server, select the Setting up

this printer on a server checkbox.

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
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|
|
|
|
|
|
|
|
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Reinstalling Printer Software

You can reinstall the software if installation fails.

1

2
3
4

Start Windows.

From the Start menu select Programs or All Programs
— Type 104 — Maintenance.

Select Repair and click Next.

The list of printers available on the network appears.
Select the printer you want to install from the list and then
click Next.

43 Type 104 %]

Select Printer Port

Select a port that will be used for your printer

f* Local or TCPAP Port
" Shared Frinter [UNC]
" Add TCPAP Part

Select a printer from the list below. IF you don't see your printer below, click [Update] to refresh the list.

NoOTE: If your printer is not already connected to the

computer, the following window will appear.

2 Type 104 X

Connect Device

Setup can not find a connected device. Check connection between your computer
and the: printer

If you want to install Type 104 properly pou have to connect Type 104
befare installation. You may connect the device using the printer cable
as the figure shows, then tun on the power of Type 104,

Click [Mext>]

Pleaze refer ta the following connection methad,

1. Connect the device to your computer
2. Tumn an the pawer of the device
3. If "Mew Hardware Wizard" is appeared, close it

4. Click [Next]

o After connecting the printer, click Next.

Printer Mame

IP#Port Mame

£~ MFP Type 108 (ISB001

¢ If you don’t want to connect the printer at this time, click
Next, and No on the following screen. Then the installation
will start and a test page will not be printed at the end of the

NOTE: If 3 firewsall has been enabled on this PC, this may be preventing the installer from Update
detecting the printer. Tempararily disable the firewall on this PC before continuing with the:
installation,

[ i |

«Back ‘ Cancel ‘

 If you do not see your printer on the list, click Update to
refresh the list, or select Add TCP/IP Port to add your
printer to the network. To add the printer to the
network, enter the port name and the IP address for the
printer.

¢ To find a shared network printer (UNC Path), select
Shared Printer [UNC] and enter the shared name
manually or find a shared printer by clicking the Browse
button.

You will see a component list so that you can reinstall any
item individually.

10

installation.

e The reinstallation window that appears in this User’s
Guide may differ depending on the printer and
interface in use.

5 Select the components you want to reinstall and click
Next.
If you installed the printer software for local printing

and you select your printer driver name, the window
asking you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click
Next.

b. If the test page prints out correctly, click Yes.
If it doesn't, click No to reprint it.
6 When the reinstallation is done, click Finish.

Installing Printer Software in Windows



Removing Printer Software

1 start Windows.

2 From the Start menu select Programs or All Programs
— Type 104 — Maintenance.

3 Select Remove and click Next.
You will see a component list so that you can remove any
item individually.

4  Select the components you want to remove and then click
Next.

5 When your computer asks you to confirm your selection,
click Yes.

The selected driver and all of its components are removed
from your computer.

6 After the software is removed, click Finish.

11
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2 Basic Printing

This chapter explains the printing options and common printing

tasks in Windows.

This chapter includes:
e Printing a Document
e Printing to a file (PRN)
e Printer Settings
- Layout Tab
- Paper Tab
- Graphics Tab
- Extras Tab
- About Tab
- Printer Tab

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is
displayed. It may look slightly different depending on your
application.

The basic print settings are selected within the Print
window. These settings include the number of copies and

print range.

General

Select Printer
§ \ = s
= =

Printer Driver  SmarThru PC

Type 104 PS Fax

Add Printer 1500

v

= 1 Print ta file

Make sure that your (Frapime)
printer is selected. =

[ol]

Mumber of copies: |1

~
¥

) Pages:

1-B5535

Enter either a single page number or a single

Ll

- Using a Favorite Setting
- Using Help

Printing a Document

NOTES:

¢ Your printer driver Properties window that appears in this
User’s Guide may differ depending on the printer in use.
However the composition of the printer properties window is
similar.

e Check the Operating System(s) that are compatible
with your printer. Please refer to the OS Compatibility
section of Printer Specifications in your Printer User’s
Guide.

o If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

The following procedure describes the general steps required
for printing from various Windows applications. The exact steps
for printing a document may vary depending on the application
program you are using. Refer to the User’s Guide of your
software application for the exact printing procedure.
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page range. For example, 5-12

3 Select your printer driver from the Name drop-down
list.

To take advantage of the printer features provided by your
printer driver, click Properties or Preferences in the
application’s Print window. For details, see “Printer
Settings” on page 13.

If you see Setup, Printer, or Options in your Print
window, click it instead. Then click Properties on the next
screen.

Click OK to close the printer properties window.

4 To start the print job, click OK or Print in the Print
window.




Printing to a file (PRN)

You will sometimes need to save the print data as a file for your
purpose.

To create a file:
1 Check the Print to file box at the Print window.

& print E]gl
General
Select Printer
ne \ = ~
e @ S

Add Printer [
T

{8 Printer Driver  SmarThru PC
{8k Type 104 PS Fax

v
[ Priett ta file E’_I sferences

Status: Ready
Leacation:

Comment Find Printer.
Page Rangs

@al Mumber of copies: |1 =

() Pages: 165535 ! !
Enter either a single page number or a single @
page range. For example, 512

2 Select the folder and assign a name of the file and then
click OK.

Basic Printing
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Printer Settings

You can use the printer properties window, which allows you to
access all of the printer options you need when using your
printer. When the printer properties are displayed, you can
review and change the settings needed for your print job.

Your printer properties window may differ, depending on your
operating system. This Software User’s Guide shows the
Properties window for Windows 98.

Your printer driver Properties window that appears in this
User’'s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you
can view additional Windows-based tabs (refer to your
Windows User’s Guide) and the Printer tab (see “Printer Tab” on
page 17).

NOTES:

e Most Windows applications will override settings you specify
in the printer driver. Change all print settings available in the
software application first, and change any remaining settings
using the printer driver.

¢ The settings you change remain in effect only while you are
using the current program. To make your changes
permanent, make them in the Printers folder.

¢ The following procedure is for Windows XP. For other
Windows OS, refer to the corresponding Windows User's
Guide or online help.

1. Click the Windows Start button.

2. Select Printers and Faxes.

3. Select your printer driver icon.

4. Right-click on the printer driver icon and select
Printing Preferences.

5. Change the settings on each tab, click OK.




Layout Tab

The Layout tab provides options to adjust how the document
appears on the printed page. The Layout Options includes
Multiple Pages per Side and Poster Printing. See "Printing
a Document” on page 12 for more information on accessing
printer properties.

2 Printing Preferences E]g]
Lapaut | Paper | Graphic | Extras | About
Paper Orientation
T @ Farirait
() Landscape
Rotate 1} + | Degees
Layout Optians
Lapout Type | Multiple Pages per Side ~
Pages per Side 1 v
Letter
B50%11.00in
Double-sided Frinting Omm @ inch
Copies: 1
) () Nane L= !
() Lang Edge Resolution: 600 dpi
O Short Edge Favorites
Printer Default v
oK ] [ Cancel ] [ Help

Paper Orientation

Paper Orientation allows you to select the direction in which

information is printed on a page.

¢ Portrait prints across the width of the page, letter style.

¢ Landscape prints across the length of the page, spreadsheet
style.

¢ Rotate allows you to rotate the page the selected degrees.

t

A Landscape

4

4 g
=

2 [

Layout Options

Layout Options allows you to select advanced printing options.

You can choose Multiple Pages per Side and Poster Printing.

¢ For details, see “Printing Multiple Pages on One Sheet of Paper
(N-Up Printing)” on page 18.

¢ For details, see “Printing Posters” on page 19.

o For details, see “Printing Booklets” on page 19.

Double-sided Printing

Double-sided Printing allows you to print on both sides of
paper.

¢ For details, see “Printing on Both Sides of Paper” on page 20.
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Paper Tab

Use the following options to set the basic paper handling
specifications when you access the printer properties. See
“Printing a Document” on page 12 for more information on
accessing printer properties.

Click the Paper tab to access various paper properties.

-3 Printing Preferences @@
Layout | Paper | Graphic | Extras | About
Cepies [1-339) :
Paper Options
Size A4 v
Source Auta Selection v
Type Pririter Default v
First Page Nane ~
Ad
8.26 % 11.69in
Sialing Printing Omm ©inch
O N Copies: 1
i h
ning Type e Rezolution: 600 dpi
Favorites
Unitled -
[ [n]:9 I [ Cancel l [ Help
Copies

Copies allows you to choose the number of copies to be printed.
You can select 1 to 999 copies.

Size

Size allows you to set the size of paper you loaded in the tray.

If the required size is not listed in the Size box, click Custom.
When the Custom Paper Setting window appears, set the paper
size and click OK. The setting appears in the list so that you can
select it.

Source

Make sure that Source is set to the corresponding paper tray.
Use Manual Feed when printing on special materials like
envelopes and transparencies. You have to load one sheet at a
time into the Manual Tray or Multi-Purpose Tray.

If the paper source is set to Auto Select, the printer
automatically picks up print material in the following tray order:
Manual Tray or Multi-Purpose Tray, Trayl, Optional Tray2

Type

Set Type to correspond to the paper loaded in the tray from
which you want to print. This will let you get the best quality
printout. If not, print quality may not be acheived as you want.
Cotton: 20 Ib to 24 Ib (75~90 g/m2) cotton paper such as Gilbert
25 % and Gilbert 100 %.

Plain Paper: Normal plain paper. Select this type if your printer is
monochrome and printing on the 16 Ib (60 g/m2) cotton paper.
Recycled Paper: 20 Ib to 24 Ib (75~90 g/m2) recycled paper.
Color Paper: 20 Ib to 24 Ib (75~90 g/m2) color-backgrounded
paper.



First Page

This property allows you to print the first page using a different
paper type from the rest of the document. You can select the
paper source for the first page.

For example, load thick stock for the first page into the Multi-
purpose Tray, and plain paper into Trayl. Then, select Tray1 in
the Source option and Multi-Purpose Tray in the First Page
option.

Scaling Printing

Scaling Printing allows you to automatically or manually scale

your print job on a page. You can choose from None, Reduce/

Enlarge, and Fit to Page.

¢ For details, see “Printing a Reduced or Enlarged Document” on
page 20.

o For details, see “Fitting Your Document to a Selected Paper
Size” on page 20.

Basic Printing
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Graphics Tab

Use the following Graphic options to adjust the print quality for
your specific printing needs. See “Printing a Document” on
page 12 for more information on accessing printer properties.

Click the Graphic tab to display the properties shown below.

-3 Printing Preferences @@

Layout | Paper | Graphic | Extras | About

Resolution

() 1200 dpi [Best)
s @EG ol fHomalk

Image Mode

() Printer Setting

) Mormal

(O Text Enhancement

a>

Toner Save Mode Ad
5 (3) Printer Getting 8.26%11.69in
oo

o8 - Oon O mm (&) inch
O o Copies: 1
Rezolution: 600 dpi
Favorites

Unitled -

Advanced Options I [ Save ]

[ [n]:9 I[ Cancel H Help

Resolution

The higher the setting, the sharper the clarity of printed
characters and graphics. The higher setting also may increase the
time it takes to print a document.

Image Mode

The available options are Normal (1, 2, 3) and Text Enhance.

¢ Printer Setting: If you select this option, this feature is
determined by the setting you've made on the control panel of
the printer.

¢ Normal (1, 2, 3): This setting is for normal documents.

¢ Text Enhance: Image Mode allows the user to enhance
printouts.

Toner Save Mode

Selecting this option extends the life of your toner cartridge and

reduces your cost per page without a significant reduction in print

quality.

¢ Printer Setting: If you select this option, this feature is
determined by the setting you've made on the control panel of
the printer.

¢ On: Select this option to allow the printer to use less toner on
each page.

¢ Off: If you don't need to save toner when printing a document,
select this option.



Advanced Options

You can set advanced settings by clicking the Advanced

Options button.

¢ TrueType Options: This option determines what the driver
tells the printer about how to image the text in your document.

Select the appropriate setting according to the status of your

document.

- Download as Outline: When this option is selected, the
driver will download any TrueType fonts that are used in your
document not already stored (resident) on your printer. If,
after printing a document, you find that the fonts did not print
correctly, choose Download as bit image and resubmit your
print job. The Download as bit image setting is often useful
when printing Adobe. This feature is available only
when you use the PCL printer driver.

- Download as Bitmap: When this option is selected, the
driver will download the font data as bitmap images.
Documents with complicated fonts, such as Korean or
Chinese, or various other fonts, will print faster in this setting.

- Print as Graphics: When this option is selected, the driver
will download any fonts as graphics. When printing documents
with high graphic content and relatively few TrueType fonts,
printing performance (speed) may be enhanced in this
setting.

¢ Print All Text To Black: When the Print All Text To Black
option is checked, all text in your document prints solid black,
regardless of the color it appears on the screen.

Basic Printing
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Extras Tab

You can select output options for your document. See “Printing
a Document” on page 12 for more information about accessing
the printer properties.

Click the Extras tab to access the following feature:

-3 Printing Preferences @@
Layout | Paper | Graphic | Exfras | About
W atermark.
Qverlay
[Ma Owerlay) £
Output Options
Print Subset Mormal [1,2.3) v
Use Printer Fonts Ad
8.26 % 11.69in
O mm (&) inch
Copies: 1
Rezolution: 600 dpi
Favorites
Unitled -
[ [n]:9 I [ Cancel l [ Help
Watermark

You can create a background text image to be printed on each
page of your document. For details, see “Using Watermarks” on
page 21.

Overlay
Overlays are often used to take the place of preprinted forms and
letterhead paper. For details, see “Using Overlays” on page 22.

Output Options

¢ Print Subset: You can set the sequence in which the pages

print. Select the print order from the drop-down list.

- Normal (1, 2, 3): Your printer prints all pages from the first
page to the last page.

- Reverse All Pages(3,2,1): Your printer prints all pages from
the last page to the first page.

- Print Odd Pages: Your printer prints only the odd numbered
pages of the document.

- Print Even Pages: Your printer prints only the even
numbered pages of the document.

Use Printer Fonts: When Use Printer Fonts is checked, the

printer uses the fonts that are stored in its memory (resident

fonts) to print your document, rather than downloading the

fonts used in your document. Because downloading fonts takes

time, selecting this option can speed up your printing time.

When using Printer fonts, the printer will try to match the fonts

used in your document to those stored in its memory. If,

however, you use fonts in your document that are very different

from those resident in the printer, your printed output will

appear very different from what it looks like on the screen.

This feature is available only when you use the PCL

printer driver.



About Tab

Use the About tab to display the copyright notice and the
version number of the driver. See “Printing a Document” on
page 12 for more information about accessing printer
properties.

Printer Tab

If you access printer properties through the Printers folder,
you can view the Printer tab. You can set the printer
configuration.

The following procedure is for Windows XP. For other Windows
0S, refer to the corresponding Windows User's Guide or online
help.

Click the Windows Start menu.

Select Printers and Faxes.

Select your printer driver icon.

Right-click on the printer driver icon and select
Properties.

Click the Printer tab and set the options.

Ul A WNE

Using a Favorite Setting

The Favorites option, which is visible on each properties tab,
allows you to save the current properties settings for future
use.

To save a Favorites item:
1 Change the settings as needed on each tab.
2 Enter a name for the item in the Favorites input box.

Sealing Printing O mm @ inch
. Copies: 1
Finina Tiee Hen = Fesalytinnesitds
Favarites
Untitled "
oK H Cancel ” Help ]
3 Click Save.
When you save Favorites, all current driver settings are
saved.

To use a saved setting, select the item from the Favorites drop
down list. The printer is now set to print according to the
Favorites setting you selected.

To delete a Favorites item, select it from the list and click
Delete.

You can also restore the printer driver’s default settings by
selecting Printer Default from the list.
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Using Help

Your printer has a help screen that can be activated by clicking
the Help button in the printer properties window. These help
screens give detailed information about the printer features
provided by the printer driver.

You can also click #] from the upper right corner of the window,
and then click on any setting.



Advanced Printing

This chapter explains printing options and advanced printing
tasks.

NOTE:

¢ Your printer driver Properties window that appears in this
User’s Guide may differ depending on the printer in use.
However the composition of the printer properties window is
similar.

o If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

This chapter includes:

e Printing Multiple Pages on One Sheet of Paper (N-Up
Printing)

e Printing Posters

e Printing Booklets

e Printing on Both Sides of Paper

e Printing a Reduced or Enlarged Document

e Fitting Your Document to a Selected Paper Size
e Using Watermarks

e Using Overlays
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Printing Multiple Pages on One
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet
of paper. To print more than one page per sheet, the pages will
be reduced in size and arranged in the order you specify. You
can print up to 16 pages on one sheet.

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 From the Layout tab, choose Multiple Pages per Side in
the Layout Type drop-down list.

3 Select the number of pages you want to print per sheet
(1, 2,4, 6,9, or 16) in the Pages per Side drop-down
list.

4 Select the page order from the Page Order drop-down
list, if necessary.

Check Print Page Border to print a border around each
page on the sheet.

5 Click the Paper tab, select the paper source, size, and
type.

6 Click OK and print the document.
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Printing Posters

This feature allows you to print a single-page document onto 4,
9, or 16 sheets of paper, for the purpose of pasting the sheets
together to form one poster-size document.

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

Click the Layout tab, select Poster Printing in the
Layout Type drop-down list.

Configure the poster option:

You can select the page layout from Poster<2x2>,
Poster<3x3>, Poster<4x4> or Custom. If you select
Poster<2x2>, the output will be automatically stretched
to cover 4 physical pages. If the option is set to Custom,
you can enlarge the original from 150% to 400%.
Depending on the level of the enlargement, the page
layout is automatically adjusted to Poster<2x2>,
Poster<3x3>, Poster<4x4>.
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Specify an overlap in millimeters or inches to make it
easier to pasting the sheets together.
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4  Click the Paper tab, select the paper source, size, and
type.

5 Click OK and print the document. You can complete the
poster by pasting the sheets together.
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Printing Booklets

~ /%
TS %Qg
S = —
ﬁ§ § =
b LSy

This printer feature allows you to print your document on both
sides of the paper and arranges the pages so that the paper can
be folded in half after printing to produce a booklet.

1 To change the print settings from your software
application, access the printer properties. See “Printing a
Document” on page 12.

2 From the Layout tab, choose Booklet Printing from the
Layout Type drop-down list.

NOTE: The Booklet Printing option is not available for all
the paper size. In order to find out the available paper size for
this feature, select the paper size in the Size option on the
Paper tab, then check if the Booklet Printing in a Layout
Type drop-down list on the Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and
type.
4 Click OK and print the document.

5 After printing, fold and staple the pages.



Printing on Both Sides of Paper

You can print on both sides of a sheet of paper. Before printing,
decide how you want your document oriented.

The options are:
¢ None

¢ Long Edge, which is the conventional layout used in
book binding.

¢ Short Edge, which is the type often used with calendars.
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NOTES:

¢ Do not print on both sides of labels, transparencies,
envelopes, or thick paper. Paper jamming and damage to the
printer may result.

¢ To use double-sided printing, you can use only the following
paper sizes: A4, Letter, Legal, and Folio, with a weight of

20~24 Ibs (75~90g/m2)

1 To change the print settings from your software
application, access printer properties. “Printing a
Document” on page 12.

From the Layout tab, select the paper orientation.

From the Double-sided Printing section, select the
binding option you want.

Click the Paper tab and select the paper source, size, and
type.

Click OK and print the document.
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Printing a Reduced or Enlarged
Document

You can change the size of a page’s content to appear larger or
smaller on the printed page.

1 To change the print settings from your software

application, access printer properties. See “Printing a
Document” on page 12.

2 From the Paper tab, select Reduce/Enlarge in the
Printing Type drop-down list.
Enter the scaling rate in the Percentage input box.

w

You can also click the w or 4 button.
Select the paper source, size, and type in Paper Options.
Click OK and print the document.
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Fitting Your Document to a
Selected Paper Size

This printer feature allows you to scale your print job to any
selected paper size regardless of the digital document size. This
can be useful when you want to check fine details on a small
document.

1 To change the print settings from your software

application, access printer properties. See “Printing a
Document” on page 12.

From the Paper tab, select Fit to Page in the Printing
Type drop-down list.

Select the correct size from the Output Size drop-down
list.

Select the paper source, size, and type in Paper Options.
Click OK and print the document.
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Using Watermarks

The Watermark option allows you to print text over an existing
document. For example, you may want to have large gray
letters reading "DRAFT"” or "CONFIDENTIAL" printed diagonally
across the first page or all pages of a document.

There are several predefined watermarks that come with the
printer, and they can be modified, or you can add new ones to
the list.

Using an Existing Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Extras tab, and select the desired watermark
from the Watermark drop-down list. You will see the
selected watermark in the preview image.

3 Click OK and start printing.

NOTE: The preview image shows how the page will look when
it is printed.

Creating a Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Extras tab, and click the Edit button in the
Watermark section. The Edit Watermark window
appears.

3 Enter a text message in the Watermark Message box.
You can enter up to 40 characters. The message displays
in the preview window.

When the First Page Only box is checked, the watermark
prints on the first page only.

4 Select watermark options.

You can select the font name, style, size, or grayscale level

from the Font Attributes section and set the angle of the
watermark from the Message Angle section.

5 Click Add to add a new watermark to the list.

6 When you have finished editing, click OK and start
printing.

To stop printing the watermark, select <No Watermark> from

the Watermark drop-down list.

Advanced Printing
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Editing a Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 Click the Extras tab and click the Edit button in the
Watermark section. The Edit Watermark window
appears.

3 Select the watermark you want to edit from the Current
Watermarks list and change the watermark message and
options.

4 Click Update to save the changes.

5 Click OK until you exit the Print window.

Deleting a Watermark

1 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

2 From the Extras tab, click the Edit button in the
Watermark section. The Edit Watermark window
appears.

3 Select the watermark you want to delete from the Current
Watermarks list and click Delete.

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?

An overlay is text and/or images stored in the computer hard
disk drive (HDD) as a special file format that can be printed on
any document. Overlays are often used to take the place of
preprinted forms and letterhead paper. Rather than using
preprinted letterhead, you can create an overlay containing the
exact same information that is currently on your letterhead. To
print a letter with your company’s letterhead, you do not need
to load preprinted letterhead paper in the printer. You need only
tell the printer to print the letterhead overlay on your
document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay
containing your logo or image.
1 Createor open a document containing text or an image for

use in a new page overlay. Position the items exactly as
you wish them to appear when printed as an overlay.

To save the document as an overlay, access printer
properties. See “Printing a Document” on page 12.

Click the Extras tab, and click Edit button in the Overlay
section.

In the Edit Overlay window, click Create Overlay.

In the Create Overlay window, type a name of up to eight

characters in the File name box. Select the destination
path, if necessary. (The default is C:\Formover).

Click Save. The name appears on the Overlay List box.
Click OK or Yes to finish creating.

The file is not printed. Instead it is stored on your
computer hard disk drive.
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NOTE: The overlay document size must be the same as the
documents you print with the overlay. Do not create an overlay
with a watermark.
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Using a Page Overlay

After an overlay has been created, it is ready to be printed with
your document. To print an overlay with a document:

1 Create or open the document you want to print.

2 To change the print settings from your software
application, access printer properties. See “Printing a
Document” on page 12.

3 Click the Extras tab.

4 Select the desired overlay from the Overlay drop-down
list box.
5 If the overlay file you want does not appear in the

Overlay list, click Edit button and Load Overlay, and
select the overlay file.

If you have stored the overlay file you want to use in an
external source, you can also load the file when you access
the Load Overlay window.

After you select the file, click Open. The file appears in the
Overlay List box and is available for printing. Select the
overlay from the Overlay List box.

6 If necessary, click Confirm Page Overlay When
Printing. If this box is checked, a message window
appears each time you submit a document for printing,
asking you to confirm your wish to print an overlay on your
document.

If this box is not checked and an overlay has been
selected, the overlay automatically prints with your
document.

7 Click OK or Yes until printing begins.

The selected overlay downloads with your print job and
prints on your document.

NOTE: The resolution of the overlay document must be the
same as that of the document you will print with the overlay.

Deleting a Page Overlay
You can delete page overlays that you no longer use.

In the printer properties window, click the Extras tab.
Click the Edit button in the Overlay section.

Select the overlay you want to delete from the Overlay
List box.

Click Delete Overlay.
When a confirming message window appears, click Yes.
Click OK until you exit the Print window.
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Using Windows
PostScript Driver

If you want to use the PostScript driver provided with your
system CD-ROM to print a document.

PPDs, in combination with the PostScript driver, access printer
features and allow the computer to communicate with the
printer. An installation program for the PPDs is provided on the
supplied software CD-ROM.

This chapter includes:

Printer Settings

You can use the printer properties window, which allows you to
access all of the printer options you need when using your
printer. When the printer properties are displayed, you can
review and change the settings needed for your print job.
Your printer properties window may differ, depending on your
operating system. This Software User’s Guide shows the
Properties window for Windows XP.

Your printer driver Properties window that appears in this
User’s Guide may differ depending on the printer in use.

NOTES:

¢ Most Windows applications will override settings you specify
in the printer driver. Change all print settings available in the
software application first, and change any remaining settings
using the printer driver.

e The settings you change remain in effect only while you are
using the current program. To make your changes
permanent, make them in the Printers folder.

¢ The following procedure is for Windows XP. For other
Windows OS, refer to the corresponding Windows User's
Guide or online help.

1. Click the Windows Start button.

2. Select Printers and Faxes.

3. Select your printer driver icon.

4. Right-click on the printer driver icon and select
Printing Preferences.

5. Change the settings on each tab, click OK.
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Advanced

You can use advanced settings by clicking the Advanced
button.

Printer, Driver Type 104 PS Advanced Options @§|

gég Printer Driver Type 104 PS Advanced Document Settings
% PaperOutput
@ Graphic

ﬁh Dacument Options

[ Ok ][ Cancel ]

¢ Paper/Output this option allows you to select the size of the
paper loaded in the tray.

¢ Graphic this option allows you to adjust the print quality for
your specific printing needs.

¢ Document Options this options allow you to set the PostScript
options or printer features.

Using Help

You can click ] from the upper right corner of the window, and
then click on any setting.

Using Windows PostScript Driver



Sharing the Printer
Locally

You can connect the printer directly to a selected computer,
which is called “host computer,” on the network.

The following procedure is for Windows XP. For other Windows
OS, refer to the corresponding Windows User's Guide or online

help.

NOTES:
« Check the Operating System(s) that are compatible with

your printer. Please refer to the OS Compatibility section of

Printer Specifications in your Printer User’s Guide.

« If you need to know the exact name of your printer, you can

check the supplied CD-ROM.

Sharing the Printer Locally
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Setting Up a Host Computer

Start Windows.

From the Start menu select Printers and Faxes.
Double-click your printer driver icon.

From the Printer menu, select Sharing.

Check the Share this printer box.

Fill in the Shared Name field, and then click OK.
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Setting Up a Client Computer

-

Right-click the Windows Start button and select Explorer.

2 Select My Network Places and then right-click Search
for Computers.

3 Fillin the IP address of host computer in Computer name

field, and click Search. (In case host computer requires

User name and Password, fill in User ID and password

of host computer account.)

Double-click Printers and Faxes.
Right-click printer driver icon, select Connect.
6 Click Yes, if the installation confirm message appears.
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Using Utility Applications

If an error occurs while printing, the Status Monitor window
appears, showing the error.

NOTES:
¢ To use the this program, you need:

- Windows 98 or higher (Windows NT 4.0 can be used only
for network-supported printers.) To check for Operating
System(s) that are compatible with your printer, refer to
Printer Specifications in your Printer User’s Guide.

- Internet Explorer version 5.0 or higher for flash animation
in HTML Help.

¢ If you need to know the exact name of your printer, you can
check the supplied CD-ROM.

Using Printer Settings Utility

Using the Printer Settings Utility, you can configure and check

print settings.

1 From the Start menu select Programs or All Programs
— Type 104 — Printer Settings Utility.

2 Change the settings.

3 To send the changes to the printer, click the Apply button.

Using Onscreen Help File
For more information about Printer Settings Utility, click @ .

Opening the Troubleshooting
Guide

Double-click the Status Monitor icon on the Windows task bar.

Double click this icon.

Or, from the Start menu, select Programs or All Programs
— Type 104 — Troubleshooting Guide.

Using Utility Applications

25

Changing the Status Monitor
Program Settings

Select the Status Monitor icon on the Windows task bar and
right-click on the Status Monitor icon. Select Options.

The following window opens.

Status Monitar Alert Option

[~ Displaywhen job is finished for network printer

W Displaywhen errar oceurs during printing

Schedule an automatic status checking every
3 =1 {1-10 gec,
= { )

e cancel |

e Display when job is finished for network printer shows
the Status Monitor balloon when your job is complete.

e Display when error occurs during printing shows the
Status Monitor balloon when an error occurs during
printing.

¢ Schedule an automatic status checking every allows
the computer update the printer status regularly. Setting
the value close to 1 second causes the computer to check
the printer status more frequently, thereby allowing a
faster response to any printer error.



Scanning

Scanning with your machine lets you turn pictures and text into
digital files on your computer. Then you can fax or e-mail the
files, display them on your web site or use them to create
projects that you can print using SmarThru software or the WIA
driver.

This chapter includes:

e Scanning Using SmarThru

e Scanning Process with TWAIN-enabled Software
e Scanning Using the WIA Driver

NOTES:

e Check the Operating System(s) that are compatible
with your printer. Please refer to the OS Compatibility
section of Printer Specifications in your Printer User’s
Guide.

® You can check your printer name in the supplied CD-
ROM.

e The maximum resolution that can be achieved
depends upon various factors, including computer
speed, available disk space, memory, the size of the
image being scanned, and bit depth settings. Thus,
depending on your system and what you are scanning,
you may not be able to scan at certain resolutions,
especially using enhanced dpi.

Scanning
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Scanning Using SmarThru

SmarThru is the accompanying software for your machine. With
SmarThru, scanning is the proverbial piece of cake.

NOTE: You can use SmarThru 4 in Windows 98 or higher.

Uninstalling SmarThru

NOTE: Before beginning uninstallation, ensure that all
applications are closed on your computer.

1 From the Start menu, select Programs.

2 Select SmarThru 4, and then select Uninstall SmarThru
4,

3 When your computer asks you to confirm, click OK.

4  Click Finish.

You may be prompted to restart your computer. In this
case you must shut the computer down and then restart it
before the changes will be saved.



Using SmarThru
Follow these steps to start scanning using the SmarThru:

1

2

Make sure that your machine and computer are turned on
and properly connected to each other.

Place your photograph or page on the document glass
or ADF.

Once you have installed SmarThru, you will see the
SmarThru 4 icon on your desktop. Double-click the
SmarThru 4 icon.

e Bin DAEMON Tools

Type 104

@ ﬂ % - Make sure that your
= == printer is selected.

Sct;n To Image Copy Print

eScan To

Allows you to scan an image and save it to an application
or folder, email it, or publish it on a web site.
eImage

Allows you to edit an image you have saved as a graphic
file and send it to a selected application or folder, email it,
or publish it on a web site.

eCopy

Allows you to produce professional quality copies. You can
make black and white or color copies of an image if your
machine supports it, and customize the copy settings.

oPrint

Allows you to print images you have saved. You can print
images in black and white or color mode if your machine
supports it.

eFax

Allows you to fax images or files you have saved on your
computer. This is available when your machine supports
the fax feature.
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4 Click Scan To. The Scan To menu bar appears on the
SmarThru 4 window.

o

| Type 104

Scan To Imaae Copv Print Fax
: . Scan To
[ Application E-mail Folder OCR Wk Settings
menu bar
Prascan |@ Scan D Application

Scan Settings

Image Type: True Color (24 bit) -

|
|

— Adjust the scan

Flesolutior: 300 dpi a settings
Scan Area: m
Source: W

Scan Multiple

Properties: 2550 & 3300 pixels - 24.08 MB

Click to start
e ) Lo @ ems=mn 1 Scanning.

Scan To lets you use the following services:
eApplication

Scanning an image and placing it in an image editor
application, such as Paint or Adobe Photoshop.

oE-mail
Scanning an image and emailing it. Allows you to scan an
image, preview it, and email it.

NOTE: To send an image by e-mail, you must have a mail
client program, like Outlook Express, which has been set up
with your e-mail account.

eFolder

Scanning an image and saving it to a folder. Allows you to
scan an image, preview it, and save it to the folder of your
choice.

eOCR

Scanning an image and performing text recognition.
Allows you to scan an image, preview it, and send it to the
OCR program for text recognition.

- Recommended Scan Option for OCR

- Resolution: 200 or 300 dpi

- Image Type: Grayscale or Black & White

eWeb

Scanning an image, previewing it, and publishing it on a
web site, using the specified file format for the image you
want to publish.



eSettings

Customizing settings of Scan To basic functions. Allows
you to customize settings for Application, E-mail, OCR,
and Web functions.

5 Click the service icon according to your job.

6 SmarThru 4 opens for the selected service. Adjust the
scan settings.

7 To start scanning, click Scan.

NOTE: If you want to cancel the scan job, click Cancel.

Using Onscreen Help File

For more information about SmarThru, click @ at the top right
corner of the window. The SmarThru Help window opens and
allows you to view onscreen help supplied on the SmarThru
program.

Scanning Process with TWAIN-
enabled Software

If you want to scan documents using other software, you will
need to use TWAIN-compliant software, such as Adobe
PhotoDeluxe or Adobe Photoshop. The first time you scan with
your machine, select it as your TWAIN source in the application
you use.

The basic scanning process involves a number of steps:

1 Make sure that your machine and computer are turned on
and properly connected to each other.

2 Load the document(s) face up into the ADF.
OR

Place a single document face down on the document
glass.

3 Open an application, such as PhotoDeluxe or Photoshop.
4 Open the TWAIN window and set the scan options.
5 Scan and save your scanned image.

NOTE: You need to follow the program'’s instructions for
acquiring an image. Please refer to the user’s guide of the
application.

Scanning
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Scanning Using the WIA Driver

Your machine also supports the Windows Image Acquisition
(WIA) driver for scanning images. WIA is one of the standard
components provided by Microsoft® Windows® XP and works
with digital cameras and scanners. Unlike the TWAIN driver, the
WIA driver allows you to scan and easily manipulate images
without using additional software.

NOTE: The WIA driver works only on Windows XP with USB
port.

1 Load the document(s) face up into the ADF.
OR
Place a single document face down on the document
glass.

2 From the Start menu on your desktop window, select

Settings, Control Panel, and then Scanners and
Cameras.

Double click your scanner driver icon. The Scanner and
Camera Wizard launches.

Choose your scanning preferences and click Preview to
see how your preferences affect the picture.

Click Next.

Enter a picture name, and select a file format and
destination to save the picture.

Follow the on-screen instructions to edit the picture after it
is copied to your computer.
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NOTE: If you want to cancel the scan job, press the Cancel
button on the Scanner and Camera Wizard.




8 Using Your Printer with

a Macintosh

Your machine supports Macintosh systems with a built-in USB
interface or a 10/100 Base-TX network interface card. When
you print a file from a Macintosh computer, you can use the
PostScript driver by installing the PPD file.

This chapter includes:

e Installing Software for Macintosh
e Setting Up the Printer

e Printing

e Scanning
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Installing Software for
Macintosh

The PostScript driver CD-ROM that came with your machine
provides you with the PPD file to use the PS driver, Apple
LaserWriter driver, for printing on a Macintosh computer.

Also, it provides you with the Twain driver for scanning on a
Macintosh computer.

Printer driver
Installing the printer driver

Connect your machine to the computer using the USB
cable or the Ethernet cable.
Turn on your computer and the machine.

Insert the PostScript driver CD-ROM which came with your
machine into the CD-ROM drive.

Double-click the Type 104 on your Macintosh desktop.
Double-click the MAC_Installer folder.

Double-click the Type 104 Installer OSX icon.

Click Continue.

Click Install.

After the installation is finished, click Quit.
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Scan driver

Install the Scan driver
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Make sure that you connect your printer to the computer.
Turn on your computer and printer.

Insert the CD-ROM which came with your printer into the
CD-ROM drive.

Double-click CD-ROM icon that appears on your
Macintosh desktop.

Double-click the MAC_Installer folder.

Double-click the MAC_Twain folder.

Double-click the ScanThru Installer icon.

Enter the password and click OK.

Click Continue.

Click Install.

10 After the installation is finished, click Quit.

Uninstalling the Scan driver

1
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Insert the CD-ROM which came with your printer into the
CD-ROM drive.

Double-click CD-ROM icon that appears on your
Macintosh desktop.

Double-click the MAC_Installer folder.

Double-click the MAC_Twain folder.

Double-click the ScanThru Installer icon.

Enter the password and click OK.

Click Continue.

Select Uninstall from the Installation Type and then Click
Uninstall.
When the uninstallation is done, click Quit.
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Setting Up the Printer

Set up for your printer will be different depending on which
cable you use to connect the printer to your computer—the
network cable or the USB cable.

For a Network-connected Macintosh

1 Follow the instructions on “Installing Software for
Macintosh” on page 29 to install the PPD file on your
computer.

2 Open Print Center or Printer Setup Utility from the
Utilities folder.

3 Click Add on the Printer List.

4 Select the AppleTalk tab.
The name of your machine appears on the list. Select

MFPO00O0xxxxxxxxx from the printer box, where the
XXXXXXXXxX varies depending on your machine.

5 Click Add.
6 If Auto Select does not work properly, select Printer
Model and your printer name in Model Name.

Your machine appears on the Printer List and is set as the
default printer.

For a USB-connected Macintosh

1 Follow the instructions on “Installing Software for
Macintosh” on page 29 to install the PPD file on your
computer.

Open Print Center or Printer Setup Utility from the
Utilities folder.

Click Add on the Printer List.

Select the USB tab.

Select your printer name and click Add.

If Auto Select does not work properly, select Printer
Model and your printer name in Model Name.

Your machine appears on the Printer List and is set as the
default printer.
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Printing

NOTES:

¢ The Macintosh printer’s properties window that appears in
this User’s Guide may differ depending on the printer in use.
However the composition of the printer properties window is
similar.

e You can check your printer name in the supplied CD-
ROM.

Printing a Document

When you print with a Macintosh, you need to check the printer
software setting in each application you use. Follow these steps
to print from a Macintosh.

1 Open a Macintosh application and select the file you want
to print.

2 Open the File menu and click Page Setup (Document
Setup in some applications).

3 Choose your paper size, orientation, scaling, and other
options and click OK.

Settings: | Page Attributes B

Format for: | } :J

P e T —— Make sure that your
aper Size: | USLetter  printer s selected.
21.59em .~ _

Orientation: m Il I_E

Scale: |100 %

@ (" Cancel ) ( oK )

A Mac 0S 10.3

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which
pages you want to print.

6 Click Print when you finish setting the options.
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Changing Printer Settings

You can use advanced printing features when using your
printer.

From your Macintosh application, select Print from the File
menu. The printer name which appears in the printer properties
window may differ depending on the printer in use. Except for
the name, the composition of the printer properties window is
similar.

Layout Setting

The Layout tab provides options to adjust how the document
appears on the printed page. You can print multiple pages on
one sheet of paper.

Select Layout from the Presets drop-down list to access the

following features. For details, see “Printing Multiple Pages on
One Sheet of Paper” on the next column.

printer: | | ]
3
" Layout H

Pages per Sheat: | ]

I
Layout Direction: . . .
1 Border: | None ]

“r

“r

Presets: | Standard

@ (Preview ) ( Save AsPDF... ) ( Fax.. ) ( cancel )

A Mac 0S 10.3



Printer Features Setting

The Printer Features tab provides options for selecting the
paper type and adjusting print quality.

Select Printer Features from the Presets drop-down list to
access the following features:

Printer: | & ]
Presets: | Standard H
" Printer Features s ]—

A Mac 0S 10.3

Image Mode
Image Mode allows the user to enhance printouts. The available
options are Normal and Text Enhance.

Fit to Page

This printer feature allows you to scale your print job to any
selected paper size regardless of the digital document size. This
can be useful when you want to check fine details on a small
document.

Paper Type

Set Type to correspond to the paper loaded in the tray from
which you want to print. This will let you get the best quality
printout. If you load a different type of print material, select the
corresponding paper type.

Resolution(Quality)

You can select the printing resolution. The higher the setting, the
sharper the clarity of printed characters and graphics. The higher
setting also may increase the time it takes to print a document.
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Printing Multiple Pages on One Sheet
of Paper

You can print more than one page on a single sheet of paper.
This feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the
File menu.

2 Select Layout.

printer: |

“r

Presets: | Standard

“r

" Layout
Pages per Sheet:| 1 4

1 Layout Direction:

Border: | None >

1=

C’) (“Preview ) ( Save AsPDF.. ) ( Fax.. )

(" Cancel ) € Print )

A Mac 0S 10.3

3 Select the number of pages you want to print on one sheet
of paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.
To print a border around each page on the sheet, select
the option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of
pages on one side of each page.



Duplex Printing

You can print on both sides of the paper. Before printing in the
duplex mode, decide on which edge you will be binding your
finished document. The binding options are:

Long-Edge Binding: Which is the conventional layout
used in book binding.

Short-Edge Binding: Which is the type often used with
calendars.

1 From your Macintosh application, select Print from the
File menu.
2 Select the Layout.

Printer: |- ]
53

——————Flayout s ]

Pages per Sheet: | 1 &

|
Layout Direction: Eg

1 Border: | None Iy

Two Sided Printing: (@ Off
) Long-Edge Binding
) short Edge Binding

Presets: ' Standard

ar

2
s
=

)

Q_') (Preview ) ( Save AsPDF.. ) ( Fax. )

A Mac 0S 10.3

3 Select a binding orientation from Two Sided Printing
option.

4 Click Print and the printer prints on both sides of the
paper.

CAUTION: If you have selected duplex printing and
then try to print multiple copies of a document, the
printer may not print the document in the way you
want. In case of "Collated copy" , if your document has
odd pages, the last page of the first copy and the first
page of the next copy will be printed on the front and
back of one sheet. In case of "Uncollated copy", the
same page will be printed on the front and back of one
sheet. Therefore, if you need multiple copies of a
document and you want those copies on both sides of
the paper, you must print them one at a time, as
separate print jobs.
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Scanning

If you want to scan documents using other software, you will
need to use TWAIN-compliant software, such as Adobe
PhotoDeluxe or Adobe Photoshop. The first time you scan with
your machine, select it as your TWAIN source in the application
you use.

The basic scanning process involves a number of steps:

¢ Place your photograph or page on the document glass or
ADF.

¢ Open an application, such as PhotoDeluxe or Photoshop.
e Open the TWAIN window and set the scan options.
e Scan and save your scanned image.

NOTE: You need to follow the program’s instructions for
acquiring an image. Please refer to the User’s Guide of the
application.
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1 Getting started

Introduction

The Network Printer Card allows you to connect your printer
directly to a network to share the printer among multiple users.
The printer functions as a network print server supporting
various network environments, such as Windows 98/Me/NT/
2000/XP/2003, UNIX, and Macintosh 8.6 or higher.

This guide assumes that you have:

¢ A good working knowledge of your network utilities

o A supported network operating system

¢ A fully operational computer system

o Access to the supervisor account as a network administrator,
or access to an account that has supervisor and print server

operator privileges

Supported network
environments

Administrators and users can configure, and use printers on the
following supported network operating systems:

Operating

system

Windows

Network

environment

98, NT, ME,
2000, XP, 2003

Printing
protocol

TCP/IP, LPD
(LPR), IPP

Action

See Chapter 3,
“TCP/IP
environment.”

Unix

AT&T system V
(Rel 4.2),
BSD4.3, HP-UX
(Rel 9.x & Rel

10.x), SCO 5.x,

SUNOS 5.5,

Sparc or Solaris

2.5.

TCP/IP, LPD
(LPR)

See Chapter 3,
“TCP/IP
environment.”

Macintosh

Macintosh 8.6 ~

9.2,10.1 ~
10.3, or higher

TCP/IP,
EtherTalk,
Bonjour

See Chapter 4,
“EtherTalk
environment.”

Note: Your printer may not support all of the listed computing
environments (operating systems). Therefore, check the
network environment your printer supports in the user's guide

that came with the printer.

1.1
Getting started

Network Printer Card

System requirements

The following hardware is required to configure a printer for
network applications.

Computer Requirements

IBM - 80486 CPU or higher
compatible PC | ¢ Minimum of 16 MB of RAM
2 MB of free disk space

Macintosh o PowerPC 68020 or higher
Minimum of 8 MB of RAM
2 MB of free disk space

Connecting your Network Printer
Card

1 Use a twisted pair cable with an RJ-45 connector to
connect the printer to your network.

Once a connection is established between the wired
network printer card and your network, the link LEDs on
the card light.

Activity LED: Blinks
when data packets are

being transferred. = =

Link LED: Lights when !‘ I
the printercardis ———

@ connected to the

network.
m

2 Set up your printer's IP address. See “IP address setup” on
page 2.1.



Programs supplied on
the CD

The CD-ROM supplied with your printer card provides you with:

e SetIP: A utility program allowing you to select a network
printer card and manually configure the addresses for use
with the TCP/IP protocol.

System requirements

To install SetIP, the following are required:
e Operating system: Windows 2000/XP/2003

e Computer/Processor: 133 MHz or faster Pentium-compatible
processor

e Memory: 256 MB (recommended)

¢ Hard Disk space: 2 GB hard disk with 1.5 GB available hard-
disk space

o Internet Explorer 5.5 or later, or Mozilla 1.0

Installing software

1 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM will automatically run. If it does not, click
Start - Run, enter x:/cdsetup.exe (x represents your
CD-ROM drive), and click OK.

2 Select the language you want.
3 Click Typical installation for a network printer.
4 Follow the onscreen instructions to complete installation.

5 Click Finish when installation is done.

Uninstalling software

You should remove the Network utilities if you are upgrading
the software or if the installation fails.

Note: Close all programs before uninstalling software.

1 Click Start > Programs - Type 104 - SetIP >
Uninstall SetIP.

2 Click OK to confirm uninstallation.

3 Click Finish when uninstallation is done.

Programs supplied on the CD
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IP address setup

Before using your network print server in your network, you
must set TCP/IP addresses for the print server. You will need
your printer card’s MAC address, IP address, subnet mask, and
gateway address. First, check with your network administrator
for the TCP/IP addresses.

Note: The MAC address is the hardware serial number of the
network printer card. You can check the address by printing
the Network Printer Configuration Page. For printing the page,
refer to your printer user’s guide.

You can set your print server’s IP address via the following
methods:

¢ Printer control panel: If your printer has a control panel and
the network configuration menu, you can set the IP address
directly from the printer. Refer to your printer user’s guide.

e SetlIP program: Go to the Using SetIP.

e Web Image Monitor Type 104: Once you have set an IP
address for your network print server, you can use the
embedded web server in the network printer card to change
the address. Go to next column.

e DHCP: You can use Dynamic Host Configuration Protocol
(DHCP) to get an IP address automatically assigned by your
network administrator, if your network system supports this
protocol.

e BOOTP: A network-based server using the BootStrap
protocol (BOOTP) can notify the network printer card of its
assigned IP address each time the printer turns on, if your
network system supports this protocol.

Note: To get an IP address from the DHCP or BOOTP server,
the IP assignment method must be set to DHCP or BOOTP.

Using SetIP

1 From the Windows Start menu, select Programs > Type
104 > SetIP > SetIP.

The program automatically detects and displays new and
configured print servers on your network.

{1 SETIP Xl

Mac Addre: P Address Defaull Gateway
MFPO0158900:254 00159900C254 10.88.188.117 55.255.255.0 10.88.188.1
MFPODOOFOASFECO  DOOOFOAJFECD  10.88.188.31 256.256.256.0 10.88.188.1

Exit Help
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5

Select the name of your printer and click £} . If you

cannot find your printer name, click | & to refresh the list.

Even with this step, if you cannot find your printer name,
then contact Network Administrator.

Enter your network printer card’s MAC address (hardware
address), IP address, subnet mask, default gateway, and
then click Apply.

Click OK to confirm the settings.

Click Exit to close the SetIP program.

Using Web Image Monitor Type 104

1

2

Run your web browser.

Enter your print server’s IP address in the URL field and
click Go.

Click Network Settings > TCP/IP.

Select Static from IP Address Assignment Method.

Web Image
Monitor Type 104

Horme. Information Machine Seftings Network Setings | Maintenance Support

s IR

Generalh | rcpip
EtherTalk, Host Nare MFPODDOFOASEFO6
TePIp,

IP Address Assignment Method | STATIC v
Raw TCPAP LPRIPP > e —

stp, P Addes fios

1P Fitering» R
Subnet Mask 265,266, 255.0 ]

UPHP,
NP, Gateway Address [1088.189.1

Reseh Domain Name [ |

Primary DNS Sever (0000 1

Secondary DNS Server lnona ]
Dynarmic DNS Registration
Primary WINS Server lnooo |

Secondary WINS Server [o000 1

Enter your print server’s TCP/IP addresses and click
Apply.

Programs supplied on the CD

2.2



TCP/IP environment

A TCP/IP network provides you with various protocols for using
printing devices and managing various types of networked
devices.

In this chapter, you will learn which management protocols are
available in TCP/IP network environments, and how to print via
your network print server using TCP/IP protocol.

Management protocols

Before beginning to print documents via your network printer,
you need to check or configure some parameters using
management protocols.

DHCP/BOOTP

Dynamic Host Configuration Protocol (DHCP) is a
communication protocol enabling network administrators to
centrally manage and to automate the assignment of IP
addresses in a network. In an IP network, each device needs a
unique IP address. DHCP lets a network administrator
supervise and distribute IP addresses from a central point and
automatically sends a new IP address when a device is plugged
into a different place in the network.

Bootstrap Protocol (BOOTP) is UDP/IP-based protocol which
allows a booting host to configure itself dynamically and
without user supervision. BOOTP provides means to notify a
host of its assigned IP address, the IP address of a boot server
host, and other configuration information, such as the local
subnet mask, the local time offset, and the addresses of default
routers. Addresses of various Internet servers can also be
transferred to a host using BOOTP.

DHCP is active by factory default on your network print server.
After boot up, the network print server will get an IP address

automatically from the DHCP server, if one exists. To set an IP
address manually, see page 2.1.

Configuring DHCP/BOOTP

To enable or disable DHCP/BOOTP, use one of the following
methods:

¢ Printer’s control panel: Refer to Network Menu settings in
your printer user’s guide.

¢ Web Image Monitor Type 104: Select Network Settings
- TCP/IP and select DHCP or BOOTP from the IP Address
Assignment Method list.

TCP/IP environment
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HTTP

Hypertext Transfer Protocol (HTTP) is an application layer
protocol for distributed, collaborative, hypermedia information
systems. It is a generic, stateless protocol which can be used
for many tasks beyond its use for hypertext, such as with name
servers and distributed object management systems. You are
using HTTP when you connect your network printer via a web
browser.

The Network Printer Card has a built-in web server, Web Image
Monitor Type 104. You can configure and manage your network
print server through Web Image Monitor Type 104 using HTTP
over TCP/IP.

SNMP

Simple Network Management Protocol (SNMP), which is part of
the TCP/IP protocol suite, is an application layer protocol that
facilitates the exchange of management information between

network devices. It enables network administrators to remotely
monitor and configure network devices, find and solve network
problems, and plan for network growth.

Network devices are monitored and controlled using four basic
SNMP commands:

e read: is used by a Network Management server to monitor
network devices. The server examines different variables
that are maintained by the devices.

¢ write: is used by a Network Management server to control
managed devices. The server changes the values of
variables stored within the devices.

e trap: is used by network devices to asynchronously report
events to a Network Management server. When certain types
of events occur, a device sends a trap to the specified server.

e Traversal operations: are used by a Network Management
server to determine which variables a network device
supports and to sequentially gather information in variable
tables, such as a routing table.

Configuring SNMP

To access your network print server using SNMP, Community
Name/Access Permission pair must be properly specified. There
are two access permission: read and write.

Assign the IP addresses of trap hosts and community names (IP
addresses) of network devices in Web Image Monitor Type 104;
select Network Settings > SNMP.

Using SNMP

Web Image Monitor Type 104 accesses, configures, and
manages network devices using SNMP. You can use other MIB
(Management Information Base) browser software, which
allows you to access management information gathered from
network devices.



SLP

Service Location Protocol (SLP) is an Internet standard network
protocol that provides a framework to allow networking
applications to discover the existence, location, and
configuration of networked services in enterprise networks,
such as printers, Web servers, fax machines, video cameras,
file systems, backup devices (tape drives), databases,
directories, mail servers, and calendars.

In order to locate services on the network, users of network
applications are required to supply the host name or network
address of the device that supplies a desired service. However,
SLP eliminates the need for a user to know the name of a
network host supporting a service. Rather, the user only needs
to supply the desired type of service and set of attributes or
keywords, which describe the service.

Based on that description, SLP also resolves the network
address of the service of the user. Administrators do not need
to help clients find new services or to remove services when
they are no longer available. SLP uses multicasting and can
work over subnet boundaries.

Configuring SLP

You can configure SLP protocol settings through Web Image
Monitor Type 104. Select Network Settings > SLP.

e SLP Protocol: You can enable or disable SLP.
e Port Number: The port number is fixed to 427.

e Scope 1 ~ 3: A scope is a set of services and a string used
to group resources by location, network, or administrative
category. Each scope should not be more than 32
characters.

* Message Type: You can select the outgoing SLP message
type sent to network devices. The default value is
Multicast.

¢ Multi Cast Radius: You can specify the maximum number
of subnets that SLP multicasts can travel across. This value
is also called the “hop count” or “time-to-live” (TTL). The
default value is 255.

¢ Registration Lifetime: You can define the time in seconds
before the Server Agents registration expires.

o Multicast Address: The Multicast Address value is fixed to
239.255.255.253, 224.0.1.127.
Using SLP

Once SLP enabled is checked, the network print server works
as a Service Agent and the User Agent.

TCP/IP environment
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Dynamic DNS (DDNS)

DNS (Domain Name System) is used for registration of domain
names and provides Host names to an IP address resolution
service. For printer devices, DNS may be utilised for printer
domain name registration, so that print server clients may refer
to the printer by its host name rather than by its IP address.
Even though a printer’s IP address is changed, all clients can
operate this printer without reconfiguration. Addressing to a
printer device by IP address is not convenient and may often go
stale if an IP address to a device is assigned dynamically via a
DHCP server. If the DHCP server can provide information about
a printer’s changing IP address to the DNS server
automatically, user convenience is increased. The printer’s
name will be used as its DNS name.

Configuring DDNS

1 Let the DHCP server provide updated information to the
DNS server.

2 Configure the same DDNS domain through Web Image
Monitor Type 104 as entered in the DNS server.

If you connect your network printer via a web browser, you
can enable this by selecting Network Settings > TCP/
IP > Dynamic DNS Registration.

3 Set the IP assignment method of your network print server
to DHCP and reboot the printer.

The DNS server will update its database and users can use
the printer’s name instead of its IP address.

WINS

Before Dynamic DNS was defined, DNS could only be updated
manually when DHCP servers automatically provided (or
removed) IP addresses. As a result, DNS servers often
contained obsolete listings. In response, Microsoft developed
Windows Internet Name Service (WINS) to solve this problem
for NetBIOS names.

Microsoft now recommends moving to Dynamic DNS and away
from WINS. However, many customers including Microsoft
maintain WINS systems and need devices to interoperate with
WINS. So devices must, at least for now, support WINS
interoperability to allow for dynamic NetBIOS name to IP
address registration and resolution.

WINS provides a distributed database for registering and
querying dynamic NetBIOS names to IP address mapping in a
routed network environment. This is the best choice for
NetBIOS name resolution in such a routed network because it
is designed to solve the problems that occur with name
resolution in complex Internet networks.



Configuring WINS

Access Web Image Monitor Type 104 and select Network
Settings > TCP/IP. You will configure two WINS server
addresses, the Primary WINS Server or the Secondary WINS
Server. The default value is 0.0.0.0.

In a DHCP server

A DHCP server can support the NBNS (NetBIOS Name Server)
option. An administrator has to set the WINS server IP address
in the NBNS option.

1 Set the IP assignment method of your network print server
to DHCP.

2 Reboot the print server.

The WINS server will update the printer's NetBIOS name
in its database. Users can use the printer name instead of
its IP address.

In the network print server

1 Configure the WINS server address through Web Image
Monitor Type 104.

2 Reboot the print server.

The WINS server will update the printer's NetBIOS name
in its database. Users can use the printer name instead of
its IP address.

Bonjour

Bonjour allows for a network system to be easily discovered
and its capabilities to be revealed by any Bonjour-compliant
client software, such as Print Center Utility built in to Mac OS X.
For details, see page 4.2.

UPnP

UPnP is an architecture for pervasive peer-to-peer network
connectivity of intelligent appliances, wireless devices, and PCs
of all form factors. It is designed to bring easy-to-use, flexible,
standards-based connectivity to ad-hoc or unmanaged
networks whether in the home, in a small business, public
spaces, or attached to the Internet.

UPnP is a distributed, open networking architecture that
leverages TCP/IP and Web technologies to enable seamless
proximity networking in addition to control and data transfer
among networked devices in the home, office, and public
spaces.

TCP/IP environment
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UPnP is more than just a simple extension of the plug and play
peripheral model. It is designed to support zero-configuration,
“invisible” networking, and automatic discovery for a wide
breadth of device categories from a wide range of vendors. This
means a device can dynamically join a network, obtain an IP
address, convey its capabilities, and learn about the presence
and capabilities of other devices. DHCP and DNS servers are
optional and are used only if available on the network, while a
device can leave a network smoothly and automatically without
leaving any unwanted state issues behind.

UPnP supports 6 protocol stacks for addressing, discovery,
description, control, eventing, and presentation, but the
Network Printer Card supports only Simple Service Discovery
Protocol (SSDP) which allows addressing, description, and
discovery.

Configuring UPnP

e Control panel: Refer to the Network Menu setting in your
printer user’s guide.

e Web Image Monitor Type 104: Select Network Settings >
UPnP.

- Auto IP Enabled: You can enable or disable Auto IP. When
this option is selected, the network print server cannot find
the control point and receive an IP address from the
control point. The network print server will create an IP
address of “169.254.XXX.XXX.”

- Multicast DNS Enabled: SSDP can use Multicast DNS.
- SSDP Enabled: You can enable or disable SSDP.

- SSDP TTL: You can specify the maximum number of
subnets that SSPD multicasts can travel across.

Using UPnP

If SSDP (Simple Service Discovery Protocol) is enabled, your
network print server is checked by a control point. This control
point is an application which supports finding UPnP devices.
Information on searching and control functions or your network
print server’s device information is displayed in an XML page
(http://xxx.xxx.xxx.xxx:5200/printer.xml).



Printing protocols

Before setting the network printing ports, you must install the
printer driver with the local port (LPT) on the system. Refer to
your printer user’s guide.

Standard TCP/IP port

You can print your documents to your network printer by
creating a Standard TCP/IP port.

Configuring Standard TCP/IP in Windows
2000/XP/2003

You can enable or disable the Standard TCP/IP Printing port
through Web Image Monitor Type 104. Select Network
Settings > Raw TCP/IP, LPR, IPP.

You can also change the port number of the Standard TCP/IP
port. The default port number is 9100.

Creating a Standard TCP/IP port

1 In Windows XP, click Start > Printers and Faxes. In
Windows 2000/2003, click Start - Settings > Printers.

2 Click Add a printer or double-click Add Printer, and then
Next.

3 Click Local printer attached to this computer and then
Next.

Make sure that Automatically detect and install my
Plug and Play printer is not selected.

4 Click Create a new port, select Standard TCP/IP port
from the Type of port list, and click Next.

5 Click Next.

6 Enter the IP address or DNS name of your network printer
and click Next.

For the port name, a default name will be entered by
Windows. You can change it to a more user-friendly name.

7 Follow the instructions on the screen to complete
installation.

Now, you can select your printer from the Print Setup
dialogue box.

LPR port

LPD, Line Printer Daemon, is the protocol associated with line-
printer spooling services. Users can use the printing service
from LPD running on a network print server through the LPR
port. Most operating systems, such as Microsoft Windows NT/
2000/XP/2003, and support LPR port printing.

TCP/IP environment
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Configuring an LPR port

You can enable or disable the LPR Printing port through Web
Image Monitor Type 104. Select Network Settings > Raw
TCP/IP, LPR, IPP. You can also change the port number of
LPR/LPD. The default port number is 515.

In Windows NT

Before adding an LPR printing port, make sure that Microsoft
TCP/IP printing service is installed on your Windows NT
computer, or install the software, if necessary.

Installing the TCP/IP printing service
1 Make sure your computer supports Microsoft TCP/IP
printing service.

1) From the Windows Start menu, select Settings >
Control Panel.

2) Double-click Network.

3) Make sure that TCP/IP protocol is listed in the
Protocols tab and Microsoft TCP/IP printing is listed in
the Services tab. If not, go to step 2.

2 Install TCP/IP printing service:

Click Add and select TCP/IP protocol > Microsoft
TCP/IP Printing. Follow the onscreen instructions to
complete installation.

Notes:

e During the installation process, you may need the Windows
Installation CD-ROM.

¢ You can only install Microsoft TCP/IP Printing if you have
administrator privileges.

After installing the service, restart your computer.

Adding an LPR port

1 From the Windows Start menu, select Settings >
Printers.

2 Click Add Printer.
3 Click My Computer and then Next.

4 Click Add Port and select LPR Port from the port type
list.

5 Click New Port.

6 Enter the IP address or DNS name of the printer and the
name of a user-defined print queue.

7 Click OK.

8 Follow the onscreen instructions to complete installation.



In Windows 2000/XP/2003

To add an LPR port to Windows 2000/XP/2003, users must
install a Standard TCP/IP port by default, then change the

printing protocol in the printer properties. For installing the
Standard TCP/IP port, see page 3.4.

1 From the Windows Start menu, select Settings >
Printers, or Printers and Faxes.

2 Right-click the printer you want and select Properties.
3 Click Ports.

4 Make sure that the appropriate Standard TCP/IP port is
selected and click Configure Port.

5 Select LPR from the Protocol section.
6 Enter the print queue name and click OK.

7 Click OK to close the properties window.

In Unix

Depending on your particular Unix system, LPD configuration
may vary. See your system documentation for the correct
syntax for the system.

Printer Port

A Network Printer port is used to send print jobs from network
computers running Windows OS that do not support the
Standard TCP/IP port or LPR port. Adding a Network Printer
port

1 From the Windows Start menu, select Settings >
Printers, or Printers and Faxes.

2 Right-click the printer you want and select Properties.

3 In Windows 98/Me, click Details.
In Windows NT4.0/2000/XP/2003, click Ports.

4 Click Add Port.

5 Select Network Printer Port from the Other list and click
OK.

6 Select the print server you want to use and click OK.

If you cannot find the print server, click Add New Print
Server to list, specify information for the print server,
such as print server name, IP address, or MAC address,
and click OK.

7 When the port name displays in the Print to the following
port list, click OK or Close.

TCP/IP environment
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IPP port

Internet Printing Protocol (IPP) allows printing across the
Internet, meaning that you can send a print job to your printer
from a remote place if you are an Internet user, no matter what
operating system you use or where you are.

Configuring IPP in the print server

The network administrator must specify information required
for IPP, such as the URI (Uniform Resource Identifier).

1 Run your web browser and access Web Image Monitor
Type 104.

2 Click Network Settings > Raw TCP/IP, LPR, IPP.

3 Configure the IPP parameters:

¢ Printer Name: Enter the network printer's name to be
used with IPP printing.

¢ Printer URI: Enter the URL of the printer using the
following format: ipp://the IP address of the printer or
http://the IP address of the printer:631 (Ex:ipp://
168.10.17.82 or http://168.10.17.82:631) 631 is the
IPP port number.

¢ Printer Information: Enter additional information
about the printer.

¢ More Printer Information: Enter more additional
information about the printer.

¢ Printer Location: Enter the name of the location
where the printer is physically located.

e Multiple Operation Timeout: Enter the time to elapse
before the printer ends a print job. When there is no
incoming data after the specified number of seconds,
the printer ends reception.

¢ Time to Keep Jobs in History: Set the length of time
the IPP printer keeps job information.

¢ Operator Message: Enter printer information for
printer users.

¢ Job Count: shows the number of print jobs.

o Driver Installer: shows the URL where you can get the
driver installer.

¢ Manufacturer: shows the URL where you can get
manufacturer information.

4 Click Apply.



Configuring a Windows client

After the network administrator has configured the network
print server, each printer user must install the printer driver and
set the print port to IPP 1.1 Port Monitor.

Note: Before following the steps below, each printer user
should install the printer driver. If the printer driver is not
already installed on the computer, install the printer driver that
came with the printer. Select the local port (LPT) when you
install the driver.

1 From the Windows Start menu, select Settings >
Printers, or Printers and Faxes.

2 Right-click the printer you want and select Properties.

3 In Windows 98/Me, click Details.
In Windows NT4.0/2000/XP/2003, click Ports.

4 Click Add Port.
5 Select IPP Port from the Other list and click OK.
6 Enter the printer URL and port name and click OK.

7 When the port name displays on the print port list, click
OK.

Now you can select the network print server from the Print
Setup dialogue box to send a job.
Setting IPP security

Web Image Monitor Type 104 allows administrators to choose
an authentication method and to create or modify user
accounts.

1 Run your web browser and access Web Image Monitor
Type 104.

2 Click Network Settings > Raw TCP/IP, LPR, IPP.

¢ Authentication: You can set a user name and
password encryption method (refer to http digest
authentication in RFC).

¢ User DB: You can set a user name and password for
IPP printing. You can set up the user database for up to
10 items.

3 Click Apply.

Note: A user name should be unique for all slots and should
not include symbols. The length of the user name and the
password should each be less than 7 characters.
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Additional functions

The following are additional functions you can use through Web
Image Monitor Type 104.

Printer properties settings

You can check and modify printer and document properties for
an installed printer. For properties that are not supported by the
printer driver, an error message indicating that the property is
not supported is displayed. These settings are used only for
printing from this system to the printer. However, these settings
do not affect the printer properties of the network printer.

Firmware upgrade (HTTP)

You can upgrade your printer’s firmware using the HTTP
protocol. First, you need to download firmware from the
website

Note: Before upgrading the firmware, make sure that TCP/IP
parameters are entered in the print server.

1 Run your web browser and access Web Image Monitor
Type 104.

2 Click Maintenance - Firmware Upgrade.

3 Select a firmware type, Printer Firmware or Network
Firmware.

4 Click Browse, and then select the downloaded new
firmware.

5 Click Upgrade.

Note: It takes a few minutes to upgrading the firmware.
After completely upgrade, the printer will be reset.

Default setting (HTTP/SNMP)

You can reset all of your network parameter settings to their
default status.

Note: All default parameters will be applied after the print
server restarts.

IP filtering

This security feature (IP Filtering) provides the ability to
prevent unauthorised network access to the network print
server based on IP addresses set by a network administrator
using Web Image Monitor Type 104.

1 Run your web browser and access Web Image Monitor
Type 104.



2 Select Network Settings - IP filtering.

3 Configure an IP filter.
o IP filtering: You can enable or disable IP filtering.

e IP Addressl1 ~ IP Address10: You can enter filtered
IP addresses. Users having the IP addresses set here
are able to access the network print server.

4 Click Apply.

Only system administrators or authorised users can set, via
Web Image Monitor Type 104, IP addresses that can access the
device. Up to 10 addresses or ranges of address choices can be
made and set. Authorised users are able to change the action
(Apply/ Undo) and to print to the network print server.

Note: Ranges of addresses shouldn't contain “null” or
*0.0.0.0" values.

Reset

1 Run your web browser and access Web Image Monitor
Type 104.

2 Click Network Settings > Reset.

You can reboot the network print server, if your network
settings are not applied correctly or the network card is
disconnected from your network.

Ethernet speed

You can set the communication speed for Ethernet connections.

1 Run your web browser and access Web Image Monitor
Type 104.

2 Click Network Settings > General.

e Speed Rate: Automatic, 10 Mbps(Harf Duplex),
10 Mbps(Full Duplex), 100 Mbps(Harf Duplex),
100 Mbps(Full Duplex). select a Ethernet speed from
the drop-down list.

3 Click Apply.

3.7
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4 EtherTalk environment

EtherTalk is AppleTalk used in an Ethernet network. This
protocol is widely used in Macintosh network environments.
Microsoft Windows system also supports this protocol. Like
TCP/IP, EtherTalk also provides packet transmission and routing
functionality.

The network printer card works on EtherTalk networks, if the
host printer supports PostScript. The description in this chapter
applies to network printing from a Macintosh computer.

EtherTalk printing

Printing in an EtherTalk network is possible with several
different hardware and software configurations. When you
issue a command to print a document, the application begins a
series of EtherTalk calls attempting to establish a connection to
the printer. The calls first initiate the NBP (Name Binding
Protocol) name-lookup process to find the currently selected
printer and its EtherTalk address. Then the Printer Access
Protocol (PAP) is used to open a connection with the printer.

Once the connection has been established, the workstation and
printer interact over a PAP connection. PAP uses lower-level
protocols, such as ATP and DDP, to provide a data-stream
service for sending print data to the printer.

Configuring EtherTalk

You can configure EtherTalk using the following methods:

Control Panel

Refer to the Network Menu setting in your printer user's guide.

Web Image Monitor Type 104
1 Run your web browser.
2 Enter the printer's IP address in the URL field and click Go.

3 Select Network Settings > EtherTalk.

o EtherTalk Protocol: allows you to enable or disable
the EtherTalk protocol.

¢ Printer Name: allows you to set the printer name for
EtherTalk protocol. The default name is MFP+MAC
address. This name is automatically displayed on
Chooser.

¢ Printer Type: shows the printer type.

o Last Error Occurred: shows the last error.

EtherTalk environment

4.1

e RTMP: allows you to set the time in seconds after which
the routing table entry maintained by the RTMP protocol
times out.

e ZIP (current zone): shows the AppleTalk Zone name.
If there is no configured zone, *(asterisk) should be
displayed.

¢ PAP (wait time before transmitting a tickle
packet): enables you to define the time interval in
seconds after which the PAP protocol should resend a
tickle packet to verify the status of the PAP connection
between the printer and your Macintosh.

4 Click Apply.

Configuring the printer

Note: The following instructions are for Mac OS 10.3, but
similar for other versions.

The following steps must be taken to configure the network
printer for use on a Macintosh system. If the network printer
you want to use is not listed in the printer pop-up menu when
you try to print a document, you should add it to your list of
available printers.

1 Open System Preferences and click Print & Fax.
2 Click Printing > Set Up Printers.

3 If the printer already appears in the printer list, select the
In Menu check box to add it to your list of available
printers. You will see the printer in the Printer pop-up
menu the next time you print.

4 Choose Printers > Add Printer.
5 Choose AppleTalk from the pop-up menu list on the top.

6 If necessary, choose an AppleTalk zone from the pop-up
menu that appears directly below it. Any AppleTalk printers
in the zone you have chosen appear in the Printer List.

7 Select the printer in the Printer List.

8 To use printer-specific features, choose the item
appropriate for your printer from the Printer Model pop-up
menu, then select your printer in the Model Name list.

9 Click Add.

The printer appears in the Printer List as the default
printer (in boldface). It also appears in the Printer pop-up
menu when you print a document.



TCP/IP printing

Apple added TCP/IP printing to all versions including and after
0S 8.6.

Note: Ensure that the Macintosh has version 8.6 or later.
Earlier versions do not support TCP/IP printing as standard.

An IP printer is a network printer that uses TCP/IP protocols
(such as LPD/LPR, IPP, or Socket or Jet Direct) to make itself
accessible to your computer. If the IP printer you want to use is
not listed when you want to print, you can add it to your list of
available printers. To add an IP printer, you need to know its IP
address or DNS name.

1 Open System Preferences and click Print & Fax.
2 Click Printing > Set Up Printers.

3 If the printer already appears on the Printer List, select the
In Menu check box to add it to your list of available
printers. You will see the printer in the Printer pop-up
menu the next time you print.

4 Choose Printers - Add Printer.
5 Choose IP Printing from the pop-up menu.

6 Select the appropriate printing protocol from the Printer
Type pop-up menu.

7 Enter the IP address or DNS name for the printer in the
Printer Address field.

8 If your printer requires it, type the queue name for your
printer in the Queue Name field.

9 To use printer-specific features, choose the item
appropriate for your printer from the Printer Model pop-up
menu, then select your printer in the Model Name list.

10 Click Add.

The printer appears on the Printer List as the default
printer (in boldface). It also appears in the Printer pop-up
menu when you print a document.

EtherTalk environment
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Bonjour printer

Usually used in Macintosh networks to search for network
devices, Bonjour consists of IPv4 Link-Local Addressing,
Multicast DNS, and DNS Service Discovery. Known as zero
configuration networking, Bonjour uses industry standard IP
protocols to allow devices to automatically find each other
without the need to enter IP addresses or configure DNS
servers.

In order to provide a true zero configuration experience,
meaning that you do not need to configure network
parameters, the printer MUST have Bonjour enabled by default.
It is NOT possible to disable any part of Bonjour.

After boot up, check the Bonjour printer name of this printer
network card in Mac OS X.

1 Open System Preferences and click Print & Fax.
2 Click Printing > Set Up Printers.

3 If the printer already appears on the Printer List, select the
In Menu check box to add it to your list of available
printers. You will see the printer in the Printer pop-up
menu the next time you print.

4 Choose Printers > Add Printer.

5 Choose Bonjour from the pop-up menu. Any Bonjour-
enabled printers on your local network or subnetwork
appear on the Printer List.

6 Select your printer from the Printer List.

7 To use printer-specific features, choose the item
appropriate for your printer from the Printer Model pop-up
menu, then select your printer in the Model Name list.

8 Click Add.

The printer appears on the Printer List as the default
printer (in boldface). It also appears in the Printer pop-up
menu when you print a document.



5 Appendix OpenSSL Statements

OpenSSL License

H'H : Copyright © 1998-2000 The OpenSSL Project. All rights
Specifications AR P ] g
Items Specifications Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following
Supported ¢ Windows: 98, NT, ME, 2000, XP, 2003 conditions are met:
networks ¢ Unix: AT&T system V (Rel 4.2), BSD4.3, HP- o i
UX (Rel 9.x & Rel 10.x), SCO 5.x, SUNOS 1 Redistributions of source code must retain the above
5.5, Sparc or Solaris 2.5. copyright notice, this list of conditions and the following
« Macintosh: Macintosh 8.6 ~ 9.2, 10.1 ~ disclaimer.

10.3, or higher 2 Redistributions in binary form must reproduce the above

Protocol TCP/IP, LPD (LPR), IPP, EtherTalk Bonjour copyright notice, this list of conditions and the foIIowing
' Y ' disclaimer in the documentation and/or other materials

Configuration | SetIP, Web Image Monitor Type 104 provided with the distribution.

utilities

3 All advertising materials mentioning features or use of this
software must display the following acknowledgment:

Hardware e PC:
requirements - 80486 CPU or higher 4
- Minimum of 16 MB of RAM
- 2 MB of free disk space

“This product includes software developed by the OpenSSL
Project for use in the OpenSSL Toolkit. (http://
www.openssl.org/)”

¢ Macintosh:
- PowerPC 68020 or higher 5 The names “OpenSSL Toolkit” and “OpenSSL Project” must
- Minimum of 8 MB of RAM not be used to endorse or promote products derived from
- 2 MB of free disk space this software without prior written permission.

6 For written permission, please contact openssl-
core@openssl.org.

7 Products derived from this software may not be called
“OpenSSL” nor may “OpenSSL” appear in their names
without prior written permission of the OpenSSL Project.

8 Redistributions of any form whatsoever must retain the
following acknowledgment:

“This product includes software developed by the OpenSSL
Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS
IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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http://www.openssl.org/
http://www.openssl.org/

This product includes cryptographic software written by Eric
Young (eay@cryptsoft.com).

This product includes software written by Tim Hudson
(tjh@cryptsoft.com).
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